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The Demo Guide explains how to manage clients, jobs, costs, billings, and fi-
nances with Clients & Profits X. Together with the Tutorial, it provides complete 
step-by-step instructions on how to add, change, find, and print information 
from your Clients & Profits X demo database.  

This demo guide is based on the Clients & Profits X feature guide, which will 
be included when you purchase the Clients & Profits X system.  It features 
highlights of the program’s most useful and productive functions. It is designed 
to help you evaluate the software for your company. The demo guide’s pages 
are identical to what you’d find in the program’s online user guide as well.  

■   Clients & Profits X: Quick Start features essential instructions for install-
ing the software on both Macintosh and Windows computers.

■   Getting Started explains how the Clients & Profits X trial demo works, 
including how to use the demo database.

■   The Introducing Clients & Profits X section describes how the system can 
be used throughout the shop—by everyone from account executives to agency 
principals.

■   The main section, Starting Clients & Profits X, is a comprehensive over-
view of the software. It highlights the software’s most important abilities, and 
walks you through the basics of adding, finding, and printing information. After 
working through this section, you’ll have a good sense of what you can do with 
Clients & Profits X.

LEARN CLIENTS & PROFITS FAST: The Clients & Profits X tutorial 
offers self-guided, step-by-step training on the C&P essentials—
adding jobs, estimating, scheduling, costing, and billing. Look for 
the fully-narrated tutorial on the Clients & Profits X web site:
www.cnp-x.com/learn/tutorial  of

Need help?  Call Clients & Profits Sales at (800) 272-4488 from 
7:00 AM - 5:00 PM Pacific Time. Or, send your questions to sales@
cnp-x.com.

For up-to-date answers check out the Clients & Profits X web site:

                   www.cnp-x.com

How to use your 
Clients & Profits X 
trial demo

Copyright © 2008 Clients & Profits Worldwide.  All Rights Reserved.
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explanations, tips, demonstrations, and links to FAQs, tech notes, and tutorials from the 

Clients & Profits X web site.  It’s continually updated, so it’s more timely and helpful than a 

printed user guide.
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Clients & Profits X: Quick Start System requirements

The Clients & Profits X trial demo installs like most typical software applica-
tions, so you’re probably already familiar with the process: Insert the Clients 
& Profits X demo  into the Mac or PC, double-click on the Installer applica-
tion, then follow the prompts. Within minutes, your new Clients & Profits X 
software will be installed on your hard disk.

Clients & Profits X is a cross-platform system, meaning any number of Ma-
cintosh and Windows users can work together on the same database. When 
you buy Clients & Profits X, the  contains installers for Mac OS X (10.4 and 
higher) and Windows Vista/XP/2000 (called “platforms”). Each platform has 
its own special version of the Clients & Profits X Player, which is the engine 
that runs the Clients & Profits X application. The Clients & Profits X demo is 
preset to support 10 simultaneous users.

■  For up-to-date system recommendations for Clients & Profits X, please 
see www.cnp-x.com/sales/workstation_recs.html

The Clients & Profits X demo software should be installed separately on every 
computer that will be used to evaluate it. The Installer creates a Clients & 
Profits X Demo folder on your hard disk. This folder contains the C&P Player, 
the Clients & Profits X demo application, and several miscellaneous files 
needed by the program. 

The demo database created by Clients & Profits X should be stored on the file 
server, where it can be shared by anyone who needs it.

■  Clients & Profits X was developed using rapid-development tool called 
Omnis Studio 4.0.3 (www.omnis.net). All of the underlying filing, saving, 
and printing functions are managed by Omnis Studio; windows, menus, 
and reports are handled by Clients & Profits X. As you use Clients & Profits 
you’ll see references to Omnis, especially when setting up and maintaining 
your database. You don’t need to know anything about Omnis Studio to use 
Clients & Profits X. 

The Clients & Profits X web site features detailed technical information, 
including up-to-date hardware recommendations:    
   
  www.cnp-x.com

There are Mac and Windows ver-
sions of the C&P Player X, which is 
the engine that runs the Clients & 
Profits X application. 

Your C&P Player has a unique serial 
number that determines how many 
users can share Clients & Profits X 
at one time.

Macintosh:  The Mac version of Cli-
ents & Profits X runs on any Power 
Mac, iMac, PowerBook, iBook, or 
eMac with Mac OS X 10.4 (Tiger) or 
Mac OS X 10.5 (Leopard). It is not 
compatible with Mac OS 9.

■  Do not use pre-Tiger versions 
of Mac OS X or else it will damage 
your Clients & Profits X database. 
Always use Mac OS X 10.4 or later.

Windows:  Clients & Profits X for 
Windows runs on any PC with Win-
dows Vista, XP or Windows 2000.

■  The Clients & Profits web site 
features detailed technical informa-
tion, including up-to-date hardware 
recommendations:
www.cnp-x.com/sales/system_
recs.html

■  Some versions are Clients & 
Profits X are not “client/server”-
based, so the software isn’t 
installed on your file server. 
Instead, the server only stores your 
database. A typical database can 
grow 25-150 megabytes per year.

Got questions? Call Clients & Profits Sales at 
(800) 272-4488

C&P Mail System Require-
ments

Clients & Profits X can auto-
matically send e-mail reminders, 
notifications, and warnings to any 
staff member using a standard 
SMTP-based mail server.

Clients & Profits e-mail is sent in 
real-time, so users will be notified 
of important news about clients, 
jobs, tasks, media, and more as 
it happens. To work in real-time, 
Clients & Profits needs a full-time 
internet or intranet (i.e., interoffice 
only) connection to the mail server. 
If the mail server doesn’t have a 
full-time internet or intranet con-
nection, users will see an error any 
time Clients & Profits sends e-mail.

■  Clients & Profits e-mail will not 
work with older non-SMTP mail 
systems.

E-mail is sent one-way from Clients 
& Profits X (that is, you can’t send 
mail to Clients & Profits X). Each 
C&P X user will have an e-mail 
address in the database. Any mail 
sent from Clients & Profits X will 
show the sender’s e-mail address, 
as if they’d sent it themselves.

■  Clients & Profits X e-mail does 
not support authentication. To send 
e-mail from C&P, you must use a 
mail server with authentication 
disabled.

■  To configure C&P Mail, see 
pages 86-87.

Clients & Profits X: Quick Start
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Installing the C&P X demo

For Mac OS X users:

1  Insert the C&P X Demo  into your 
computer (or download the demo 
installer from www.cnp-x.com).

2  Double-click on installer ap-
plication. 

3  Follow the prompts.

A new Clients & Profits X Demo 
folder will be copied to Applica-
tions folder. 

For Windows XP users:

1  Insert the C&P X Demo  into your 
computer (or download the demo 
installer from www.cnp-x.com).

The Windows installer will start up 
automatically.

2  Click on the Install Software 
option when prompted.

The Installer will prompt you to 
choose a destination for the new 
C&P folder. The C:\Program Files 
folder is chosen automatically, 
but an alternate directory can be 
chosen.

3  Follow the prompts to finish the 
installation.

A demo database is included in the 
Clients & Profits X Demo folder, 
which you can use to explore the 
software before starting your own 
database.

■  Repeat these steps other users 
who wish to use the Clients & 
Profits X trial demo.

Networking the Clients & 
Profits X demo

Clients & Profits X is a true multi-
user relational database. This 
means dozens of people can work 
together on the same database of 
clients, jobs, costs, and billings at 
the same time. 

All versions except Clients & Profits 
Classic X support MySQL Pro, which 
runs on the Apple Xserve and Win-
dows XP. You can use MySQL with 
the C&P X demo. For more informa-
tion, see: www.cnp-x.com/mysql

■  For best performance and 
security, a file server dedicated  to 
the Clients & Profits database is 
strongly recommended.

Like earlier versions, Clients & 
Profits X isn’t installed or run 
from the file server. Instead, it is 
installed only on user workstations. 
Only the database is stored on a 
shared folder on the server. Anyone 
who uses Clients & Profits X starts 
it from their own computer, then 
opens the shared database from the 
server. All of the  work is entered 
and processed (including printing 
reports) from the user’s computer. 
The file server only saves the data.

The shared database created by 
Clients & Profits X should be stored 
on the file server, where it can be 
accessed by anyone who needs it.

■  The Clients & Profits X demo is 
a 10-user version. This means up to 
ten Mac users and/or PC users can 
work on the demo simultaneously.

Clients & Profits X: Quick Start
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Starting the Clients & Profits X 
Trial Demo

2.  If prompted, select and 
open the demo database.

The first time you launch the 
Clients & Profits X demo you’ll 
be prompted to select and open 
a database. Clients & Profits X 
thereafter remembers where your 
database is stored. To open your 
database click the Open Database 
button. Next, find the drive, server, 
or folder that contains the database 
then click on the database itself 
then click Open.  

1. Double-click on the 
Clients & Profits X demo 
application.

Clients & Profits X starts up like any other Macintosh or Windows applica-
tion:  simply double-click on the program, open the database, then introduce 
yourself. Because Clients & Profits X is a multi-user application, many people 
could be sharing it at any one time. By introducing yourself to Clients & 
Profits X with your initials, the system becomes aware that you’re using it.  

Every potential Clients & Profits X user should be added to the Users table 
separately. When a user starts Clients & Profits X, he or she will be prompted 
to enter their initials and an optional password. The initials and password 
combination verifies that they can use all or part of the system. System 
Managers can give each user access to parts of Clients & Profits X, as well as 
special preferences (such as window positions, status codes, pop-up warning 
messages, etc.). These preferences are portable, so they travel with you to 
any computer you may use in the shop—whether or not it’s a Mac or a PC. 

Starting the Clients & Profits X demo

This is your Clients & Profits X 
Program.

This is your Clients & Profits X 
database. (It will have a different 
name, based on whatever you call 
it.)

For technical help, please call the Clients & Prof-
its X Sales at (800) 272-4488
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4. Leave the password, 
blank press Tab.

Passwords are sometimes used 
to validate who you are to Clients 
& Profits X. The demo database’s 
standard users, MGR and DEMO, 
do not have passwords.  Later, if 
your System Manager requires 
passwords, it must be entered.    

■  Passwords are case sensitive, 
which means capital letters are dif-
ferent from lowercase letters.  
If your password is ROSEBUD, 
for example, entering Rosebud 
wouldn’t work. If you get an error 
when entering your password, 
check your case.

■  If you don’t have a password, 
the Introduce Yourself window 
closes automatically.

3. Enter the user ID as 
DEMO, then press Tab.

Your initials help the system track 
who’s doing what. The system 
remembers when you start and stop 
Clients & Profits X, as well as what 
kinds of entries you make.   You 
must be an authorized user to use 
Clients & Profits X.  

■   The demo database has two 
standard users: MGR and DEMO. If 
you’re using the Clients & Profits X 
demo for the first time, enter your 
initials as MGR. This user is your 
default System Manager, enabling 
you to add, edit, and delete users.  
Both IDs have no password, so can 
be used temporarily until you’ve set 
up your own users and passwords.

■   If you enter your initials and get 
the message “user not found” then 
you’re not an authorized user.  First, 
make sure you’re entering the right 
initials (don’t forget a middle initial, 
for example). If the message still 
appears, see your System Manager.

5. Choose any menu com-
mand, or click on an icon 
in your Information Center.

The functions to which you have ac-
cess are based on the preferences 
set by your System Manager.  Menu 
commands that are unavail-able to 
you are dimmed and can’t be used. 
Otherwise, if the menu command is 
available, you can use it.    

If you’re given access to an Infor-
mation Center window, you can 
click on an icon to quickly open a 
production or accounting window 
(depending on your preference). 
Clicking on an Information Center 
icon is the equivalent of choosing 
the menu command.

All of the important menu com-
mands have keyboard equivalents. 

For example, pressing Command-2 
(on a Mac) or Alt-2 (in Windows) 
opens the Job Ticket window.

Starting the Clients & Profits X demo

Getting help. Select the show help bar option 
to display on-line help for many menu com-
mands, toolbar buttons, and window fields. 
The help bar appears at the bottom of the 
window. On a Macintosh, the same on-line 
help is shown by enabling Balloon Help.

Keyboard shortcuts
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Getting Started

The C&P demo contains a small 
sample database (named C&P 
demo.DF1 depending on which 
version you’re using) to use with 
the Clients & Profits X demo. This 
demo database contains sample 
clients, vendors, staff members, 
jobs, costs, and billings. It contains 
a realistic chart of accounts, as well 
as a complete task table, status 
code table, and preferences.  

A sample set of typical us-
ers—including their appropriate 
access privileges—are included as 
examples.  

■  If you’re a current Clients & 
Profits X user, do not use your 
existing database. Instead, use 
only the database converted for 
your Clients & Profits X demo. If 
you accidentally open your existing 
database, it will be damaged—and 
you’ll have to restore a backup.

The demo database contains 
sample jobs, each with a collection 
of typical job tasks. These jobs 
represent the usual kinds of work 
produced by ad agencies, design 
firms, and in-house marketing 
departments. You can print any job 
report, summary, or list using these 
jobs. Or, you can enter your own 
jobs and tasks first.

■  If you plan to share the demo 
database between Macintosh 
and Windows users, follow the 
instructions for networking Clients 
& Profits X on the following pages. 
The name of the demo database 
needs to end with with the exten-
sion .DF1.

This trial version of Clients & Profits X is the actual, working software. It is 
essentially the same software application you’d get if you’d bought it out-
right, except for a few restrictions. Beyond some basic limits (see below), you 
can try everything that’s important to your company.  

■  There are four versions of Clients & Profits X: Clients & Profits Classic X, 
Clients & Profits X, Clients & Profits SQL X, and Job Tracker.  All versions 
have the same production management capabilities, including electronic 
job jackets, estimating, scheduling, time keeping, and cost tracking. Agency 
Manager adds check writing, client billing, and financial accounting—making 
it a complete agency manager. The C&P demo lets you install and evaluation 
any version to see which Clients & Profits X software works best for your 
shop.

Here’s what you can do:  

■  Open a new job ticket. 
■  Edit a job’s estimate. 
■  Print estimates. 
■  Add a task to a job ticket, then change its schedule. 
■  Print a job list. Add a new purchase order. 
■  Enter some time into your Time Card. 
■  Enter some vendor invoices into Accounts Payable.  
■  Post checks for job costs. 
■  Print a work in progress report. 
■  Review a job’s costs on-screen.  
■  Transfer costs from one job to another. 
■  Add a job billing, then print a billing preview. 
■  Print invoices and statements. 
■  Track productivity and profitability by client. 
■  Print an audit trail, then print financial statements.  

Getting Started

Clients & Profits X is the result of 
years of constant development of 
agency production and account-
ing software. It is based on the 
comments, suggestions, criticisms, 
and ideas of over 2,500 Clients & 
Profits X users since 1986. You’re 
not just evaluating software—you’re 
evaluating a system for managing 
clients, jobs, costs, and billings.  

Upgrading to a system like Clients 
& Profits Pro Xbably means a lot 
of re-thinking about how your 
shop works. Clients & Profits X is 
designed to take the work you do 
and make it work better. To make 
the most of your time, focus on 
the features you need most (e.g., 
tracking jobs and billing), and not 
less important features like setting 
preferences and defaults.  

It’s not uncommon for companies 
to take six months or more to 
implement a system as powerful 
and as comprehensive as Clients & 
Profits X . While you can be produc-
tive and useful almost immediately 
(for instance, opening new jobs), 
there are many less apparent func-
tions, options, and settings that 
can wait until the more important 
features are used.

The demo database To make the most of your 
time

LEARN CLIENTS & PROFITS X FAST:  The Clients & Profits 
X tutorial offers self-guided, step-by-step training on 
the C&P essentials—adding jobs, estimating, schedul-
ing, costing, and billing. Look for the fully-narrated 
tutorial on the C&P Demo , or visit the Clients & 
Profits X web site: 

www.cnp-x.com/learn/tutorial/ of
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Clients

Work in Progress/Job Costs/Cur-
rently Billable/Pre-Billing Reports

Billing and Accounts 
Receivable

Client Payments

General Ledger

Job Tickets

Purchase/Insertion Orders

Accounts Payable

Checks In-house Expenses

Time Cards/Time Sheets
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Introducing Clients & Profits X. So what do you do 
first?

Since Clients & Profits X was designed especially for 
the advertising industry, you’ll probably feel famil-
iar with it after only a few days. It’s made to move 
you smoothly through the steps that every job goes 
through: estimating, trafficking, costing, and bill-
ing—the same steps you go through now. But instead 
of using a manual system of job jackets and forms, 
everything will be in Clients & Profits X.  

A little planning helps: With a clear objective (i.e., 
“I want to open new jobs, track our costs, and bill the 
clients by the end of the month”), you’ll have it up-
and-running sooner than later. Remember, over 2,500 
advertising agencies, design studios, and corporate 
graphics departments have been down this road be-
fore—and survived (and even prospered!).  
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It all begins with job tickets. The job ticket is an 
electronic job jacket, just like the ones you’ve been 
using for years. It’s the heart of your system. The job 
ticket remembers everything about a job: estimates, 
schedules, specifications, production status, and traffic 
milestones—as well as what you’ve spent, what you’ve 
billed, and how much you’ve made so far. Once you’ve 
opened a new job ticket, anyone who needs to can see 
it instantly from their own computer. Jobs have tasks 
that describe in detail what needs to be done, like 
copywriting, layout, and printing. Any part of the job 
ticket can be changed any time.
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Daily traffic reports, always up-to-date. Open jobs are 
tracked by production status, which categorizes your 
jobs into stages like estimate pending, in production, 
ready to bill, and closed. You can use lots of status 
codes, and they can be changed any time (so don’t ob-
sess over them now). Most of the job reports, including 
the daily job hot sheet, select jobs by production status.  
Anyone can change a job’s production status anytime 
during the day—from their own computer—instantly 
updating the traffic reports. It’s really easy, and helps 
keep your job reports timely and accurate. In addition to 
job lists, you can also print daily work-to-do reports that 
list unfinished job tasks by staff member. Used together, 
these reports make it difficult to forget deadlines.
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Track your job costs.  First come job tickets, next come 
job costs. You need to track everything you spend to 
get the job done—whether it’s invoices from vendors, 
hours worked from time sheets, out-of-pocket expens-
es like faxes and stats, or direct costs for which you 
wrote checks. Everything you do gets a job number 
and task—that’s how Clients & Profits X knows what 
you’ve spent.  Costs are marked up automatically, so 
billing your clients is easy. Remember, don’t forget any 
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Bill quickly, bill often.  The billing process is f lexible 
and mostly automatic. You can invoice everything 
that’s unbilled on your job tickets, or bill only certain 
tasks by using a billing status code. Invoice billing 
amounts are figured automatically based on job costs, 
but you can easily change them. You can even bill 
tasks that do not yet have any costs. First, you’ll print 
pre-billing worksheets showing unbilled jobs. Account 
executives can use these reports to help decide what’s 
ready to bill.  They can review job costs on-the-spot, 
right from their own computer—then make changes 
directly to the jobs themselves. The changes they 
make are automatically ref lected on the month’s new 
invoices.
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Add it all up, print it out. Clients & Profits X is more 
than a job tracker—it’s a real accounting program. So it 
gives you all of the invaluable insights you need to run 
your shop better. Like profitability by client, task, job, 
or accounting period. Or productivity by staff member, 
client, or task. You can see how much you owe to ven-
dors any day of the month, whether or not the month 
is closed (which isn’t even needed, actually)—as well 
as who owes you.  Every invoice, check, and client 
payment automatically updates your General Ledger, 
which produces your financial statements.  These 
financials can be printed every day if you want to—and 
they’ll always be up-to-the-minute accurate, based on 
the work you’ve entered so far.  So it’s easy to keep 
tabs on how well you’re doing.
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Clients & Profits X is the best-selling advertising agency management 
system for Macintosh and Windows. It is designed to handle everything: 
clients, jobs, traffic, costing, billing, accounting, and more. It supports dozens 
simultaneous users (depending on version) It allows both Macintosh and Win-
dows users to share the same program and database at the same time, from 
anywhere in the office.  And much of the program is customizable (without 
programming) based on each user’s working style.

Designed for Everyone. Clients & Profits X is designed to be used all day, 
throughout the week. We made a major effort to design the windows around 
the work of a production manager and an account executive, so you’ll find 
the job-related features are much more obvious. We’re trying to get the 
system out of the back office and onto the desks of everyone in the shop—so 
it can become an information source for all, not just some, people.  

Friendlier, More Productive. The software is visual, graphic, using easy-to-
understand icons to open jobs, edit estimates, enter time, and more. By 
appeal-ing to your staff’s creative nature, we hope to get both the accounting 
and production users more invested in Clients & Profits X than they are now. 
We expect users to open Clients & Profits X in the morning, then refer to 
it whenever a job is opened, a cost reviewed, time is tracked, etc. Now it’s 
finally easier to track things with the computer than it is to write them down 
on paper. 

■  New features in Clients & Profits X appear in bold.

■  Features will vary based on which version of Clients & Profits X you use.

Features and Benefits

— Clients & Profits X is a single application for both production  
        and accounting
— A modern windows-based user-interface with browser-like toolbar 
buttons and links
— Electronic job jackets
— Seamless integration between job tickets, job costs, client           
        billing, and financial accounting
— Clients & Profits X looks and feels the same for both Mac and 
Windows users
— Visually-oriented, mouse-based for ease of use
— Highly interactive, so users can see what they need to see from  
        their own computer
— Automatic C&P electronic mail for jobs, clients, media, etc.
— User-based passwords restrict access to only functions each  
         user should use
— Customizable options, preferences, and settings can be           
changed without programming
— Customizable Information Center for shortcuts
— Cost-based work in progress accounting
— Built-in one-write, double-entry General Ledger
— Smart, integrated lookup lists (showing jobs, clients, tasks,  
         etc.)
— Large note fields (for longer descriptions)
— Integrated media buying for print, radio, and television
— Built-in Daily Time Card (that can be opened anywhere)
— Batch Posting
— All reports can be exported to spreadsheets like Microsoft Excel
— Custom Report Writer (to design your own job lists, etc.)
— Data is accessible via ODBC (C&P Pro, Job Tracker only)
— Multi-user (supports up to 451 simultaneous users)
— Integrated advertising-tuned spell checker
— Contact manager
— Integrated sales management/CRM system (“Sales>Maker”)
— Built-in company, client, and personal calendars

General FeaturesFeatures and Benefits
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Estimating

Features and Benefits

— Job tickets are opened directly from each user’s computer
— New jobs are available to all users automatically, eliminating  
         the job book
— New jobs are numbered automatically, or you can enter your  
         own job number
— New jobs include a client number, job name/title, contact  
         names, and a detailed description
— Job tickets contain job tasks for estimating, scheduling,  
         costing, and billings
— Existing jobs can be cloned to open new jobs with the same  
         tasks and descriptions
— The job ticket window shows the job tasks’ estimate, billings  
         to date, and unbilled totals
— Online creative brief, work order, and printing specs forms
— Costs for job tasks can be quickly reviewed on-screen
— Purchase and insertion orders for job tasks can be quickly  
         reviewed on-screen
— The Find Jobs dialog box makes it easy to find jobs by client,         
          job name, status, etc.
— New jobs can be created automatically using spec sheets 
         (e.g., production, media, etc.)
— Spec sheets are customizable, and include a template listing  
         typical tasks by job type
— Jobs contain charge numbers for corporate accountability
— Jobs can always be marked as unbillable to prevent billable                 
         costs from being posted
— Jobs for the same project can be tracked together by project  
         name
— Each job contains user-defined fields for tracking special  
         information
— Different users can be adding jobs at the same time
— Jobs can contain up to 9 account codes, cost centers, and  
         billing percentages for chargebacks
— Tasks can be added to a job ticket anytime
— Asset Manager that creates new folders automatically   
         whenever a new job is opened
— Proposal writer
— View>Point drill-downs let you see costs, billings, and orders                                   
for one or more job tasks

— Estimates are created automatically when the job is opened,   
         so there’s no rekeying
— Estimates are based on job tasks
— Estimates let you enter up to 3 estimate amounts           
for each job task
— Estimates are designed for laser printers, so no special forms    
         are needed
— Printed estimates feature customizable margins, fonts, 
         and a logo
— Estimates can be printed many times
— Revisions to estimates are numbered automatically and   
         appear  on the printed estimate
— Previous revisions are saved and can be recalled anytime
— Estimate options include customizable disclaimers, 
         approvals, and distribution names
— Advanced estimates feature a pop-up worksheet for estimat 
         ing hours and expenses per job task
— Change orders can be added for revisions once the estimate  
         has been approved
— Estimates can be billed for any percentage automatically
— Job tasks can be grouped and sorted many ways on printed  
         estimates
— Estimate options can be copied from spec sheets for 
         consistency
— Lengthy descriptions can be entered for each job task; these  
         notes appear on printed estimates
— An estimate can contain a contingency (either a percentage  
         or f lat dollar amount)
— Estimates can be printed for a range of job numbers
— Estimate amounts appear on job summaries and other job  
         reports automatically
— Estimates can be e-mailed as PDF attachments

Job Tracking
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Job Costing, Timekeeping

Features and Benefits

— Clients & Profits X tracks all costs against job tickets
— Different users can add job costs at the same time, from their  
own computer
— The pop-up Daily Time Card lets users track their hours 
throughout the day while they work
— Clients & Profits X tracks all time, including administrative  
time, overtime, and unbillable time
— Time is posted instantly to job tasks
— Every time entry contains hours, a net cost amount, and a  
gross amount
— The week’s hours can be entered in a batch with time sheets
— Time sheets can be entered by the staff member, or in             
batches by an accounting clerk
— Optional time approvals
— Every staff member has a standard hourly cost and billing rate
— Billing rates can be customized by staffer, client, and job task
— Clients can have a custom staff or task-based billing rates
— If a user hasn’t entered enough hours, he or she will be             
prompted to finish their time card before quitting C&P
— You can add purchase orders for vendor purchases
— You can add vendor invoices for both production and 
agency overhead purchases
— Vendor invoices are automatically reconciled with purchase/ 
insertion orders
— Accounts Payable invoices can be distributed to dozens of 
clients, jobs and cost G/L accounts
— A/P invoices can contain billable and unbillable costs on  
the same invoice
— You can write checks to vendors, automatically paying off  
unpaid invoices
— You can write checks for job costs directly, and include             
markups
— Job costs include both a net cost amount (your cost) and a  
gross amount (what the client will pay)
— Markups can be customized by job task, vendor, or on the cost 
itself
— Track internal charges like color proofs, -ROMs, etc.
— Employee expense reports are automatically reconciled             
against check advances
— Unbilled costs can be easily transferred between jobs
— Employee expense reports can be automatically reimbursed
— Credit card statements can be imported in Accounts Payable

Traffic and Scheduling

— Jobs are tracked by production and billing status, traffic            
milestones, and by task schedules
— Job lists sort jobs by status (i.e., new, awaiting approval, in  
production, ready to bill, closed)
— Traffic reports show jobs and their milestones (i.e., approvals,  
meetings, presentations)
— Different job types have different traffic milestones 
— Each job can show up to six different traffic assigments (e.g., 
creative director, copywriter, production manager, etc.)
— Any status code can have a pop-up alert (e.g., “this job is  
closed - don’t use it!”)
— C&P e-mail is sent whenever a job’s status is changed
— Job tasks can be scheduled independently with a start date 
and a due date
— Work to do reports show unfinished tasks by resource, date, 
task, or client
— Job schedules can be printed for clients showing tasks by start 
date
— Each job task can contain lengthy specifications that explain      
the work to be completed; these notes appear on job schedules 
and work to do reports
— Job statuses, traffic milestones, and job schedules can be 
updated quickly in batches
— Jobs can be reviewed on-screen by AE/team
— Client status notes/next steps can be entered for each job, 
then summarized on client job reports
— Scheduling a job checks for staff availability; if the person is 
unavailable, a backup staffer is suggested
— A job’s tasks can be automatically scheduled using standard 
lead times
— Job tasks can be scheduled for completion using mornings or 
afternoons
— Job tasks remember their date finished
— Job lists can be printed for any range of status codes
— Schedules and work to do reports can be printed for any range  
of start dates or due dates
— Schedule Charts can be printed showing selected tasks for any  
range of due dates
— The Weekly Task Planner shows each staff member’s scheduled 
tasks in a daytimer-like format
— Job schedules and traffic information can be updated while  
 adding time in the Time Card or Time Sheet
— Timeline-based Production Planner
— Rush Jobs manager
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Media Work in Progress

Features and Benefits

— Insertion orders can be added for print media buys
— Broadcast orders can be added for TV, radio, and cable buys
— Media buys can be imported from TAPSCAN, Strata, and   
SmartPlus using the C&P Media Link.
— Media estimates can be printed for client approval
— Detailed media plans can be created and printed for print or  
broadcast buys
— The Media Calendar lets media planners and buyers   
easily tracking space closing dates, material due dates,   
and other media deadlines
— C&P e-mail notifies buyers of media deadlines automatically.
— Broadcast orders can be automatically created from broadcast  
media plans
— Insertion orders can be automatically created from print  
media plans
— Media accrual entries update the G/L automatically
— Media can be pre-billed directly from the Insertion Order  
window with a single mouse click.
— A user-defined Publications table lists publication names and  
addresses, along with a list of ad sizes and rates
— A publication’s ad sizes can be looked up and copied to a  
print media plan.
— A customizable Stations table lists tv, radio, and cable   
stations, along with a list of time/programs and rates.
— A station’s time/programs can be looked up and copied to  
broadcast media plans

— Costs update work in progress report instantly as they 
are posted
— Costs feature a user-defined billing status (e.g, Unbilled,  
Unbillable, On-Hold, Killed, Partial, etc.)
— Costs can be reviewed on-screen for one or more job tasks
— The Job Snapshot window shows up-to-the-minute estimates,  
actual costs, billings, and profit to date
— All costs track when and where they were billed automatically
— Work in progress reports can be printed anytime, showing 
up-to-the-minute unbilled jobs
— Work in progress reports show unbilled jobs, tasks, and costs  
by date and status code
— Detailed work in progress reports show costs by billing status
— Costs can be easily and quickly transferred between jobs and  
tasks, even for different clients
— All costs can contain lengthy descriptions for better 
accountability
— Job Progress reports can be printed for clients showing gross 
costs, but not net costs
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Financial Accounting

Features and Benefits

— One-write, double-entry general ledger
— Customizable chart of accounts
— User-defined fiscal year with 24 accounting periods
— Lockable accounting periods
— 9-digit account numbers (not including profit centers,           
account classes, and sub-classes)
— Flexible default settings for standard G/L accounts
— Automatic G/L account coding by job task
— Each G/L account can belong to a user-defined profit center
— Up to 99 profit centers can be created for clients, jobs, tasks,  
          and G/L accounts
— Each G/L account can include a 2-digit department number
— Obsolete or unused G/L accounts can be made “inactive”
— Each account has a customizable ratio and cash flow setting
— Real-time financial statements (print anytime during the  
         period for up to the minute totals)
— Journal entries are posted automatically from A/P, A/R, Client  
         Payments, and the Checkbook
— Journal entries can be added into any unlocked period
— Print journal and audit trails for any date and/or period
— Import payroll entries from CheckMark Payroll (available for  
         Mac and Windows)
— Industry-standard financials (trial balance, income statement,  
        balance sheet, detailed trial balance)
— Track G/L budgets by month using the Budget Worksheet
— G/L account can be combined together (i.e., rolled-up) on  
        financial statements
— Track journal entries by client, job number, and vendor
— Journal entries can be cloned, automating routine entries
— Recurring entries can be schedule for the year in advance
— A special Auditor window makes it easy to find entry errors
— The G/L Reconciliation tool lists uncleared journal entries for     
        a selected account (e.g., prepaid insurance, etc.)
— An online Overhead Allocation Worksheet calculates client    
        overhead using hours, billings, or agency gross income
— Year-end closing is automated and very easy

Billing and Accounts Receivable

— Clients, jobs, and tasks can be billed at any time, for any  
          amount, any number of times, any time during the month
— Invoices are numbered automatically
— You have complete f lexibility over billing amounts
— All unbilled jobs can be invoiced automatically
— As an option, invoices show hours billed or previous billings
— Invoices are designed for laser printers; no forms needed
— Invoices show charge numbers, cost centers from job tickets
— Many jobs can be billed on the same invoice, even from  
            different clients
— Sales taxes are calculated automatically by job task using  
            customizable client rates
— One client’s jobs can be billed to a different client account
— Advance billings can be billed as deposits against job tickets
— Retainers can be billed as deposits against a client account
— As an option, invoices can bill change orders and open POs
— Invoices have customizable billing addresses
— Billing amounts are applied to jobs costs automatically
— The costs billed by an invoice can be reviewed and posted
— Invoices can be printed in batches by invoice number and  
            date
— An Invoice Detail report can be printed with invoices showing  
            costs billed on each invoice
— Invoices can be proofed in batches, then posted (updating  
            the  job, client, and general ledger)
— Billing previews can be printed for approval before posting  
            and printing final invoices
— Client statements show charges and payments or unpaid  
            invoices only
— An invoice’s payments can be viewed from the Accounts 
            Receivable window
— Discounts and adjustments can be applied while adding 
            client payments
— WIP billing creates invoices for unbilled costs for any time
            period automatically
— Invoices can be e-mailed as PDF attachments
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Snapshot Reports System Management and Security

Features and Benefits

— Production reports list jobs by status, unfinished tasks, and  
            work to do
— Work in Progress reports show unbilled costs by job, task, 
            date, and status
— Job Cost reports show buyouts, time, and expenses by date  
            and job status
— Client Account Agings show unpaid receivables
— Vendor Account Agings show unpaid payables
— Cash Flash reports show unpaid payables and receivables by  
           scheduled pay dates and current cash balances
— The Cash Flash totals can be e-mailed to management
— Productivity reports show hours by staffer, job, client, and  
           task
— Profitability reports compare estimates, costs, and billings by  
           client, job, task, and more
— Financial statements can be printed for any accounting             
period, any time during the month

— User-based passwords are customizable
— User-based budget alerts warn users when they’re near or over  
           budget on a job task
— The Introduce Yourself log-in window restricts access to  
           registered users
— User-based access privileges to menu commands and 
           data entry
— Manager-level users can change passwords and access for  
           users
— User accounts and passwords have separate expiration dates
— Users can be restricted to proof and posting only their work
— Users can be restricted to only seeing their own time entries
— Cost amounts and cost rates can be hidden by user
— Users can be restricted from adding, editing, or deleting jobs
— Users can be given view-only access to job tickets
— Each user has a maximum amount for which they can add a  
            purchase order
— Users can be restricted to seeing but not adding, editing or       
            deleting, A/R invoices
— Passwords and access privileges are saved in the database,   
           not the application, so aren’t replaced with software  
            updates
— Different databases can contain different passwords and  
           access privileges
— Users can be restricted from accessing certain clients
— An online In/Out sign-out board helps track who’s here
— An office number can be entered for each database, allowing  
           financials from multiple offices to be consolidated
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Estimates
Every job gets an estimate. Estimates can be edited as 
soon as a job ticket is opened. Estimates can be made 
separately for each new job, or copied (“cloned”) from 
old jobs. Estimate amounts can be entered for some or 
all job tasks. You can revise estimates any number of 
times then print them for client approval. Printed esti-
mates look just like printed invoices. Job reports show 
just how close you are to reaching estimates.

The Job Ticket Flowchart
The Job Ticket is the heart of Clients & Profits X. Everything 
you do for clients is estimated, tracked, and billed through job 
tickets. Open a job ticket when the job is started. Once closed, 
jobs stay in the database for profitability and productivity 
reports.

Flow Chart

Schedules and Traffic
Job Schedules keep you up to date. Job tasks, such 
as ART and COPY, can be given start and due dates 
to make daily traffic reports. Together with weekly job 
status lists, traffic reports show who’s working on what 
jobs and tasks. Dates should be updated daily as work is 
completed and dates change.

♦

♦
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Job Costing
Keep your eye on the bottom line. Everything you spend 
to get a job done is recorded in Clients & Profits X. 
Invoices from vendors should be entered everyday, as 
should time sheets. Checks can be added and printed, 
too. All costs, expenses, and hours update t     he job ticket, 
 so   it’s easy to know the job’s bottom line.

General Ledger
Get up-to-the-minute financial state-
ments. Reports are updated whenever 
costs, billings, checks and payments are 
saved or posted. So you’re always seeing 
current information on job summaries, 
cost reports, and financial statements.

Billing, Accounts Receivable,  
and Client Payments
Client billing is automatic. Jobs can be billed from esti-
mates, work in progress, or at completion. Invoices can be 
made automatically based on the job’s unbilled costs, in-
cluding markups. Some or all tasks can appear on invoices. 
Jobs can be billed any number of times. Printed invoices 
look just like estimates. Print statements and account ag-
ings (which show how much the shop is owed) at any time.

Purchase and Insertion Orders

Flow Chart

Vendor Buyouts

Time

♦

♦
♦

♦

♦

♦

♦
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Using The Information Center To change your Informa-
tion Center window setting

Only a system manager can change 
the Information Center window set-
ting for each user.

1  Choose Setup > Users, Access & 
Passwords.  

2  Select a user from the list on 
the left.

3  Click on the customize info 
center link.

4  Make your changes, then click 
Save.

To open your Information 
Center window

Ordinarily, your Information Center 
window opens automatically after 
introducing yourself. It reappears 
after you close a production 
window.  

The Information Center is optional, 
so you may not see one. If so:

1  Choose My > My Information 
Center.  

2  Click on any icon to open a 
window. 

The Information Center gives you a quick, convenient way to work through 
Clients & Profits X. The Information Center window opens automatically 
whenever you start Clients & Profits X. You can choose an Information Center 
that best fits the way you work: Production, Accounting, or both.  Clicking 
on the different icons on the Information Center opens various production 
and accounting windows—just as if you choose them from a menu. When 
you’ve finished working and close a window, your Information Center returns 
automatically.

The user sees his or her initials, name, and photo (from the Staff window, 
if one has been pasted).  

The Information Center also features a customizable company message.  This 
message appears on everyone’s Information Center window, alerting the 
staff to upcoming events, important deadlines, or agency news. The standard 
message is entered in the Agency Information window, and can be changed 
anytime. Special messages can be scheduled each day using the Daily Mes-
sages utility.

Using The Information Center

Click any button in the Infor-
mation Center to jump quickly 
to that window.
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Using Lookup Lists Using the lookup list to 
send e-mail

If your Clients & Profits X system is 
connected to an SMTP mail server, 
you can send e-mail to the C&P 
Helpdesk while you’re working. This 
makes it very easy to get answers 
to questions about C&P when they 
happen. 

1  Choose File > Get Help

The Send Help E-mail window lets 
you compose a brief message then 
send it to your system manager, 
or to the C&P Helpdesk, the C&P 
online User Group mailing list, or to 
the C&P Wish List.

If you send a question to the C&P 
Helpdesk, the answer will be send 
via a reply to your e-mail. Ques-
tions sent to the C&P User Group 
will be answered by other Clients 
& Profits X like you who also 
subscribe to the online user group. 
Messages send to the C&P Wish 
List are added to the R&D database 
automatically (there’s no reply).

Lookup lists make it easy to find account numbers, job numbers, and more 
while you’re working. They show basic information about clients, jobs, 
staff members, vendors, the chart of accounts, status codes, the task table, 
groups, and purchase orders:  

Lookup lists can be opened anytime, anywhere —even while you’re adding or 
editing something. For example, you can look up a client while adding a new 
job ticket. Once you’ve found the client, double-clicking on the record enters 
it into the “client” field for you. 

The list is updated the first time the lookup window is opened, getting the 
information it needs from the server. (It may take several moments to update 
the list if there are many records to list, or if the server or network is busy; 
you can cancel updating by clicking the Cancel button.) When a lookup list is 
used later, it opens immediately; however, it does not show any recently-
added records. Updating a lookup list brings it current, showing everything 
added into the database so far. You can update a lookup list anytime by 
clicking the Update button.

  

To find something using a 
lookup list

Lookup lists will open automatical-
ly whenever you tab past an empty 
client number, job number, task 
code, or vendor number field.
Also, lookup lists can be opened 
whenever you want using the 
Lookup menu.  For example, to find 
a client: 

1  Choose Lookup > Clients.

The client lookup list account 
shows numbers, names, contacts, 
and phone numbers.  You can sort 
the list by clicking on column head-
ings and the up/down symbol.  

2  Use your mouse to scroll through 
the client records.

3  Double-click on a client record to 
select and use it, or press Return.  

If you are adding a new job or an 
invoice, the client number is en-
tered automatically and the lookup 
window closes.

To print a lookup list  A report 
can be printed showing the 
information found in a lookup 
list by clicking the Print button. 
Records in the printed report 
are sorted in the same order as 
they appear in the lookup list 
window.
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The job ticket is the foundation for everything that happens in Clients & Prof-
its X.  The job ticket is an electronic job jacket that remembers dates, costs, 
and other information about the work you do.  

Everything you do for a client should be added as a job ticket. Job tickets 
should be opened before the work has begun so that estimates, costs, and 
time can be tracked accurately.  Job tickets are used throughout the system 
to manage production, traffic, estimates, costs, and billings. For example:  all 
kinds of costs are given job numbers when they are added; these costs appear 
on job reports automatically.  

Estimates, costs, hours, and billing amounts are tracked on job tasks. Job 
tasks are the actual things you’re doing to get the job done:  artwork, 
copywriting, typesetting, printing, etc. A job can have one or more job tasks 
(there’s no limit) of your choosing. A Task Table lets you set up a list of stan-
dard tasks and their settings, such as markup and taxable status. 

Clients & Profits X substantially automates job tracking. Jobs are numbered 
automatically as they are opened, eliminating the job book you’re probably 
using now.   You can make up job spec sheets that contain basic information 
about a type of job, such as the tasks that belong to a job type. These spec 
sheets can be applied to new jobs, instead of keying in information manually. 
Production status, due dates, and traffic details can be updated throughout 
Clients & Profits X, making it easy to keep your work current—from any PC 
or Mac in the shop. Any job can be cloned, making an exact duplicate for a 
new job.  

Except for the job number and client, everything about a job ticket can be 
changed as much and as often as needed. Most of this job information is 
optional.

Clients & Profits X can handle hundreds of jobs at the same time. Thousands 
of jobs can be part of your database at any time, making it quick and easy 
to review your job history. Clients & Profits X even keeps a daily diary of 
changes to job tickets.

Since Clients & Profits X is 
designed to manage hundreds of 
jobs simultaneously, it provides an 
intelligent way to find just the jobs 
you wish to see.  If you know the 
job number that you wish to find, 
do this:

■  Choose Production > Job 
Tickets, then enter the job number, 
then click Find.  The job ticket 
window appears displaying your job 
and its tasks.  But what if you don’t 
know the job number?  Clients & 
Profits X makes it easy to find the 
job:

■  Choose Production >Job 
Tickets, then click the Find More 
link. Select “client” from the Find 
by pop-up menu.  Enter a client 
number, then click Find.  The Find 
Job Tickets window lists all of the 
jobs for the client.  Jobs are sorted 
by job number, but you can sort 
them differently by clicking on 
the name/title, contact, or other 
column headings.  

Once you’ve found the job you’re 
searching for, double-click on it to 
display the entire job and its tasks.

Jobs can also be selected by job 
name (which can include any part 
of the name/title), production 
status, billing status, project and 
client purchase order number.

Anything about a job can be 
seen and changed by choosing 
commands from the Edit menu 
or by clicking on a button in the 
window’s tool bar:

Estimates  Enter budgets, esti-
mates, and estimated hours for job 
tasks.  

Specs Keep details like name/title, 
start and due dates, and a long 
description.

Schedule, Traffic Track jobs by due 
dates, production status and traffic 
milestones.

Snapshot See the job’s up-to-the-
minute remaining estimate, costs 
to date, billings, and profit so far.  

Contingency  Show a f lat amount 
or percentage on the printed 
estimate.

Change Orders  Tracks authorized 
changes to the job’s estimate.

Work in Progress  Lists each cost, 
time entry, and expense posted so 
far, including whether it is billed, 
unbillable, on hold, etc.

Job Diary  See a history of the daily 
changes to jobs, tasks, status, etc.  
Anyone can add diary entries for 
client meetings, etc.

Job Tickets

Job Tickets To find a job ticket Working with  job tickets
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The Job Ticket window

1  The arrow toolbar buttons can 
be used to scroll through the previ-
ous and next job tickets.   

2  These toolbar buttons can be 
used to add, clone, edit, and de-
lete job tickets.  Click the add new 
job ticket button to add a new job.  
Existing job tickets can  be cloned 
into new jobs by using the clone 
job button.  Click the edit button 
to edit the job’s key information 
found in the Specs window, such 
as the client contact, job name/
title, project, job type, start date, 
or profit center.  Click the delete 
button to delete a job ticket. 

3  Tasks can be easily added or 
removed from job tickets.  Click 
on the add new job tasks button to 
add a new task to the job ticket.  
Click the remove task button to 

remove a task from a job ticket.
  
4  These toolbar buttons can 
be used to print job reports and 
estimates.

5  A job ticket can be found by 
entering in the job number here. 

6  These links allows you to add, 
edit, view, delete, or print creative 
briefs, estimates, specs, change 
orders, work orders, or assets.

7  History keeps track of the job 
tickets that you previously viewed. 

8  The job’s view>point pop-up 
menu contains links to view and 
track the job’s progress.

9  The job’s key information is 
listed here for reference.

10  Clicking on the closed box 
closes a job by giving it a closed 
status.

11  The priority status describes 
the priority level for this job ticket 
to let staff know which jobs need to 
be worked on at a quicker pace.

12 The estimate vs actual hours 
graph shows the percent of total 
hours entered on time cards in 
red; the blue slice is the percent of 
estimated hours remaining.

13  The estimate vs billed graph 
shows the percent of estimate that 
has been billed in red; the blue 
slice is the estimate remaining. 

14  Job tasks are used to track 
estimate amounts, costs, hours, 
billings, and unbilled costs. 

15  The job’s scheduling window is 
where you can setup and edit task 
due dates and resources.  The job’s 
traffic window is where you can 
edit the job’s key traffic informa-
tion such as the production status 
code, status note, or milestone 
dates.  The timeline window shows 
a linear graph of the job schedule.

16  Production status and billing 
status codes track a job’s progress 
from start to finish, such as esti-
mate pending, in production, ready 
for billing, or billed and closed.

17  The traffic assignments can be 
used to assign up to six key staff 
members who are responsible for 
the job. 

18  This box is a user-defined way 
to show an at-a-glance look at how 
far from completion a job ticket is.
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Job Tasks

Tasks do the real work of job tracking, since they track every dollar of 
estimates, cost, time, and billing from start to finish. They really have 
two distinct roles:  one for accounting and another for production.  On the 
finance side, job tasks are used throughout the system to track what’s been 
estimated, spent, billed, and earned.  Tasks are the line items clients see on 
estimates.  They are the detail that appear on clients invoices.  Profitability 
reports compare each task’s costs and billings to analyze a job’s profit.

On the production side, 
job tasks represent the 
individual steps you’ll 
perform to complete the 
job.  For scheduling, you’ll 
give each task a due date, 
start date, and the name 
(or initials) of the resource 
who’ll complete the task.  

Tasks are separate, but 
related, to jobs.  The job 
itself doesn’t actually track 
estimates, costs, hours, 
and billings.  Instead, it 
leaves it to the task to 
manage these things.  
That’s why a job without a 
task can’t track anything.  
You’ll never add a job cost 
or billing without entering 
both the job number and the task code. 

A job must have at least one task, but can have hundreds—it’s your choice.  
Anyone can add tasks to a job ticket (that is, if they have the access privi-
leges).  A task can be added to a job anytime and from many places in Clients 
& Profits X.  Tasks are usually added at the time the job is opened.  Many 
tasks can be added to jobs quickly if you apply a spec sheet to a new job 
ticket.  You can set up the spec sheet’s template to include all of the tasks 
for a certain type of job, such as brochure, to save time.

The tasks you’ll add to jobs are part of a Task Table.  The Task Table contains a 
master list of every task you’ve ever used (and probably ever will use).  Each 
task includes basic information like a name, standard markup, group and 
sort, and a default general ledger account for cost and income.  When a task 
is added to a job, its basic (or “default”) information is copied from the Task 
Table to the job ticket.  This saves time, since you don’t have to re-key the 
details for a task such as ART on each job ticket.

Once added, job tasks can be instantly used for estimating, scheduling, 
costing, timekeeping, and billing.  Tasks can also be added later while you’re 
working from Accounts Payable, Time Sheets, Purchase Orders, and the 
Checkbook using the lookup list.  Remember that the same task can’t be 
used twice on the same job.

Job Tasks

To add a job task

New tasks can be added at any time during a job’s existence, but are usually 
added when the job is initially opened. From the Job Ticket window, choose  
Edit > Add New Job Tasks. The Add Tasks window opens, listing the job’s cur-
rent tasks. You can only add tasks in this window.  
Enter the task code if you know it, or leave the field empty then press Tab. 

The Task Table lookup list appears, 
listing tasks. Use your mouse (or 
arrow keys) to find the task you 
want, then double-click on it.  The 
task code will be entered to the job 
automatically. The task’s descrip-
tion, group, and sort are copied 
automatically from the Task Table.

Change the description, group, and 
sort then press Tab to move and 
save this task. The task is added to 
the job ticket immediately. Repeat 
these steps to add more tasks, then 
click Done to finish.  The task’s 
long description can be edited 
while adding a task by clicking on 
the note symbol.

To edit a job task

Job tasks can be changed anytime 
as needed. Everything about the task, except its code, can be changed on the 
job ticket. Editing a job task doesn’t affect the Task Table or the same task on 
other jobs, so you’re free to change it any way you want. To edit a job task, 
double-click on the task in the Job Ticket window.
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The Edit Job Task window

1 The remove button can be used 
to delete the task from this job 
ticket. Once a task has activity 
(i.e., costs, billings) it can’t be 
deleted.

2 The job number and title are 
listed here for reference.

3 The jump to pop-up menu allows 
you to quickly view another task on 
the job ticket. 

4 Each task can have a custom 
icon to illustrate its function. Task 
icons are copied from the Task 
Table to new job tasks and appear 
on work to do reports.

5 The task code uniquely identifies 
the task on costs and billings, 
like ART or COPY. The task name 
briefly describes the task’s purpose 
or function, such as Artwork or 
Copywriting. Clients see task 
names, but not task codes, on es-

timates and invoices. Once added, 
the task code can’t be changed but 
can be renumbered using Utilities.

6 Job tasks marked as finished 
don’t appear on traffic reports. 

7 The task’s description appears on 
printed estimates, invoices.

8 To show the task description on 
many job reports, check the show 
description checkbox.

9 Use the always unbillable option 
to prevent billable costs from being 
added to a job task.
 
10 Job tasks can be arranged into 
user-defined groups by entering an 
optional group number. 

11  Job tasks can be sorted within 
a group using a sort number. 
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12  Each task can have its own 
standard debit G/L account (dGL, 
for job costing) and credit G/L 
account (cGL, for billing) that will 
be automatically copied to A/P 
invoices, checks, and A/R invoices. 

13  A job task can be tracked using 
a production status, just like the 
job. 

14  Each task can have its own 
markup, which replaces the 
vendor’s markup on A/P invoices 
and POs. A media commission can 
also be added for each task. The 
media commission is copied to 
Media and Insertion Orders. 

15  Each job task tracks up to two 
sales taxes, or it can be nontaxable. 
The task itself determines whether 
or not the billing amount is taxable. 
The client account will determine 
what the tax rate is for estimating 
and invoicing. 

16  Each task can be set as an 
estimating/billing task, scheduling 
task, both, or neither. Estimating 
tasks appear only on the estimate 
window, and will be billed on A/R 
invoices. Scheduling tasks appear 
only on the job schedule, and can’t 
be estimated or billed. Tasks with 
neither option are for internal job 
costing only, and won’t be billed. 

17  The roll-up option allows you 
to combine several tasks belonging 
to the same group to be combined 
into one task total on the estimate 
and/or invoice. 

18  You can control the billing rate 
used on time cards and time sheets 
by choosing a billing rate method. 
The standard setting is changed 
in Preferences, then copied to 
each job. Both clients and staff 
members can have different sets of 
billing rates.
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Estimating

Estimates are not “created” separately from the job ticket.  Instead, estimates 
are an integral part of the job and its tasks. Estimates are based on the tasks 
you’ve added to a job; in fact, tasks are the basis of the estimate. So the de-
tails you enter for a task—the task name, group, sort—is what the client sees 
on the printed estimate. This is very important: Jobs are estimated by job task 
only. Unless a job ticket has tasks, you can’t edit its estimate.

A job ticket has only one estimate, but that estimate is f lexible. Since a job 
can have many tasks, you’ve got 
the ability to make very detailed 
estimates for your clients. An 
estimate can be revised any num-
ber of times as needed (estimate 
revisions are numbered automati-
cally, and appear at the top of the 
printed estimate). Revisions are 
retained, so previous estimates 
can be reprinted.

Estimates can be revised and re-
printed as many times as needed. 
Printing an estimate doesn’t 
affect its production or billing sta-
tus. Estimates print on letterhead, 
and have several customizable 
options.

■  Estimates feature three dif-
ferent customizable estimate 
amounts. All three columns 
can be used when estimating large jobs with 
either phases or differently-priced options.
Or a single column can be used for less 
complex jobs.

The names of the three estimate amounts are 
customizable. They can be used to handle jobs 
with multiple print quantities (e.g., 1M, 2M, 5M). 
Or they can be used to show revisions (e.g., Original, Revised, Final). Or, they 
can offer a client a choice of qualities (e.g., 1-color, 2-color, 4-color). For f lex-
ibility, any one of the three amounts can be shown on the printed estimate. 
Or, you can show all three amounts on the same page—giving your client 
an easy way to choose which estimate to authorize. In addition, all three 
amounts can be combined together to show a total estimate.

Estimates also have a unique, powerful feature: the estimate pop-up work-
sheet to speed up estimating.  The worksheet lets you budget time for up to 
four different staff members and up to four different costs for each task. The 
task’s estimate is calculated automatically based on your entries, replacing 
your calculator.  

An estimate’s column headings can be included as part of the job type/spec 
sheet.  When a new job is opened with this spec sheet, the column headings 
are copied automatically. (The estimate’s column headings can be fine-tuned 
while you’re editing the estimate amounts, which only affects the job being 
edited).

To edit a job’s estimate

1  From the Job Tickets window, 
find the job whose estimate you 
wish to edit.

2  Click the Estimate button, 
or choose Edit > Edit Jobs > 
Estimate Amounts.

The Estimate window opens, 
listing the job’s estimate/billing 
tasks. Tasks are sorted by group, 
just as they’ll appear on the 
printed estimate. 

3  Enter the estimate’s amounts, 
then click Save.

The Estimate window features 
several useful shortcuts that 
make entering estimates faster 
and easier. These shortcuts lets 
you add or remove tasks from the 

estimate, clear the estimate and start over, copy estimate amounts, edit the 
task’s description, and change the estimate’s options.

Clients & Profits Xvides several useful shortcuts that help make editing a 
job’s estimate easier and faster. Several useful shortcuts can be used while 
the estimate is being edited. 

Estimate-only tasks keep 
off traffic reports. A job 
task can be used for esti-
mating and billing only, 
scheduling only, or for both 
functions. Estimate-only 
tasks don’t appear on job 
schedules.
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The Estimate window

1  Any estimate/billing job task can 
be added to the job ticket from the 
estimate window by using the add 
task button. Only tasks that have 
no costs, time, or billings can be 
deleted from the job ticket using 
the remove task button in the 
estimate window.  

2  To erase the entire estimate, use 
the clear toolbar button. Estimate 
amounts can be copied from one 
column to the next by using the 
copy amounts button.

3  Use the print estimates button 
to print the estimate.  
  
4  The job number and name/title 
appear here for reference.  

5  The job’s initial budget is the 
ballpark amount that was entered 
when the job was opened and 

appears here for reference. The 
initial budget doesn’t appear on the 
printed estimate.

6   Each job task has it’s own 
pop-up estimate worksheet that can 
contain hours and amounts for up 
to four staff members (including 
their own billing rates) and up to 
four kinds of expenses (including 
markups). The estimate can be for-
matted in many different ways by 
using the estimate options button. 
The task description button can be 
used to edit the job’s description, 
taxable setting, and roll-up task.

7  The job’s previous estimates can 
be recalled using the show estimate 
revision pop-up menu. The menu 
lists the job’s prior revisions, plus a 
New Revision option to start a new 
revision. 

8  There are three customizable 
column headings that can be used 
to format the job’s estimate.  

9  The job’s tasks are sorted by 
group and are identified with an 
asterisk if they are taxable.

10  The budget is  your cost for 
the task before markups, fees, and 
commissions. The budget amount 
is used in reports to compare the 
budget vs estimate and for budget 
alerts to warn users when they’re 
near or over budget on a job task.

11  The estimate hours for a 
task are the number of hours you 
estimate it will take to finish the 
task. Job reports use these hours to 
compare against actual hours.  

12  The estimate amount can be 

calculated using the estimate work-
sheet. Double-click on the task line 
to open the estimate worksheet, 
then enter staff, hours, and rates. 
The data entered here is copied to 
the estimate.  

13  Before approval, an estimate 
can have up to three estimate 
amounts to show clients different 
versions of the estimate.

14  The final estimate—the one 
that the client approves—appears 
on the job ticket window, job sum-
maries, and other reports. 

15  The estimate can be approved 
online to indicate that the client 
has approved it. Once approved,  
no more revisions can be made 
to it. If needed, the estimate can 
be unapproved by the user who 
approved it.
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The pop-up menu will list the number of prior revisions, along with an option 
to recall the job’s original estimate amounts. To recall a previous revision, 
simply choose it from the pop-up menu. In addition, a previous revision can 

be made current by clicking the  (i.e., Make Current) button. A new revi-
sion will be created using the previous rev’s 
amounts.

Choosing a final estimate

Although a job can have up to three different 
estimates, only one is considered the final 
estimate. It is the one of which the client 
approves. The final estimate’s amounts appear 
on  the job ticket window, job summaries, 
and other reports. The Final Estimate pop-up 
menu shows the names of your estimate 
columns, along with options for “none” (i.e., no 

estimate) and “all” (i.e., when all estimate amounts are combined). Choosing 
one of the three estimates makes it final. This selelction isn’t saved unless 
the estimate is saved.

To print estimates 

1  From the Job Ticket window, choose click the  (i.e., Print Estimate) but-
ton, or choose File > Print Estimates.  

The Print Estimates window opens. The currently-displayed job number is 
entered automatically, but can be changed.

2  Enter a job number.

3  Choose which estimate should be printed, its options, then choose a desti-
nation from the Print to pop-up menu.

Use the print distribution copies option to print up to five separate copies of 
each job estimate. It lets you print copies without using carbonless, multi-
part forms. A copy will be printed for each distribution name entered into the 
Estimate Options window. If no distribution names have been entered, only 
one copy of the estimate will be printed.

Estimating (con’t)

Estimating

Clients & Profits provides several useful shortcuts that help make editing a 
job’s estimate easier and faster. Several useful shortcuts can be used while 
the estimate is being edited. 

Budget amounts

Each job task can have budget amount. The budget amount represents the 
agency’s cost to produce 
the task. It is the amount 
of money and time you’re 
planning to spend to 
finish the work. Unlike 
estimate amounts, budget 
amounts don’t include fees, 
markups, or commissions. 
Clients don’t see budget 
amounts—only estimate 
amounts. So they’re used for 
internal cost tracking only.  
Job reports compare budget 
vs. estimate to 
calculate the job’s gross margin. Also, 
budget alerts use this amount to warn user 
when they’re near or over budget on a 
job task.

■   Each task only has one budget amount. 
Even if three estimate amounts are entered, 
enter the budget amount as the agency’s 
actual cost to finish each task.

Revising estimates

Clients & Profits X automatically tracks the various revisions to a job’s 
estimate. The job starts with an original estimate, which can be changed 
many times before it is presented to the client. But once the client sees 
the estimate, any changes requested by the client should be reflected in 
“revised” estimate. Each official revision gets its own revision number, which 
is generated automatically. The revision number appears on the printed 
estimate to help you and your client keep track of the various versions of the 
job’s estimate. Once the client approves it, no more revisions are made to the 
estimate. 

A job’s original estimate can be changed many times before it is printed for 
the client’s approval. To make the first official revision, choose New Revision 
from the Show Est Rev pop-up menu. The original estimate is saved, but 
the new revision becomes the current estimate. When the first revision’s 
estimate amounts are saved, they’ll appear on the printed estimate. Every 
time the estimate is edited, users can decide whether the changes should be 
a new revision; if so, they’ll choose New Revision from the pop-up menu each 
time. 

When a client says “ok.” 
Although a job can have 
three versions of an estimate, 
only one becomes the “final” 
estimate. The final estimate’s 
amounts appear on job re-
ports to compare estimate vs. 
actual billings. Amounts from 
the “final estimate” are also 
used for estimate billing.
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The printed estimate

Estimate
Date 05/21/07

Marta Jones Number 06-ABI-173
American Bios/Integrated Systems Revision Original

AE/Team AK
Cost Center: 3-394-94989
Due Date: 09/14/06

Name/Title: Bliue Sample & Die Lap Top Package
Acct. Super. Tammy Burns

Phone: 213 999-1927

Desc/Specs: Design/Layout & Production of Package
Blue Sample & Die
Copy Refinement
Name Treatment - color
B&W layouts (rough)
Tight B&W Layouts
Final Mechanical Art
B&W Line Drawings

Description Estimate:

Creative $2,520.00
Production $1,770.00
Fulfillment $576.00
Account Management $330.00

Subtotal $5,196.00

*8.2500 % State Sales Tax: $428.67

TOTAL $5,624.67

Including 10.00% contingency: $6,187.14

This estimate includes only the items listed above, and
 does not include client revisions that exceed the estimated amount.

Approvals

Client Date:
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Change orders document changes made to a job’s estimate after it has been 
authorized. They prevent potentially costly misunderstandings between the 
agency and the client when a job has gone over budget. 

When a change is requested (by either the client or the agency, it doesn’t 
matter), a change order can be added then printed. The printed change order 
resembles an estimate. Unlike the estimate, it only shows the cost and 
description of the change being requested. The client signs off on a change 
order just like they sign off 
on an estimate, giving the 
authorization to exceed 
the job’s estimate. A new 
change order is printed 
automatically when it is 
saved.

Change orders are better 
than printing a revised 
estimate, since it doesn’t 
remind the client of the 
job’s total cost. Clients 
see only the change order 
amount. A change order 
doesn’t affect the job’s 
original estimate, either. 
Instead, a separate change 
order amount is tracked for 
each job task.  

A change order can include 
up to six tasks from the same job ticket. 
A long note can be included to explain what’s 
being changed. Since clients will see this 
information, don’t enter anything confidential 
or potentially embarrassing. Each change 
order has a standard type that quickly identi-
fies the kind of change order: Additional Info, 
Agency Corrections, Client Revisions, F-Y-I, or  a 
custom change order type. Task estimate and change order amounts appear 
on job progress reports. Both can be billed automatically in Accounts Receiv-
able. Change orders do not require an amount, but can be used to document 
changes to a job even if there will not be an additional charge. E-mail will 
be sent to the job’s traffic assigments informing them instantly of any new 
change orders.

To see a job’s change orders

1  From the Job Ticket window, click the Change Orders link or choose Edit > 
Change Orders.

The Change Orders window opens, listing the job’s change orders sorted by 

Change Orders

date (newest entries first).  Entries can be resorted by clicking on the different 
column headings (i.e., when who, what).  The sort order canbe reversed by 
clicking on the sort buttons in the toolbar.

To add a change order

1  From the Change Order window, click the Add button

2  Select a type, then enter 
the date, description, and 
notes.

This information appears on 
the printed change order, so it 
should be clear and complete. 
Type is used for reference, 
and doesn’t affect the change 
order. The last option sup-
ports a user-defined type of 
change order.  

3  Enter up to six tasks and 
amounts.

Enter the new budget and 
estimate gross amounts 
(including markups, fees, 
and commissions). Click the 
Lookup Job Tasks button to 

see the job’s tasks; double-clicking on a task copies it to this change order.

4  Click Save.

To edit a change order

Unapproved change orders can be freely edited. Everything on the change or-
der, except for the number, can be changed. From the Change Order window, 
double-click on a change order, make your changes, then click Save. You’ll be 
prompted to reprint the change order each time it’s edited.

■  To approve a change order, click the OK’d by client checkbox.  Once the 
Ok’d by client option is clicked, the change order cannot be edited.  You can 
uncheck the OK’d check-box later if needed.

To delete a change order

Unapproved change orders can be deleted anytime by selecting the change 
order in the Change Orders window, then clicking the Delete button. Delet-
ing a change order deducts its amounts from the change order totals on job 
tasks. An approved change order can’t be deleted.

Change Orders

Approved change orders.
When a client signs off 
on a change order, it can 
be marked as “approved” 
in Clients & Profits X. 
Approved change orders 
can’t be changed, keeping 
your job costs accurate.
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The Add Change Order window

1  Change orders are numbered 
sequentially to track how many 
change orders have been added 
to a job. 

2  Use the type pop-up menu to 
categorize the change order. It 
appears on the printed change 
order, and includes Additional Info, 
Agency Corrections, Client Revi-
sions, FYI, and Other, which allows 
you to create your own change 
order type name.

3  The date and time the change 
order was added is entered auto-
matically, along with the staffer’s 
initials who added the change 
order.

4  The name of the client contact 

is automatically entered on the to 
line, but can be changed.

5  Enter a brief description of the 
change on the subject line.

6  Change orders can contain a 
lengthy description to document 
the change. They appear on the 
printed change order. 

7  Every task that is on the job is 
listed. Add hours, a budget amount 
(your projected cost) and the esti-
mated amount you’ll show to the 
client. Only the tasks have amounts 
will appear when printed.

8  If enabled, an automatic e-mail 
will be sent to staffers selected 
in the notify list. There is no limit 
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to the number of staffers you can 
select.

9  The names chosen using the to 
be approved by button appear at 
the bottom of the printed change 
order.
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Clients & Profits X is a complete production/traffic manager, providing an 
easy way to print daily job status, weekly traffic, and staff work to do reports. 
The traffic system has four parts: job tickets, production and billing status 
codes, traffic milestones, and unfinished tasks. 

The job ticket is the basis of the production, traffic, and scheduling system. 
Jobs have status codes that categorize their progress through completion. 
A standard collection of status codes, called a Status Table, is completely 
customizable. Everyone uses the same status codes to classify their own 
jobs, such as Awaiting Approval, Estimate 
Pending, In Production, and Closed - Ready 
for Billing. Since status codes offer a 
consistent, predictable way to track a job’s 
progress, they make it easy to coordinate 
many jobs among different account execu-
tives or teams.  

While jobs and status codes show the big 
picture, it’s the job tasks and due dates 
that really get the work done.  Every job 
task can have a due date, start date, and 
a resource assigned to do the work. Jobs 
can be scheduled in detail, so you’ll know 
what’s due every day.  Work to do reports 
show the day’s unfinished job tasks, with a 
separate page for each person. Job sched-
ules can be moved forward, backward, 
or otherwise rearranged anytime—and 
the daily work to do reports are updated 
automatically.

Traffic reports show jobs by status, including
 important dates and times.  These key events, 
called milestones, track client meetings, 
creative approvals, press checks, and more. 
A job can have up to twelve different traffic 
milestones (you can use any or all twelve as 
needed; different kinds of jobs will need more 
or less detail). Milestones can vary by job type, 
so they are included as part of a spec sheet. 
Traffic reports group jobs by job type, showing, 
for example, all of the brochures, radio spots, ads, etc. for easier job tracking. 
Jobs may not need milestones unless they are complex.

The key people responsible for getting jobs done can be assigned to each job. 
These traffic assignments can then be used when printing traffic reports.

Tasks vs. milestones

Each job type has up to 12 milestones to track its key events and deadlines. 
Unlike tasks, they’re usually not the individual steps needed to do the job. 

Traffic

Traffic

Tasks, in contrast, track the daily work required to complete the job. Tasks 
contain much more detail, including start date, due date, who will do the 
work, and several different long descriptions. Milestones enhance the status 
report by showing the job’s vitally important dates and times, instead of 
every unfinished task. Milestones are best for tracking only the big deadlines 
that can’t be missed. Traffic reports are printed by status code, while work to 
do reports are printed by due date. Unlike traffic reports, job and task sched-
ules can be printed for any period of time (e.g., the week after next). Use 
tasks when you want to schedule each step the job will take. Task reports are 

more flf lexible, and can be sorted by many 
factors such as resource and client for more 
f lexibility.

Production status vs. billing 
status

A job can have two status codes—one for 
production, the other for billing—to avoid 
contention between production people and 
accounting people. Using a production sta-
tus, a production manager can freely track 
jobs and not worry about the accounting 
manager’s unbilled job report.  Likewise, 
the accounting manager can maintain a job 
list showing unbilled, closed, or unbillable 
jobs by billing status without interfer-
ing with production.  This is because the 
production status and billing status are 
essentially unrelated to each other on the 
job ticket. All job reports can be printed 
by production or billing status. This way, 

the production department and the accounting department can see jobs their 
own way.  The production status and billing status share the same status 
table, but can have entirely different meanings.  Since status codes are user-
defined, it’s your choice.  The job can have the same status, such as awaiting 
approval or closed, billed for both the production and billing status.

■  To add, change, or delete a status code, choose Setup > Status Table.

Dozens of status codes for 
jobs and tasks. The Status 
Table contains dozens of 
custom status codes for 
tracking production, billing, 
and task status. Each status 
code can notify staffers 
when it is added to a job 
ticket.
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Traffic Features

Feature How it works, how it’s used

The jobs’ production status can be quickly and easily updated throughout the day, then summa-
rized every morning on the Daily Job Status report.

The Weekly Traffic reports lists open jobs and their traffic milestones. The jobs’ milestones can be 
updated throughout the day as they change, then summarized for weekly traffic meetings.

Anyone who works on jobs can see their week’s deadlines from the Weekly Task Planner window. 
Scheduled job tasks can viewed for the next four weeks. 

Production and traffic managers can review unfinished job tasks by client, staff member, AE/team, 
etc. from their own PC in real-time. Tasks can be instantly and easily rescheduled here.

Snapshot reports analyze job tasks to track on-time performance, missed deadlines, and more.  

Clients & Profits X notifies staff members via e-mail when job tasks are due, when a job’s status 
has been changed, when a client is billed for a job, and when the client pays the job’s invoice. In 
addition, upcoming follow-up calls can be scheduled for clients in the Client Diary.

The Status Table can contain hundreds of different production, billing, and task status codes. Sta-
tus codes are use to categorize jobs based on their progress, from start (i.e., “new job”) to finish 
(i.e., “closed”) and every stage in between. All traffic reports show jobs by status.

Each job can have a customizable status note to brief ly describe the job’s current status, or its 
next step. Status notes appear on the Daily Job Status report and other traffic reports.

Status codes can include customizable status alerts. These alerts can be set to stop a staff mem-
ber from working on a job that’s not approved, already billed, or closed.

The key phases or production steps (i.e., work f low) for every type of job can be predefined for traf-
fic reports. The job’s traffic milestones help production and traffic staff manage work f low.

A job’s production/billing status, status notes, milestones, next steps, and due dates can be easily 
and quickly updated while entering time, as well as from the Job Tickets window.

Staff members can schedule themselves out on their Availability Calendar for any morning, after-
noon, or entire day. When a staff member is scheduled for a job task, Clients & Profits X checks 
the staffer’s availability. The user scheduling the job is immediately warned that the staff member 
is unavailable.

An instant “ballpark” schedule can be instantly created for a new job. The ballpark schedule calcu-
lates the start and due date for every task on the job using each task’s lead times. It’s a quick way 
to make an educated guess about when a job can be completed. The due dates from a ballpark 
schedule can be fine-tuned to produce the final job schedule.

Special sub-tasks can be created for scheduling different people for the same task. For example, 
the task COPY for copywriting might involve several copywriters, proofreaders, and fact checkers. 
Sub-tasks can be added for COPY to schedule due dates and resources for everyone responsible 
for the job’s copywriting. Sub-tasks appear on work to do reports, but don’t affect estimates, job 
costing, or billing.

Daily Job Status Reports

Weekly Traffic Reports

Weekly Task Planner

Work to Do

Traffic Analysis

Automatic e-mail Notification

Custom Status Codes

Status Notes

Status Alerts

Traffic Milestones

Easy Traffic Updating

Resource Availability

Ballpark Schedule

Scheduling Sub-Tasks

Traffic
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There are three parts to job traffic: status codes, traffic notes, and milestones. 
Status codes classify jobs, such as new, in production, awaiting approval, and 
ready to bill. Traffic notes describe anything about a job’s progress, such as 
the results of client meetings. But milestones give you real information. 

Milestones represent key events or phases, such as the dates of creative 
meetings, client approvals, press checks, etc. Each job type can contain up 
to twelve different milestones (but not all milestones need to be used). They 
vary by job type, so each type of job (brochure, ads, radio spots, etc.) has its 
own customized set of milestones.  Traffic mile-
stones are optional, but can be very useful when 
used together with status codes to better track 
the shop’s production.  

Traffic milestones are part of the spec sheet. If 
a job doesn’t have a spec sheet, it doesn’t track 
traffic milestones. Also, the spec sheet must have 
milestone headings; if not, this job can’t track 
milestones. Jobs with the same job type share the 
same milestone headings. 

The initials of the job’s key creative, 
production, and account people can entered 
as traffic assignments (i.e., traffic names). 
Jobs can be selected by traffic names, providing 
traffic reports by creative director, 
account supervisor, copywriter, etc.

To update one job’s traffic status

From the Job Ticket window, find the job you 
wish to update then click the Traffic button. 
The job’s traffic window opens, displaying its 
current production and billing status, 
status note, start and due dates, traffic notes,  
and milestones. Enter the job’s up-to-date  
production and billing status, status note, next 
steps, milestones, and other traffic information 
then click Save. The changes to the job’s traffic 
status update production reports immediately. 
Once the changes are saved, anyone looking at this job will see the up-to-
date traffic information.

■  If the job’s status was changed, an e-mail message will be sent immedi-
ately, if applicable. The status e-mail will automatically notify selected staff 
members when a job’s status changes.

Updating Traffic

To update traffic status for many jobs

1  To update the Choose View > Traffic.

The Find Job Tickets dialog box opens, prompting you to enter selections for 
finding jobs.

2  Choose a find option from the pop-up menu (e.g., client) then enter a find 
value (e.g., client number).

3  Select a status then enter a range of status 
codes, then click Find.

Jobs can be selected by production or billing 
status, and any range of status codes. This options 
let you find only open jobs, for instance. The jobs 
you’ve selected are listed from the file server into 
the Update Traffic window.  Jobs are sorted by job 
number, but can be arranged by clicking on any 
column heading. Jobs are grouped by job type to 
make it easy to analyze and update traffic informa-
tion for the same types of jobs (e.g., brochures, 
interactive, etc.). To see jobs for a different job 
type, choose another job type from the Job Type 
pop-up menu.

4  Click once on a job’s first milestone to select it 
for updating.  

The job’s traffic assignments, milestone headings, 
and traffic milestones appear in spreadsheet form 
on the window. Once selected, the job’s traffic 

milestones and traffic assignments can be edited. Jobs can be selected for 
updating at random by clicking on the milestone you want to change.
                             
5  Repeat step 4 for every job that needs updating, then click Save.

To update the Daily Job Status report

The Daily Job Status report is designed to be printed every morning to sum-
marize the shop’s work in production. The report is printed from the Daily Job 
Status window after the job status is updated. The production or billing status 
for many jobs can be easily and quickly updated every day.

Updating Traffic

Update traffic anywhere, 
anytime. It’s quick and 
easy to update a job’s 
status, traffic milestones, 
status note, etc. The pop-
up Traffic window can be 
opened whenever the job 
is entered on a time sheet 
or time card.
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The Job Traffic window

Updating Traffic

1  The job’s traffic assignments can 
be cleared any time by clicking on 
the clear button.

2  Click the print button if you 
need a hard copy of this job’s traf-
fic report.

3  The job number and name/title 
appear here for reference.

4  The production status and 
billing status can be changed by 
entering a new status code over the 
old status code. If you’re not sure 
which status code to use, choose 
Status Codes from the Lookup 
menu. Double-click on a status 
code from the Lookup window. The 
status code will be copied to the 
Traffic window automatically. A job 
diary entry will be created each 

time the production or billing status 
code is changed.

5  The job’s start date and due 
date can be changed in the Traffic 
window. Changing these dates here 
doesn’t affect the job schedule 
(so Work to Do reports won’t be 
affected). To change the stat and 
due dates for job tasks, use the 
Reschedule function in the Job 
Schedule window once the Traffic 
changes are saved. You can also 
enter the date closed for the job in 
this window.

6  The days until due counter keep 
a running tab on how close the shop 
is to meeting the job’s due date. 
The numbers normally appear in 
green, but when the job is overdue, 
they turn red and begin counting 

the days overdue. 
7  The status note supplements 
the job’s current production or bill-
ing status. It lets you enter a brief 
description that appears on the Job 
Ticket window, on some job lists, 
and traffic reports.

8  The job’s priority can be 
changed by clicking on the pop-up 
menu and choosing one of the six 
customizable priority levels. A job 
diary entry will be created each 
time the job’s priority is changed. 

9  The job’s traffic assignments 
(i.e., traffic names) are the initials 
of the creative and production 
people most responsible for getting 
the work done. Traffic reports can 
be printed for any one of the job’s 
traffic names. 

10  The client status notes/com-
ments/next steps can be used to 
create progress reports for clients 
(see the Client Status report in the 
Job Lists) with any kind of informa-
tion you want.

11  If the job was added using a 
job type/spec sheet, its traffic mile-
stones can be edited. Jobs without 
a job type won’t show milestones. 

12  The job’s unfinished tasks are 
listed for an overall view of what 
needs to be completed. This field 
shows the task, who it is assigned 
to, and when it is due. When tasks 
are marked done, they no longer 
appears on the this list. 
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1  Choose View > Daily Job Status.

2  Enter the selections to find jobs, then click Find.

Jobs are sorted by client then by job number, making it easy to see the cur-
rent status of specific jobs (see page 35). Each job’s production status (or bill-
ing status, depending on the option you chose) and status note can be easily 
updated by entering the new status and note then pressing Tab. The status of 
many jobs can be entered at the same time.

■  The job’s traffic milestones, next 
steps, and traffic assignments can 
be updatfX–for the selected job by 
clicking the traffic link. The Update 
Traffic window opens (see page 30), 
prompting you to update the job’s 
traffic information. 

■  Jobs can be closed by entering 
the default closed status code. If 
the default closed status is entered, 
the job’s Closed checkbox will be 
checked when these changes are 
saved.

Closing jobs

Closing a job is not as meaningful (or as 
permanent) as it sounds. Jobs are closed when 
they are assumed to be finished and billed. 
Closing a job isn’t literal, since costs, time, and billings can still be added to 
it. But what closing does is useful: Closing tries to prevent users from adding 
purchase orders, costs, and time to jobs that have had a final billing.

Closing a job is not permanent, since a closed job can be easily reopened.  
But it prevents two traditional problems: (1) costs sometimes are posted after 
the job is billed, and (2) billing these late costs is easy to overlook. Before, 
an account executive had to closely watch these unbilled costs, then make 
sure they were billed next time.  But it was easy to forget. Clients & Profits 
X prevents this by automatically reopening jobs when late costs are posted. 
And, reopened jobs get a special reopened job status. Since all open jobs ap-
pear on billing reports, account executives will see both open and reopened 
jobs—and their unbilled costs. Closed jobs can be printed on all job reports by 
including the closed status codes in the print selections.

To close one job

From the Job Ticket window, find the job ticket you wish to close then lick 
the Closed checkbox. If the job has unbilled costs, you’ll be prompted to 
write them off first: 

If you click Yes, the they will be written off automatically (i.e., their billing 
status changes to write-off; the G/L is unaffected). If the can’t close jobs with 
unbilled costs option is checked in job Preferences, the job can’t be closed 

until all of its unbilled costs are 
either transferred, written off, or 
made unbillable by changing their 
billing status.

If the job has unfinished tasks, it 
can’t be closed if the can’t close 
jobs with unfinished tasks option 
is checked in Preferences.

The job’s production status and 
billing status changes to the 
closed status code, usually 999. 
Once closed, a warning will appear 
anytime someone tries to add a 
purchase order, time entry, or cost. 

The default closed status code is set in Preferences.
One-click closing. To close a 
job, simply click its Closed 
checkbox. The job’s status 
will change to the default 
closed status.

Updating Traffic

Updating Traffic (con’t)
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The Daily Job Status Report

Updating Traffic

1  Click on the find button to 
select jobs by AE/Team, client, or 
traffic assignment, and a range of 
production or billing status codes.  

2  Click the print button to 
print the daily job status report. 
Job status reports can also be 
printed, with more options, from 
the job tickets window and from 
snapshots.

3  Click on the traffic button to 
update the selected job’s traffic 
information such as the mile-

stones, start and due dates, and 
traffic notes.

4  Jobs can be sorted by job 
number, name/title, status code, 
priority, or status note by clicking 
on a column heading.

5  The job’s production status or 
billing status will appear here, 
based on how jobs were found. 
Highlighting a job’s status selects 
it, which allows you to change its 
status code. Pressing tab selects 
the next job. Tabbing past the sta-
tus code displays its description.

y

q w

r

e

t

6  The job’s status note will appear 
here and can be edited.
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The ability to coordinate hundreds of jobs, tasks, and resources through a 
common job schedule is one of Clients & Profits X’s greatest strengths. Job 
scheduling lets you see the shop’s unfinished work for any day of the week, 
for any week, and for any time period.

Like estimates, schedules are not created independently of jobs. Instead—like 
estimates—schedules are based on a job’s tasks. Every task on a job ticket can 
have multiple due dates, start dates, 
and resources who are responsible 
for doing the work, and specifica-
tions that describe what to do. Any-
one who needs to know can see their 
work to do today, this week, next 
week—or for any period of time.  

A job ticket can have any combina-
tion of job tasks.  The tasks you 
choose are completely customiz-
able to accommodate any kind of 
job. To better distinguish a job task, 
it can be classified by its purpose: 
Estimate/billing only, scheduling 
only, or both estimate/billing and 
scheduling. In addition, sub-tasks 
can be added to schedule different people 
to the same task (such as assigning three 
copywriters to the COPY task). Sub-tasks 
only appear on job schedules, and don’t 
affect job costing, billing, or the account-
ing system.

Job tasks can be scheduled automatically. A 
standard lead time can be entered for every task, 
which is used to create a ballpark job schedule. 
This ballpark schedule looks at the sort order for each task, then automati-
cally schedules start and due dates based on lead time. A production manager 
(or someone else who can schedule jobs) can use automatic scheduling to 
automate much of the basic task scheduling—then tinker with the dates until 
the schedule seems workable.

Scheduling jobs is completely f lexible. You can schedule job tasks when a new 
job is opened, then print a job schedule to attach to the client’s estimate. Or, 
schedule tasks after the job is approved. Updating job schedules is simple, so 
it’s easy to keep up with postponed deadlines as they happen. Printing work-
to-do reports always uses the current job schedules, so you’ll always have 
accurate, timely information.

A job can be scheduled anytime. However, scheduling a job when it is first 
opened ensures that the work-to-do reports are accurate and complete.  
Sometimes a rough schedule works well enough to start a job. Task due dates 
can be fine-tuned as the schedule is refined over time.

Job Scheduling

Job Scheduling

Get instant deadlines with 
ballpark schedules.
The Ballpark Schedule 
function calculates start 
dates and due dates au-
tomatically based on the 
job’s start or due date and 
each task’s lead time. The 
job’s ballpark schedule 
can be fine-tuned by sim-
ply editings its due dates.

To schedule job tasks

1  From the Job Ticket window, find the job you wish to schedule.

2  Click the Schedule button.

The Job Schedule window opens, listing the job’s scheduling tasks. These 
tasks appear, sorted by the schedule 
sort order numbers.  If no schedule 
sort numbers are listed, the the 
tasks are sorted by task code. As 
tasks are scheduled, the list is 
resorted. Any task can be selected 
for scheduling by clicking once on 
the task name.

■  If a task isn’t appearing, make 
sure it isn’t marked as an estimate/
billing task only.

3  Enter the task’s due date and 
time. 

The due date can be entered as any day of the week, including Saturdays, 
Sundays, and holidays. The Skip option will prevent weekends from being 
scheduled.

4  Enter the task’s resource and lead time.

The resource is the person, place, or thing responsible for completing the 
task. It can be a staff member, a vendor, or a free-lance employee. Lookup 
lists can be used to find a staff member or vendor. The resource is not limited 
to existing staffers or vendors, so anything or anyone can be entered. The 
lead time should be entered as the number of days needed to complete this 
task.

5  Enter the task’s start date, then press Tab.

The start date is calculated based on the task’s due date and lead time, but 
can be changed.

6  Repeat these steps for the other job tasks, then click Save.

■  Tasks do not get a finished date until they are complete and no longer 
need to appear on Work To Do reports.
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Job Scheduling

The Job Schedule window

1  Sub-tasks are special tasks used 
exclusively for scheduling. They are 
added to schedule different people 
are multiple deadlines fro the same 
task. Any number of sub-tasks can 
be added to the job schedule using 
the add sub-task button. 

2  sub-tasks can also be removed 
from the schedule at any time us-
ing the remove sub-task button. 

3  The job’s entire schedule can 
easily be erased using the clear 
button. The ballpark schedule 
button can be used to automati-
cally create a job schedule based 
on either the job’s start date or due 
date. The reschedule button works 
like the ballpark function, except it 
preserves the relative time for each 
task, while changing the start date 
and due dates for each task based 
on a new job start date or due 
date. The resource’s tasks can be 
easily reassigned to someone else 
using the Reassign button. 

4  Click on the Print Schedule 
button to print a hard copy of the 
schedule. 

5  The job number and name/title 
appear here for reference. The job’s 
start and due dates are used by the 
Ballpark and Reschedule functions 
to calculate start and due dates for 
each job task.

6  Clicking on the calendar link 
opens the job’s calendar window, 
which lists the deadlines for a 
selected date.

7  It’s easy to see other deadlines 
without closing the job schedule 
window by using the view>point 
pop-up window. This task’s sched-
ule option shows deadlines for 
other jobs for the currently selected 
task. This resource’s tasks option 
shows deadlines for other jobs for 
the currently selected resource per-
son. This day’s tasks option shows 

the deadlines for other jobs for the 
currently selected due date.

8  Special instructions can be 
added or edited for tasks in the job 
scheduling window. Tasks with spe-
cial instructions will appear with 
a red “X” by it’s task name. For 
convenience, the pop-up estimate 
worksheet can be viewed from the 
job schedule window. 

9  The job’s schedule tasks are 
listed in the order in which they 
are completed. The step number is 
copied from the Task Table, then 
entered for each task.

10  Clicking the show sub-tasks 
arrow shows or hides the task’s 
sub-tasks.

11  The task name describes the 
task’s purpose or function.

12  The due date field is the 

date on which the task should be 
completed.

13  The due time field indicates 
when the work is due.

14  The resource is the staff mem-
ber, freelancer, or vendor who is 
responsible for doing the work.

15  The job task’s estimated hours 
appear here for reference.

16  The lead time is the number of 
days needed to complete the task.

17  The start date is the date on 
which the task’s work is to begin. 

18  The finished date is the 
date on which the job task was 
completed. 

19  The skip Saturdays/Sundays 
option lets you prevents users from 
scheduling tasks on weekends. 
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can be allocated to the sub-task (e.g., 4 hours out of the COPY’s 12 estimated 
hours just for proofing). Many sub-tasks can be added for each task. The total 
of the sub-tasks’ hours can’t exceed the task’s estimated hours.

To update a sub-task’s due date, etc.

The sub-task’s due date, start date, task specifications, and finished date are 
updated just like any other task: open 
the Job Schedule window, select the 
sub-task, make your changes, then click 
Save. Because sub-tasks only appear 
on the Job Schedule window, they can’t 
be updated from time cards and time 
sheets. However, sub-tasks will appear 
on the Weekly Task Planner and Work To 
Do windows, where they can be updated.

To remove a sub-task

Sub-tasks can be easily removed from 
job schedules. To remove a sub-task, 
select it by clicking into one of its fields 
then click the  (Remove Sub-Task) 
button.

To edit a task’s specifications

Each scheduling task can contain detailed specifications that describe the 
work to be done. These task specifications appear on the resource’s printed 
work to do reports, as well as the Weekly Task Planner. They’re optional, 
but can be useful for documenting the scope of the work, how it should 
be produced, or to explain any special instructions. Clients don’t see task 
specfications on estimates and invoices. To edit a task’s specifications, select 
a task then click the (i.e., Edit Task Specs) button, make your changes, then 
press Tab to save.

■  Tasks that have specifications are highlighted in the Job Schedule window 
with a red “X”. 

To review a task’s estimate

It’s sometimes helpful when scheduling a job to review the task’s estimate. 
To see the task’s estimate, select a task then click the task’s estimate link. 

The pop-up Estimate window shows the task’s estimate amounts, including
 details from the task’s estimate worksheet: staff members,estimated 
hours, and expenses. In some cases certain people may have been
planned to work on a task, but are no longer available. Or, the task might 

Job Scheduling (con’t)

Job Scheduling

To print a job schedule

A job schedule can be printed from the Job Schedule window by clicking 
the   (Print) button. The printed schedule will list the job’s tasks by due 
date. It will reflect the changes you’ve made to the schedule but haven’t yet 
saved. If these changes aren’t saved, the job’s previous due dates will appear 
on the printed schedule the next time it is printed.

To print a job timeline

The Job Timeline report provides a 
graphic look at the job’s schedule. The 
job’s tasks are listed by due date and 
graph their relative start and due dates 
by clicking the timeline link. Timelines 
can only be printed for one job at a time, 
and only from the Job Schedule window.

To add a new job task while 
scheduling

New tasks can be added to a job ticket 
while editing the job’s 
schedule. Tasks can be added by 
opening the Task Table lookup 
list, selecting a task, then dragging 
it onto the Job Schedule window. 
The task is instantly part of the 
job ticket. 

To add a sub-task

Sub-tasks are special tasks used exclusively 
for job scheduling. They are added to 
schedule different people or multiple 
deadlines for the same task. For example, the task COPY for copywriting 
might involve several copywriters, proofreaders, and fact checkers. Any num-
ber of sub-tasks can be added for COPY to schedule due dates and resources 
for everyone responsible for the job’s copywriting. Sub-tasks are scheduled 
and updated like regular tasks. They appear on work to do reports, but don’t 
affect estimates, job costing, or billing.

1  Select the task (by clicking into any of its fields) for which a sub-task will 
be added.

2  Click the  (Add Sub-Task) button. 
The sub-task is inserted beneath the selected task. The sub-task gets the 
same task code, but the description can (and should) be customized for this 
sub-task’s purpose. Each sub-task can have its own resource, due date, due 
time, lead time, and start date. Some portion of the task’s estimated hours 

Can they do this task? When 
a resource is scheduled for a 
job task, it’s easy to see their 
other deadlines. The View 
Unfinished Task window lists 
the resource’s other responsi-
bilities for the week. You can 
analyze the resource’s work-
load to deter-mine whether or 
not to add this task to their 
work to do list.
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have been underestimated, so the production manager can to assign junior 
(i.e, less expensive) artists to the task. 

The pop-up Estimate window lets you review the task’s estimate amounts 
without closing the Job Schedule window. You can see the infor-mation you 
need to make a better, more informed schedule with-out having to quit what 
you’re doing, reprint the job’s estimate, then return to the Job Schedule 
window.

To clear a job’s schedule

The job’s entire schedule can be erased 
with a single mouse click. Use this shortcut 
when the schedule is wrong and needs to 
be created from scratch. This shortcut is 
much faster than manually deleting each 
task’s schedule information. To erase the 
job’s schedule, click the  Clear button.

To create a ballpark schedule

Ballpark schedules can be created automatically using the job’s start date 
or due date. The ballpark function looks at the job’s tasks, evaluating which 
tasks are finished first (based on their schedule sort order) and lead time. A 
user can choose whether to work forward from the start date or backward 
from the due date. Either way, a job schedule will be calculated with ballpark 
start and due dates for each task.

■  The ballpark schedule function works best on new jobs that haven’t been 
scheduled before. The ballpark schedule replaces any start or due dates on 
the job ticket, erasing any dates you may have entered manually.

1  From the Job Schedule window, click the  (ballpark) button.

The Create Ballpark Schedule dialog box opens (see page 36), prompting you 
to select the start date or due date. For convenience, the job’s actual start 
date or due date can be updated here.

2  Choose start date or due date, then click OK.

You’ll see the job’s new start dates and due dates almost instantly. Ballpark 
scheduling is fast—and you can still fine-tune one task or another until the 
schedule is perfect. None of the schedule’s dates are saved until you click 
Save, so you can freely edit the task’s dates and lead times.

Job Scheduling



46

To reschedule a job

It always seems to happen: you spend hours creating a perfect, realistic 
schedule for a job then the client postpones it a month. Instead of manually 
changing each task’s start and due dates, there’s an easy, automatic way to 
reschedule the job. The Reschedule shortcut automatically rearranges a job 
schedule around a new start date or due date. Each task’s relative time (i.e., 
the days between its start date and due date) is preserved—only the dates 
themselves are changed. While the Reschedule funtion instantly reschedules 
the job, you can still manually 
fine-tune the dates as needed.

■  Rescheduling a job schedule 
doesn’t check the shop’s workload 
for any particular day or week.

1  From the Job Schedule window, 
click the Reschedule button.

The Reschedule Tasks dialog box 
(see below) prompts you to select 
a new start date or due date.

2  Choose start date or due date, 
then click OK.

You’ll see the task’s new start 
dates and due dates almost 
instantly—and you can still fine-
tune one task or another until the
schedule is perfect. None of the schedule’s 
dates are saved until you click Save, so 
you can freely edit the task’s dates and
 lead times.

To reassign someone’s deadlines

If the resource assigned to a job’s tasks can’t do the work (i.e., they’ve been 
moved to a different account team, they’ve quit, etc.), the resource’s tasks 
can be easily reassigned to someone else. The Reassign Deadlines shortcut 
swaps the old resource for the new one you’ll enter. 

Job Scheduling (con’t)

Job Scheduling

If someone’s unavailable, 
use their backup. Any 
staff member can write 
themselves out for any 
morning, afternoon, or en-
tire day. If someone tries 
assigning a task’s deadline 
to a staff member who 
is unavailable, the Avail-
ability Alert informs the 
scheduler—and suggests a 
backup person.

■  This shortcut only applies to tasks on one particular job. However, you can 
reassign all of the tasks assigned to a staff member (who quit, for example) to 
someone else using the Reassign Deadlines shortcut in the Staff Availability 
window (see the Manager’s Manual, page 3-20).

1  From the Job Schedule window, click the Reassign Deadlines link.

The Reassign Deadlines dialog box 
(see below) opens, prompting you 
to enter the old resource and the 
new resource. The resource for the 
currently selected task is entered 
automatically, but can be changed 
to any resource scheduled for this 
job.

2  Enter the old resource and the 
new resource, then click OK.

You’ll see the new resource re-
place the old resource on the job’s 
tasks almost instantly.

To view other deadlines 
for tasks, resources, or 
dates

Sometimes its helpful while scheduling to see other deadlines for a task, a 
resource, or some other date. Clients & Profits X makes it easy to see other 
deadlines without closing the Job Schedule window: the View Scheduled 
Tasks link, View Tasks for Resource link, and Unfinished Tasks pop-up win-
dows look up deadlines from other jobs by task, resource, or date. Deadlines 
are selected using the currently selected task, its resource, or its due date. 
These windows help you balance the shop’s workload by seeing what other 
tasks are due during the same time frame as the task you’re currently sched-
uling.
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The Weekly Task Planner

The Weekly Task Planner window lists your unfinished job tasks for the 
current week. It is a personal scheduler that shows your unfinished jobs and 
tasks (i.e., the job tasks to which you’re the resource). Tasks are grouped by 
day, giving you a clear look at your week’s deadlines. For each deadline you’ll 
see its job number and task, the hours left on the task from the estimate, and 
when the task is due (i.e., time of day, which is optional). 

■  Each staff member only sees their unfinished tasks in the Weekly Task 
Planner. To look for unfin-
ished tasks for someone 
else, choose View > Work To 
Do. The Work To Do window 
finds tasks for any resource, 
client, or AE/team. It’s more 
f lexible for production and 
traffic managers who need 
to track deadlines for many 
people.

The unfinished tasks are 
displayed in a friendly 
calendar-like window.  
Each day has a scroll bar so 
many unfinished task can 
be listed.  Tasks due for the 
current week are shown, but 
you can also view the next 
three weeks of scheduled 
tasks.

The task’s schedule can be 
updated from the Weekly 
Task Planner window 
by double-clicking on an entry. The staff 
member can easily edit the task specs, change 
the scheduled dates, or mark the task as 
finished.  Changes to the task’s schedule are 
saved instantly.

To see this week’s deadlines

1  Choose View > Weekly Task Planner.

You’ll see all your unfinished tasks due this week. 
Use the scroll bar to scroll through each day’s 
entries. 

To see next week’s deadlines

1  Choose a week from the pop-up menu.

To print your weekly task planner

1  From the Weekly Task Planner window, click the Print button.

To update a task’s schedule

1  From the Weekly Task Planner window, double-click on a job task.
 
The Edit Task Schedule 
window opens (see below), 
displaying the task’s 
description, specifications, 
start and due dates, task 
status, and finished date. 

If the task status and the 
task’s specifications have 
changed, they can be 
updated by simply typing 
in the new information. 
The task’s estimated hours 
and actual hours appear for 
reference to show you how 
much time is available to 
finish the task. If this task 
is now finished, click the 
Finished checkbox. The 
finished date is entered 
automatically, but can be 
changed if needed. 

Once a task is marked 
as finished, it won’t appear on the Weekly Task Planner, the Work To Do 
window, or traffic reports.

The Weekly Task Planner

What’s going on next 
week?”  The Weekly Task 
Planner makes it easy to 
know your important dead-
lines. The week’s sched-
uled tasks are sorted by 
day of the week, helping 
you to better manage your 
time. A task’s schedule in-
formation can be updated 
by double-clicking on a 
job task.
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Purchase Orders

Purchase, insertion, and broadcast orders account for purchases you make 
from vendors on a client’s behalf. They are not required by Clients & Profits 
X, but give you control over your purchases. That’s because purchase orders 
provide written verification for the goods and services you order. 

Anyone can add their own purchase orders, up to a user-defined dollar limit. 
POs have at least one job and task, but can contain several for better cost ac-
counting. Amounts from the purchase order update job tickets automatically.  
Up to five copies of a purchase order can then be printed on plain paper, so 
special forms aren’t needed.  When the vendor’s invoice is posted and the PO 
is referenced, the PO is reconciled automatically.

Tracking purchase orders can be essentially paperless, since you can add, 
change, and see everything about a PO directly from your computer. The 
cost of your orders will appear on job reports. Purchase orders aren’t true job 
costs; instead, they are commitments you’ve made for a job cost.  They are 
essential for accurate cost accounting, since they track the purchases you’ve 
made throughout the month, but still haven’t received the vendor’s invoice. 
Purchase orders can be billed individually or by task in Accounts Receivable.

A job ticket can have hundreds of purchase orders; there’s no real limit.  Job 
commitment reports can be quickly printed (or reviewed directly from your 
computer) showing just what you’ve ordered—and whether or not it has been 
invoiced by the vendor. Many parts of the purchase order are customizable to 
save time. Templates, which contain basic details about a kind of purchase, 
can be applied to a new purchase order, for faster data entry. Cloning dupli-
cates an existing purchase order when you’re ordering the same or similar 
thing again.

When the cost is eventually invoiced by the vendor, the purchase order’s 
balance decreases. The purchase order keeps a running balance of open com-
mitments, showing you how much you’ve purchased from vendors that hasn’t 
been invoiced. Once the invoice is posted in Accounts Payable, a purchase 
order can’t be changed.

■  Many users can add purchase orders at the same time. Sometimes your 
cursor becomes a padlock, indicating that someone else is using a record that 
you need. In these cases, the padlock will disappear—and your purchase order 
can be entered—when the other user saves his or her work. 

Whether you’re ordering printing for clients, print or broadcast media, or 
supplies for the office, everything is added into the Purchase Orders’ data file. 
This file contains purchase orders, broadcast orders, and insertion orders. All 
of the purchase order functions (i.e., finding, editing, printing, closing, etc.) 
apply to purchase orders, broadcast orders, and print insertion orders.

■  Broadcast and print insertion orders are explained in the Media Buyer’s 
Guide to Clients & Profits X supplement, which can be downloaded from the 
Clients & Profits X web site. 

Job tickets track both the net and 
gross amounts of your purchase 
orders.  These totals, which are up-
dated whenever you add and save 
a purchase order, show the balance 
of the commitments you’ve made 
for job costs.  

When a purchase order is added, 
you’ll enter a net amount and 
(optionally) a gross amount.  The 
net amount is the actual cost of the 
purchase, before markups and com-
missions.  The gross amount is what 
you’ll eventually bill the client for 
this purchase.  Each line item on 
a PO can have a different net and 
gross amount.  The PO’s totals are 
based on all of its line items.

Saving the purchase order increases 
the job’s committed total—but the 
cost total is unchanged.  This is 
because a purchase order isn’t a 
real job cost yet.  It will be, once 
the vendor does its job, sending 
an invoice.  Posting the vendor’s 
invoice in Accounts Payable moves 
the amount from the commitment 
column to the cost column on the 
job ticket.  The job’s Net and Gross 
PO balances decrease, since they 
have been invoiced.  

Posting the PO isn’t required, since 
it doesn’t affect the General Ledger.  
Purchase orders don’t affect the 
vendor’s balance, either.  They can 
be freely edited until the vendor’s 
invoices are posted into Accounts 
Payable.  Changing a purchase 
order updates its job tasks accord-
ingly.

How Clients & Profits X 
manages purchase orders

Standard information for purchase 
orders can be customized to save 
time.  These settings, called de-
faults, are copied to new purchase 
orders automatically.  Purchase 
order default settings can be edited 
anytime in Preferences.

Purchase order preferences include:  
a standard distribution list for 
printing copies of a purchase order; 
three standard approval names; 
five standard user-defined fields for 
tracking special details; a standard 
disclaimer that prints at the bottom 
of the printed purchase order; your 
company logo (which prints at the 
top of the printed purchase order); 
margins for printed purchase orders; 
and the option to show the client’s 
name on the PO.

These settings can be copied to all 
users, or they can be personalized 
for each user.  Giving different users 
their own special defaults saves 
them time; when they add their 
own purchase orders, their settings 
are entered automatically.  

The automatic PO numbering 
setting is changed in Preferences, 
too.  To change your purchase order 
defaults, choose Purchase Orders 
from the Preferences pop-up menu 
under Setup.

The PO heading, can be customized 
to Work Order or Change Order in 
Names from the Preferences menu.

Purchase order defaults

Purchase Orders
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The Purchase Order window

Purchase Orders

1  Use the previous and next 
buttons to scroll through purchase 
orders.

2  Click the add new purchase 
order button to add a new pur-
chase order. Or click on the clone 
purchase order button to make an 
exact copy of an existing purchase 
order.  Click the edit button to edit 
the purchase order’s key details, 
such as the status, description, or 
approvals.  Click the delete button 
to delete the purchase order.

3  Click the add amounts button to 
add new amounts to an order. The 
remove amounts button deletes 
one or more selected costs from 
an order. 

4  Any purchase order can be pre-
billed using the Pre-bill button.

5 The print reports and print orders 

buttons are used to print purchase 
order reports and forms.

6  If you know the purchase order 
number you want to find, simply 
enter the number into the find 
order field.

7  The history pop-up menu can 
be used to jump to a previously 
viewed purchase order.

8  Use these links to edit the 
order’s description/status, vendor 
information, or delivery details 
and to view vendor invoices or the 
vendor diary.

9  Every order has a unique 
number.

10  The order date is the date the 
PO was added. The client number 
does not show on the printed PO. 
The ordered by field shows the ini-

tials of the person who added the 
order. The due date shows when 
the goods or services are due to be 
delivered or performed. 

11  A PO can include only one 
vendor; if you’re buying something 
from multiple vendors, each vendor 
gets its own purchase order.

12 The PO amount is the total 
amount of the purchase order’s 
line items.

13  The balance amount shows the 
amount remaining on the purchase 
order that has not been invoiced to 
vendor invoices.

14  The PO will be closed automat-
ically when applied to a payable for 
the full balance due.

15  Net cost is the amount you’re 
paying for the goods or services, 

before markups or commissions.

16  A lengthy description provides 
a detailed explanation of the order 
to the vendor.

17  POs that are used repeatedly 
for the same vendor can be marked 
as a Blanket PO.

18  The order’s current revision 
number increments automatically 
each time someone edits the order. 

19  The status is user-defined note 
that describes the order’s current 
progress and appears on the 
printed purchase order.

20  If an order has been approved, 
the approver’s initials and date 
appear on the Purchase Order 
window.
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Accounts Payable

Everything you buy from a vendor on account, whether for a job or for the 
shop, is an accounts payable entry.  These purchases, which are usually 
recorded from vendor invoices, are added into Accounts Payable.  Since 
Accounts Payable is integrated with the General Ledger, there’s no double-
entry—information entered on invoices becomes part of the G/L.  The A/P file 
tracks everything about your purchases:

 ■  What you’ve bought
 ■  From whom it was purchased
 ■  How much it cost
 ■  When the invoice should be paid
 ■  The purchase’s markup and gross amount
 ■  When the invoice was paid

Vendor invoices should be added daily, to keep your accounting files and job 
cost reports timely and accurate. Invoices with job costs can be billable or 
unbillable, or any combination.  They can contain one or more jobs and tasks 
for f lexible job costing. Invoices for overhead (which are unbillable by nature) 
can debit any number of G/L accounts.

Accounts Payable is seamlessly integrated with the vendor files, jobs and 
tasks, and the general ledger. This means that when an invoice is posted, 
many things are updated at once:  the vendor balance increases; the invoice’s 
cost and gross amounts increase the job’s totals; and debit and credit entries 
are created in the General Ledger. Vendor invoices are also integrated with 
purchase orders. When an invoice is added with a purchase order number, the 
PO’s job and cost information is copied to the invoice automatically—sav-
ing entry time. Posting the invoice updates the purchase order’s balance, 
automatically closing open POs. Posting the A/P invoice also reconciles the 
committed totals on jobs and tasks.

Vendor invoices don’t update vendors, jobs, or the G/L until they are posted. 
Invoices are saved as unposted entries, and can be changed or deleted; 
however, unposted invoices only appear on the proof list, and not on cost or 
accounting reports. Posting makes invoices permanent, for better account-
ability. Once posted, an invoice can not be changed—only adjusting entries 
can be made against it. Or an invoice can be unposted, edited, and reposted.

■  Invoices from vendors shouldn’t be added into Accounts Payable if they’ve 
been pre-paid with a check.  Instead, write the check as a job cost.

Debit and credit journal entries 
are created automatically when 
payables are posted. Every invoice 
makes a credit entry (usually A/P) 
and one or more debit entries (ei-
ther job cost or overhead expense). 
Default debit and credit accounts 
are entered for you automatically.  

■  The invoice’s credit account is 
always a payable account, which is 
copied from the G/L preferences or 
from the vendor’s default cGL.

■  Invoice line items have debit ac-
counts (the “dGL”).  An invoice can 
have many line items, distributing 
a cost to dozens of debit (i.e., cost 
or expense) accounts. The debit 
account for job costs is copied from 
the job task’s dGL. Vendors can 
have default expense dGL accounts, 
which are copied to overhead 
invoices. The dGL will be copied 
from G/L Preferences, if no other 
default is set up.  

■  Journal entries from payables 
are posted into the Purchases jour-
nal.  The entry’s reference number 
is a combination of the prefix, AP#, 
and the invoice number.

■  Journal entries aren’t created, 
and the G/L account balances 
aren’t updated, until an invoice is 
posted.  In the General Ledger, the 
Purchases journal can be printed 
showing the journal entries posted 
from Accounts Payable.

Accounts Payable and 
the General Ledger

Like job costs, vendor invoices 
for overhead expenses are added 
into Accounts Payable as they 
are received in the mail. Add-
ing these expense invoices is a 
relatively easy process, since you’ll 
be entering information right from 
the invoice. Overhead invoices are 
added without jobs and tasks, since 
they don’t affect clients. 

Media accrual invoices complete a 
WIP (i.e., work-in-process) account-
ing procedure that started with 
the client’s media billing. Tracking 
media accruals automatically is 
complex and requires accurate en-
try of both media billings to clients 
and media invoices from vendors. 

The process doesn’t happen unless 
the “automatic WIP accruals” op-
tion is checked in your accounting 
preferences. Once enabled, Clients 
& Profits X creates accrual entries 
from media billings for the media’s 
estimated cost, then reconciles 
those entries with the actual costs 
from the vendor’s invoices—the 
media accrual invoices. This feature 
automatically tracks the value of 
media accruals on your financial 
statements.

■  If the automatic media WIP 
accrual option is unchecked in your 
accounting Preferences, media ac-
crual invoices can’t be added.

Before media accrual invoices can 
be entered, the insertion order or 
broadcast order must be pre-billed.

Overhead and Media Ac-
crual Invoices
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The Accounts Payable window

accounts payable reports.  

6  The find more link can be used 
to find payables by sequence, 
invoice number, date, or vendor.

7  History keeps track of the ac-
counts payable invoices that you 
previously viewed. 

8  Vendor diary entries can be 
viewed or added by clicking on the 
vendor diary link.  An accounts 
payable invoice’s payments can be 
viewed by clicking on the payments 
link.

9  The vendor’s invoice number is 
entered from the printed invoice.  

10  There are four kinds of A/P 
invoices:  Job Costs, Overhead,  
Media Accruals, or Credit Card 
Statement.

11  The vendor number identi-
fies from whom something was 

1  Use these toolbar buttons to find 
the previous and next accounts 
payable invoice.

2  Accounts payable invoices can 
be easily added, cloned, edited, 
and deleted.  Click the add new 
invoice button to add a job cost 
payable. An existing payable can 
be cloned into a new payable, by 
clicking on the clone button. Click 
the edit button to edit  the invoice’s 
details. Click the delete button to 
delete an unposted accounts pay-
able invoice.  

3  To change the distribution of an 
invoice, click on the redistribute 
button. If you only need to remove 
an amount from the invoice, click 
on the remove button.

4  The repeat button can be used 
to create recurring entries for an 
overhead expense invoice.

5  Use the Print button to print 

purchased.  

12  The date is from the invoice 
itself, not when the invoice was 
added. 

13  Payment terms are copied from 
the vendor account.  Pay date is 
the date on which you plan to pay 
the invoice.

14  The invoice’s description is 
user-defined and explains what was 
purchased. It appears on cost, A/P, 
and G/L reports.

15  The amount is the total cost of 
the invoice. 

16  The cGL is the invoice’s credit 
G/L account, usually A/P.

17  The invoice’s balance due 
decreases when the vendor’s check 
is posted.

18  The posted date shows when 

the invoice updated the General 
Ledger.  

19  The accounting period shows 
which G/L period was updated 
when the invoice was posted.

20  The client paid date shows if 
this job cost has been billed to the 
client and when or if it has been 
paid.

21  The days until due box shows a 
countdown to the accounts payable 
invoice’s due date.  

22 Net cost is the cost amount 
before commissions. Gross is the 
billable cost amount, including 
markups and commissions. The 
dGL is the invoice line item’s debit 
G/L account, usually a job cost or 
overhead expense account. 

23  The user’s initials who added 
the invoice are appear on the Ac-
counts Payable window.
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The Daily Time Card

The Daily Time Card

Everyone can track their daily time using the built-in time card. It keeps a 
daily record of the jobs and tasks on which you work. You can enter billable 
and unbillable time for any client, including agency time (i.e., meetings, 
vacations, etc.). Time entries are added throughout the day as you work.  

Time is entered in numbers (e.g., 2.75 hours) and not in minutes (e.g., 35 min-
utes). Cost and billing rates are applied automatically when the time card is 
saved; they can’t be seen or changed on the time card. To save time, the job’s 
traffic and schedule details can be updated 
when entering your hours.

The time card stopwatch

The time card has a stopwatch that can 
track your time on a project while you’re 
working. The stopwatch works by remem-
bering when you’ve clicked the “start” and 
“stop” buttons for a selected job and task 
on the Time Card. To use the stopwatch 
function, you first need to enter a job and 
task. Make sure that either the job or task 
is selected, then click the “start” button to 
start the clock.  Later, click on the same job 
and task again then click the “stop” button 
to stop the clock. The elapsed time will be 
calculated and 
entered for you.

■  The stopwatch isn’t especially 
intelligent, so it doesn’t know when 
you’re taking a break or on the tele-
phone. And it’s not clairvoyant, so 
it won’t know that you’ve finished 
one task and started another.   

The stopwatch is just a shortcut, so it doesn’t dictate how your time is spent. 
You can still change the time worked on a job and task by changing the 
hours—replacing the hours entered on the time card. There’s no problem if 
you forget to stop the clock—there just won’t be any hours entered automati-
cally for that job and task. There’s nothing to prevent you from timing several 
jobs and tasks at once.

Billable time, unbillable time, and overtime

Any time entry on a time card can be billable, unbillable, or overtime.  Bill-
able time will have a cost rate and a billing rate. Unbillable time will have 
a cost rate only—the billing rate will be zero. Billing rates are copied to the 
time card when it is saved, based on the staff member, the client, and the 
task. A time entry always gets its cost rate from the Staff record.  The billing 
rate is copied from the staff, task, or client file depending on how the job is 
set up. Overtime has its own staff-based cost and billing rates.  All time, even 

if it is unbillable, updates jobs and tasks.

To use your time card

1  Choose My > My Time Card.

Your time card for today opens, listing the time you’ve entered already, and 
prompting you to enter a job number.

2  Enter the job number, task, hours, and a 
brief description of the time entry.

3  Click Save.

To close the time card window, click the 
Close box.

To update traffic and schedule 
info from your time card

1  Choose My > My Time Card.

2  Enter a job and task, then click on the  
Traffic or Schedule button.

Clicking on the Traffic button opens the 
Edit Traffic window, where you can change 
the job’s production status, billing status, 

milestones, and traffic notes.  Clicking on the Schedule button opens the 
Update Task Schedule window, where you can change the task’s due date, 
resource, start date, status, production specs, and mark the task as finished.  
The changes you make to the job schedule and traffic are saved immediately.

To enter time for a different day

1  Choose My > My Time Card.

2  Click the Next or Previous buttons to find the desired day’s time card.

3  Enter the time entry’s job, task, hours, etc. then click Save.

To delete your time card

Time cards can’t be deleted. However, individual time entries can be deleted 
from the Time Sheets window until they are billed.

Updating job schedules  
Job traffic and task schedules 
can be updated while a user 
enters his or her time. These 
changes update traffic reports 
instantly.
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The Daily Time Card window

1  Since time cards are meant to 
be used throughout the day, today’s 
time card appears automatically.  
You can see the week’s time cards 
by clicking on the previous day and 
next day arrows.  

2  The time card has a stopwatch 
that can track your time on a 
project while you’re working. The 
stopwatch works by remembering 
when you’ve clicked the start and 
stop buttons for a selected job and 
task on the Time Card.

3  Click the remove button to 
delete an unsaved entry from the 
timecard.  
 
4  Click the print timecard button 
to print a report showing today’s 
time card, for quick reference.  

5  To find the timecard for a spe-
cific day, enter the date into this 
field and click on the find button. 

6  These links can be used to see 
your tasks and update information 
for a job task.  The show my tasks 
link can be used to automatically 
copy in all job tasks that are due 
for the user.  All the user needs to 
do is fill in the hours.  The show 
schedule link lets you see (and 
maybe edit) the job task’s due 
date, status specifications, and 
other details.  Clicking the Finished 
checkbox removes the task from 
schedule and work to do reports.  
Any changes you make are saved 
immediately. The show traffic link 
lets you see (and maybe edit) the 
job’s production status, billing 
status, milestones and traffic notes/

next steps.  The show notes button 
allows the user to add a lengthy 
description for the time entry.

7  Your name appears here for 
reference.  You can only see and 
use your own time card.  Your time 
card will open regardless of which 
computer you’re using anywhere in 
the shop.

8 The hours to go box shows the 
number of hours needed to meet 
the user’s planned hours for the 
day.  Planned hours can be set in 
the Staff file for each day of the 
week.

9  Many different jobs and tasks 
can a be entered onto the day’s 
time card.  If you don’t know a job 
number or a job task, leave the 

field blank, then press Tab to open 
the Lookup List.

10  Each time entry can be marked 
as overtime.  Overtime is billed 
at different (and usually higher) 
rates than regular time, using an 
overtime rate from the Staff file.
11 Today’s hours shows how many 
hours are entered so far.  An option 
can be set in your Staff record to 
force you to account for a minimum 
number of hours each day.

12 Click cancel to stop entering 
time.  Clicking Cancel doesn’t 
erase any time previously saved on 
the time card, just the hours you’ve 
entered now.  Previously saved time 
entries are marked with an ‘X’. 
Click save to save the jobs, tasks, 
and hours you’ve just entered.  The 
time will automatically post when 
it is saved.
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Weekly Time Sheets

The need to keep detailed, accurate records of how everyone in the shop 
spends their time is vital to staffing, billing, productivity, and profitability.  
That’s why daily time keeping is so important to Clients & Profits X.  Unlike 
other accounting systems, time keeping is a fundamental feature in Clients 
& Profits X.  That’s why there are so many ways to track time, whether it’s 
billable or unbillable.  

A time sheet is a collection of a day’s time entries for one person. Each time 
entry is a separate record of a person’s work containing the date, job number, 
task, the number of hours, cost and billing rates, and a short description.

Time can be tracked either through time cards or time sheets. There’s no real 
difference between them; in fact, time entered on time cards becomes a time 
sheet when the time card is saved. But the time card has the advantage of 
being available to users all day, while they’re working. 

The time sheet, in comparison, is designed for users who enter their time 
weekly, not daily, or in agencies that have one person input the time for all 
staff members.  

Time added into a time sheet is posted as it is saved—so jobs, tasks, and 
cost reports are updated immediately. Unlike time cards, the time sheet has 
the option to show cost and billing rates. This option, which can be set for 
each user, lets a user adjust cost and billing rates. Time entries can be added, 
edited, and deleted as needed—any time, if the user has the necessary access 
privileges. There are no limits to how many time entries can be added.  Any 
time entry can be made unbillable by unchecking the Billable checkbox; if so, 
the time’s cost amount will appear on the job, but the billable amount will 
be zero.

Time reports can be printed daily, weekly, or for any period of time. Time 
reports can show time by staff member or for one job number. The time card 
reports analyze the week’s time by department or team, for better account-
ability. Productivity reports, which are printed from Snapshots, show total 
hours by staffer, task, client, or job—and are excellent ways to analyze how 
people work.

Weekly Time Sheets

In most shops, freelancers are 
treated like employees—their 
hours are added into time sheets.  
But what about the freelancer’s 
invoice?  The answer depends on 
the freelancer’s time sheets:  if you 
give the freelancer a billing rate, 
but no cost rate, then just his or 
her billable hours are posted to the 
job as an unbilled cost.  Since the 
billable time is already on the job, 
the freelancer’s invoice is added 
as a non-billable A/P invoice (it 
will only have a cost amount).  The 
freelancer is added as both a staff 
member and a vendor, but with 
different numbers (ex:  staff initials 
ABC vs. vendor number AC) to keep 
them separate on cost reports.

■  Time sheets don’t affect the 
General Ledger. Clients & Profits X 
uses time sheets for productivity 
and job costing, but not payroll.  
Your financial statements show 
payroll costs from the checkbook or 
manual journal entries.

Time sheets, freelancers, 
and the General Ledger

Time sheets and billing 

Clients & Profits X gives you a 
variety of ways to program rates on 
time sheets, especially billing rates. 
This means you have the f lexibility 
to set rates by staff member, job 
task, or client. They are applied 
automatically, making your time 
accounting more accurate.

Cost rates: Cost rates are set by 
staff member. Each staffer has a 
standard cost rate plus an overtime 
cost rate. Cost rates don’t vary by 
client, job, or task (since someone 
usually makes the same salary re-
gardless of what they do). You can 
change the cost rate while adding 
a time sheet if you have the proper 
access privileges.

Billing rates: Billing rates are much 
more variable. To accommodate 
different clients, you can create 
special rates for staff members 
or clients. Or, job tasks can have 
special rates that guarantee the 
same billing rates regardless of who 
works on the task.  

Jobs are assigned a billing rate 
based on the option always pull 
billing rate from task, staff or cli-
ent. This option can be set up as 
a default in general Preferences, 
as well as by job type and even 
job task.  This rate is then used on 
timesheets

■  For more information on billing 
rates, see the Clients & Profits X 
web site at www.clientsandprofits.
com.
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The Time Sheet window

Weekly Time Sheets

1  Use the remove button to 
remove an entry from a time sheet. 
The clear button will clear all 
entries from the time sheet.

2  Enter the initials of the staff 
member who did the work. Your 
initials are automatically entered, 
but they can be changed if you are 
entering a time sheet for someone 
else.

3  Choose an accounting period for 
this time sheet from the pop-up 
menu. Time entries don’t affect the 
G/L, the period is important for the 
Overhead Allocation Worksheet and 
the job and client P&L reports.

4  These buttons can be used to 
see tasks for the staff member a 
time sheet is being added for. The 
show my tasks button can be used 

to automatically copy in all job 
tasks that are due for the user. All 
the user needs to do is fill in the 
hours. The show schedule button 
lets you see (and edit, if you have 
access privileges) the job task’s 
due date, status specifications, 
and other details. Clicking on the 
finished checkbox in the job’s 
schedule removes the task from 
schedule and work to do reports. 
Any changes you make are saved 
immediately. The show traffic but-
ton lets you see (and maybe edit) 
the job’s production status, billing 
status, milestones and traffic next 
steps/comments. The show notes 
button allows the user to add a 
lengthy description for the time 
entry.

5  Each time sheet entry has a 
date. It’s important to use the time 

entry’s actual work date, since 
all of the job costs, productivity, 
and profitability reports use it. An 
accurate work date makes your 
time sheets more like a daily time 
log, which makes it easier to be 
accountable to clients.

6  Enter the job number here. If 
you’re not sure about a job number, 
leave it blank and press Tab. The 
jobs lookup list opens, listing the 
open jobs. Double-clicking on a job 
copies it to the time sheet. 

7  If you have a standard task in 
your Staff record, it will be copied 
to the time sheet automatically. 
You can change the task by typing 
over the standard task.

8  Enter the hours worked. Every 
time entry, including unbillable 

time, has some amount of hours. 
Enter the hours as numbers with 
up to two decimal places. 

9  Click the OT checkbox to make 
a time entry “overtime.” Overtime 
entries can be billed at an overtime 
rate, which is defined for each 
user. Overtime entries can be 
analyzed separately on time and 
productivity reports.

10  Enter a short description of the 
work done in the notes field.

11  If you have access privileges 
to see rates, you’ll see the entry’s 
cost rate and bill rate here. These 
rates are used to calculate the time 
entry’s net and gross amounts. To 
make an entry unbillable, enter the 
billing rate as zero. These amounts 
are calculated when the time sheet 
is saved. 
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Media

The media functions in Clients & Profits X are designed to replace the 
database or spreadsheet-based custom systems that most shops now use to 
plan, buy, and track media. It doesn’t try to replace high-volume media buy-
ing systems like SmartPlus, TAPSCAN, or Strata.  Instead, it is designed for 
shops that buy a relatively small amount of media—and whose planning and 
analytical needs are simple.  

Although it can create broadcast buys, Clients & Profits X is optimized for 
print media planning, buying, and tracking.  It works best in shops that 
primarly buy business-to-business media, instead of consumer broadcast 
media.  That’s because it doesn’t import and process ratings data from media 
services like Nielsen and Arbitron. Instead, you’ll set up and maintain your 
own station, publication, program, ad size, and rate information. It’s a big job 
to maintain these files, so it’s only practical if the number of media plans you 
do is small.

There are two ways to buy media with Clients & Profits X: media plans and 
media estimates. Media plans are elaborate and automatically lookup ad 
rates, while media estimates are simple and added manually. They both print 
a professional-looking report for your client to sign, authorizing your media 
buys. Otherwise, they have different purposes.

Media estimates vs. media plans

Media plans use the station and publication data (which you’ll set up) to 
automate the planning process—so there’s no rekeying information from the 
rate table to the media plan. Media estimates skip the planning process—in-
stead, you’ll simply type in the details about the media buy each time you 
need one. There are also specially-designed media windows and forms for 
broadcast and print plans.

Media estimates, however, are free-form. You can customize the information 
on media estimates as needed. Every media estimate you do could conceiv-
ably have different labels and headings, depending on the different kinds of 
media that you buy. Since there’s less to set-up, creating a media estimate is 
much faster than creating a media plan (which may be reason enough to use 
them).

If you don’t need a planning system, or use another system (like a spread-
sheet or Tapscan) to plan your buys, consider using only media estimates. 
Once the media estimate is added, it can easily create insertion orders 
automatically without rekeying. This saves lots of time and effort, as well as 
keeps your insertion orders more accurate.  

Media and the General Ledger

There is no direct link between media plans and the General Ledger. Adding 
a media plan doesn’t affect jobs. The job ticket is updated when an insertion 
order is created from a media plan; the job task’s Net and Gross PO total 
increases to show that you’ve ordered something. Insertion orders, like 

Media

purchase orders, don’t affect the General Ledger either. The General Ledger is 
only affected when the station or publication’s invoice arrives or the insertion 
is billed.

You can account for insertion orders made during the month with general 
journal entries to a media G/L account. A list of insertion orders added during 
the month can be printed from the PO Reports window; this total would be 
added as a journal entry, then reversed next month  The difference between 
the month’s insertions is your actual media cost.

Media Estimates

If you buy mostly print media (magazines and newspapers) for your clients 
and you’re planning needs are basic, use a media estimate. Adding a media 
estimate is similar to adding a job:  the media estimate has a number, a cli-
ent, a description, and line items just like a job has tasks.

Media estimates are very customizable. Each media estimate has five column 
labels (e.g., publication name, issue date, close date, ad caption, and ad size) 
that you can change for different kinds of media buys. You can enter a long 
description, a campaign code (for post-buy tracking), a standard disclaimer, 
and up to three approval names. These details appear on the printed media 
estimate.

Media estimates don’t affect job tickets until the insertion orders are created.

Print and Broadcast Media Plans

On the media plan for a client, enter a plan number, name, and other details, 
then add separate buys for each station or publication.  

Print media plans can be set up for monthly, weekly, or daily publications.  
For magazines, these periods can represent months during the year. For 
newspapers, they can represent different weeks. Since these periods are 
customizable, they can handle any kind of time range; however, the periods 
you enter apply to every buy on the media plan.

Adding media buys is like adding tasks to jobs. You’ll enter the publication or 
station code, which behaves like the task code. You can see the publication’s 
ad sizes (or the station’s programs/times) from a pop-up Lookup List. Double-
clicking on an ad size (or program) enters it onto the media plan. Most 
importantly, the rate is copied to the media buy automatically. For broadcast 
buys, you’ll enter the number of times the spot will run—and the total cost 
and rating points are calculated automatically.  You can add many different 
buys for many different publications (or stations) onto the same media plan.

When the media plan is printed, the buys you’ve entered are grouped to-
gether by publication (or station).
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Clients & Profits X features an integrated media calendar. The calendar, which conveniently 
appears whenever users work with media, lists upcoming space closing and material due dates 
as well as user-defined calendar “tickler” entries. These scheduled entries can be automatically 
e-mailed to media planners, buyers, and vendors. 

The names, addresses, and phone numbers of the most commonly-used publications and their 
various ad sizes (including prices) can be set up before adding print media plans. The information 
entered for each publication and ad size is copied automatically to new print plans, saving time 
and reducing data-entry errors. The publications table can be updated any time as information 
changes.

The Stations table lists the name, address, and account details for hundreds of different radio, 
television, and cable stations. The Times/Programs table contains descriptions and costs of the 
time slots offered by each station. This information is used automatically by broadcast media 
plans, and is copied to broadcast orders. 

Simple, quick media estimates can be created for clients showing them a schedule of media 
buys for any number of publications or stations. The printed media estimate looks like a job 
estimate, and includes a client approval signature line. Insertion orders can be made automati-
cally from media estimates.

Detailed broadcast media plans can be created that show scheduled radio, television, cable, or 
internet buys, including the number of spots, rating, cost per point, and more. Broadcast orders 
can be generated directly from broadcast media plans.   

Complete print media plans can be made that show schedule ad placements for daily newspa-
pers, weekly periodicals, or monthly magazines. Insertion orders can be created from print media 
plans without rekeying.

Orders can be created automatically from broadcast and print media plans. Orders can be placed 
any time using the information already saved on the media plan, saving time and eliminating 
rekeying errors

Once insertion and broadcast orders are created from media plans, they can be easily and 
quickly billed. Insertion and broadcast orders remember the client’s invoice number, so it’s easy 
to keep track of unbilled media.

Media accruals for work in progress are posted automatically from media billing. The net cost of 
the insertion or broadcast order is used for accrual journal entries, which update a special WIP 
accrual G/L account. When the media vendor’s invoice is entered, it reconciles the actual cost of 
the media with the accrued cost then makes the automatic reversing entry.

In Accounts Payable, the actual number of broadcast spots or ad placements is reconciled with 
the planned spots from the insertion or broadcast order. Each order keeps its own running bal-
ance of planned cost vs. actual cost, making it easy to bill clients accurately.

The optional C&P Media Link imports broadcast orders from MRP’s SmartPlus, TAPSCAN, and 
Strata. Imported buys appear automatically in the Purchase Order window, where they can be 
billed like other broadcast orders. A “standard media interface” lets any other media buying 
system export buys to Clients & Profits X using a simple-to-program import file format.

Media Calendar

Publications/Ad Sizes Tables

Stations/Programs Tables

Media Estimates

Broadcast Media Plans

Print Media Plans

Insertion Orders, Broadcast Orders

Media Billing

Media WIP Accounting

Media Reconciliation

Importing SmartPlus, TAPSCAN, 
and Strata Media Buys

Media Features

Feature How it works, how it’s used
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Checkbook

Checkbook

Hand-written checks

Clients & Profits X can write and print checks for vendor invoices, job costs, 
overhead expenses, and employee advances.  Clients & Profits X keeps a 
complete, detailed check register for all of your bank accounts—and can 
help you easily reconcile the accounts each month.  Checks are numbered 
automatically as they are written.  Different checking accounts should have 
different numbering sequences, which you can easily set in the Chart of 
Accounts. 

You can write checks any time. You can write one check at a time, or many 
checks at once. Checks are written individually for a vendor and unpaid 
invoices. Every check you write, including hand-written checks, should be 
added into Clients & Profits X.  A check can be written as a vendor payment 
on account, a job cost, or an overhead expense.  This means, for example, the 
same check can’t combine payments to vendors and overhead.   Checks can 
be written as direct disbursements for job costs, charging one or more jobs 
and tasks for pre-paid costs like printing, postage, and delivery—including 
markups.

Writing a check to a vendor is easy:  Open the Checkbook window, choose 
Write Check from the Edit menu, select Vendor Payment, enter the check’s 
vendor, account, date, and amount, then save it.  The vendor’s unpaid in-
voices are listed, and the check amount is applied automatically to the oldest 
payable.  You can decide for yourself which invoices to pay, as well as the 
payment amounts.  Posting the check reduces the vendor’s balance, pays off 
the unpaid invoices, and creates journal entries in the General Ledger.

The Auto-Pay Payables option makes writing checks for many vendors even 
easier.  This command pays unpaid payables automatically, based on a date.  
Clients & Profits X finds the unpaid invoices, then automatically writes the 
check—one for each vendor.  These checks are unposted, so they can be eas-
ily proofed and edited before posting.

Checks are printed using industry-standard, pre-printed check stock.  These 
checks, which are easily ordered from Deluxe or Rapidform, work best with 
Clients & Profits X.  Checks can be printed individually, or in batches by 
check number.  

The checkbook is seamlessly integrated with the General Ledger.  There’s no 
double-entry, so the information you enter on a check becomes part of the 
G/L.  Whenever checks are posted, debit and credit journals entries are cre-
ated automatically.  Every check makes a credit entry (usually cash) and one 
or more debit entries (either A/P, job costs, or overhead expense).  Default 
debit and credit accounts are entered for you automatically.

■  The check’s credit account is 
always a cash account.  The cash 
account is copied from your G/L 
account preferences.  Checks de-
crease your cash balance.  You can 
change the check’s credit account 
to withdraw funds from an alternate 
account, such as a money-market 
account.

■  Every line item on a check has 
a debit account (the “dGL”).  One 
check may have dozens of line 
items, each of which creates a debit 
journal entry.  For vendor payments, 
the line item’s dGL is copied from 
the A/P invoice’s credit account 
(usually A/P).  Checks for job costs 
get the dGL first from the job task’s 
debit account, then from your G/L 
preferences.  Checks written for 
overhead expenses can be debited 
to any expense account.

■  Journal entries from checks are 
posted into the Cash Disbursements 
journal.  The entry’s reference num-
ber is a combination of the prefix 
CK# and the check number.  The 
Cash Disbursements journal shows 
entries posted from the Checkbook.

■  Journal entries aren’t created, 
and the G/L account balances 
aren’t updated, until a check is 
posted.

Checks and the General 
Ledger

Hand-written checks aren’t dif-
ferent from other checks, except 
that they aren’t printed. They are 
entered exactly the same way, 
but usually from the hand-writ-
ten check’s stub. You’ll still want 
to enter the job cost or overhead 
expense information (job, task, 
debit account, etc.). But check the 
Hand-written check option before 
the check is saved. This option pre-
vents a hand-written check (or any 
check, for that matter) from being 
printed. When you select checks 
for printing, checks with this option 
chosen will be skipped.  

■  You can enter checks out of or-
der, so be careful to enter the right 
check number when adding hand-
written checks. The check number 
in Clients & Profits X should match 
the pre-printed check number on 
the hand-written check stub.
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The Checkbook window

1  Use the arrow buttons to find the 
previous and next checks.

2  The auto-pay button can be 
used to automatically cut checks 
for unpaid payables selected by 
vendor and A/P account for through 
a selected pay date.

3  Click the add button to write 
a vendor check. Checks can be 
edited by clicking on the edit 
button. To delete a check click 
on the delete button.  Voiding a 
check leaves the original check 
intact, but changes the amount to 
“***VOID***” and makes revers-
ing G/L entries.  If the check’s 
distribution is wrong, click on the 
redistribute button.  

4  Click on the print reports button 
to print checkbook reports.  To 
print checks, click on the print 
checks button.  

5  These toolbar buttons can be 
used to print cash disbursement 
reports and checks.  

6  To find a specific check, enter 
the check number here. 

7  Click on history to jump to a 
previously viewed check.

8  To see a check’s description, add 
a memo, or customize the payee’s 
address, click the description link.

9  The check’s paid to (i.e., payee) 
name is copied from the vendor 
account, and is usually the vendor 
name. 

10  Checks are numbered auto-
matically as they are added. Each 
checking account has its own 
numbering series.

11  The date shows the date the 
check was added. It appears on 
the printed check. Reports select 
checks by date.

12 The amount is the check’s total 
amount.

13  This is the amount of the 
check written in text.  

14  Checks have line items that 
contain the job cost, overhead 
expense, or A/P invoice informa-
tion. A check’s distribution can 
be changed until the check is 
posted. Double-clicking on a line 
item shows the distribution item’s 
details.

15  The memo is a short descrip-
tion of the check. It appears on the 
printed check, checkbook reports, 
and on journal entries.

16  Checks that are marked as 
1099 payments appear on the year-
end 1099 report.  

17  Checks that are marked as 
cleared have already been recon-
ciled in the bank reconciliation.

18  The cGL is the check’s credit 
G/L account. Each checking ac-
count has its own check numbering 
series. A check can be written for 
any open accounting period. The 
period determines which month is 
updated when the check is posted. 
The posted date is when the check 
updated A/P and the General 
Ledger. The posted date can be dif-
ferent from the check date.  Check 
reports can be printed by posted 
date or check date.

19  The initials of the person who 
wrote the check appears here for 
reference.
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Today’s date is entered automatically, but can be changed.  This date appears 
on job cost reports. If you don’t know the job number, leave it blank then 
press Tab. The job ticket Lookup List opens, listing open jobs.  Double-click-
ing on a job name copies it to the expense report. If you don’t know the job 
task, leave it blank then press Tab. The job task Lookup List opens, listing the 
job’s tasks.  Double-clicking on a job task copies it to the expense report.

5  Enter the first expense’s cost 
and gross amounts.

The expense’s cost is the 
amount you’ve paid for this 
expense.  The expense’s gross 
amount is the amount the client 
will eventually be billed.  If the 
expense is unbillable, leave the 
gross amount empty.

6  Enter the first expense’s 
notes.

The notes describe the expense 
on job cost reports.  It’s optional.  
To enter a longer description, 
edit the expense  after it has 
been saved.

 
7  Repeat these steps for the 
other remaining expenses.

8  Click Save.

You can add dozens of entries for many jobs and tasks at the same time, as 
long as they are for the same kind of expense. Once expenses are saved, they 
can be changed or deleted as needed until posted.

9  Choose File > Post, then follow the prompts to post this expense.

Expense Reports

Expense reports are a quick way to add many costs for a fax machine, stat 
camera, computer workstation, or other equipment. The Add Expense Report 
window lets you enter dozens of expense records for the same thing at the 
same time.  

Every in-house expense entry can have both a cost amount and a gross 
amount. The expense’s cost amount is how much the expense cost the shop.  
It is a user-defined amount, 
based on a best-guess of what 
the expense cost. The expense’s 
gross amount is the billable 
cost.  Gross is the amount that 
will be billed later to the client. 
The net and gross amounts are 
both user-defined.

When the expense entry is 
saved, its cost amount will 
update the job and task—the 
task’s cost total increases. The 
expense’s gross amount increas-
es the job task’s unbilled total. 
The gross amount becomes part 
of the client’s invoice when the 
job is eventually billed.  Ex-
penses are totaled by job task.  
Each job task shows the total 
expense for f lexibility. The job 
task’s cost total also includes 
expenses.

To expense reports

1  Choose Accounting > Expenses.

2  Click the Add button, or choose 
Edit > Add Expense Report.

3  Enter the expense’s description and 
accounting period.

The description is the name, part number, or code for a piece of equipment.  
It appears on job cost reports in the vendor/staffer column. Unlike accounts 
payable or checks, there is no lookup for expenses. It’s completely free-form, 
so you can track all kinds of equipment, facilities, and supplies.  Any un-
locked accounting period can be chosen from the pop-up menu. The current 
period, from Agency Information, is chosen automatically. The period here is 
used only for better accountability on job cost reports.

4  Enter the first expense’s date, job number, and job task.

Expense Reports

Expense tracking means greater 
profits.  Tracking expenses makes 
client reports more accurate. By 
capturing expenses, you’ll have a 
better idea about your clients’ true 
profitability. That’s because with-
out knowing every expense you 
use to service a client, it’s easy 
to think clients are more valuable 
than they actually are. 
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Employee Expense Reports

Expense advances are reconciled by adding employee expense reports. Each 
staff member can add their own expense report, because adding them is 
easy: enter the expense advance’s check number, then enter the expenses. 
If the expenses are for more than the advance check, then a check will be 
generated for the staff member. If the advance check was for more than the 
expenses, then a check is requested from the staff member to reimburse the 
company.

Once the expense 
report is posted, 
the advance check 
amount moves from 
prepaid expense to the 
appropriate expense 
accounts.

To add an em-
ployee expense 
report

1  Choose Accounting 
> Expenses.

2  Choose Edit > 
Add Expenses > Add 
Employee Exp Report. 

The Add Employee Ex-
pense Report window 
opens, prompting the 
staff member to enter 
the check number from 
the expense advance.

3  Enter the check number from the 
expense advance.

This step is required to add expense
reports. If expense reports were added
without referencing the advance
check, the check would never be 
reconciled—and the company would
think the employee still owes it money. Only check numbers from employee 
expense advances will be accepted. Once the check number has been en-
tered, the staff member can enter their expenses. The amount of the expense 
advance check appears for reference. This is the amount that was advanced 
to the employee for their expenses. 

4  Enter the first expense’s date, job number, and job task.
The date shows when the expense occured. It appears on job cost reports and 

the Invoice Detail report (which documents the billing amounts on the job’s 
invoice).

5  Enter a note, cost amount, and gross amount.

The optional note describes the expense on job cost reports. The expense’s 
cost is the amount you’ve paid for this expense. The gross amount is what the 
client will eventually be billed. If this expense is unbillable, leave the gross 

amount as zero.

6  Repeat steps 4-5 
for the remaining 
expenses on the 
expense report.

You can add dozens 
of expenses onto 
a single expense 
report, as long as 
they are being  
 
reconciled to the 
same expense 
advance check.

 
7  Click Save.

If the employee 
spent more than 
their expense 
advance, Clients 
& Profits X will 
automatically add a 

check to the employee for the difference. 

This reimbursement check is posted automatically, so all you have to do is 
print the check. However, if you spent less than the amount of the expense 
advance, the employee will need to write a personal check for the difference. 
Clients & Profits X won’t save the expense report until the employee’s check 
number is entered.

Employee Expense Reports

Employee can enter their own 
expense reports from their own 
computer. All they need to enter is 
the check number from their ex-
pense advance. Clients & Profits X 
looks up the check, then prompts 
them to enter their expenses.
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Clients & Profits Xvides many ways to track a job’s progress on-line. The job’s 
“snapshot” provides an up-to-the-minute look at its estimate vs. billings, 
estimated hours vs. actual hours, profit to date, and the job’s next billing. The 
job’s “progress” window shows totals for each job task.

To view a job’s snapshot

The Job Snapshot window sup-
plies account executives, account 
coordinators, and others with an 
up-to-the-minute snapshot of a job’s 
progress.  Quick calculations show 
the job’s remaining estimate and 
profit-ability. This helps users catch 
any problems before they become 
serious—and expensive or trouble-
some to fix. A job’s advance billing 
balance appears in the Snapshot 
window. The balance is the amount 
you can apply against upcoming 
invoices for this job.

Account executives can use the job 
snapshot to better plan the upcom-
ing billings. By entering the date 
and amount of the job’s next billing, 
pre-billing reports can be printed.  
These reports show what’s 
expected to be billed during the 
next billing 
cycle. The job’s account executive will be 
notifiedby e-mail on the billing date.  Account 
executives can use the job snapshot to 
review a job’s estimates vs. actuals. If a 
job looks like it is costing too much, the 
over budget amount can be entered into 
the snapshot window. Progress reports  can  
be printed showing these problem jobs, so that  
they can be watched more closely.

1  From the job ticket window, click on the Snapshot button.

The Job Snapshot window opens displaying the jobs estimate, hours, profit-
ability, and billing totals. If account planning is important, the cost amounts 
and hours needed to finish the job, as well as the amount and date of the 
next billing, can be entered here. These amounts appear on the Snapshot 
Worksheet report, which can be used by account supervisors to track each 
job’s percentage complete.

2  Enter the job’s needed and next billing information, then click Save.

Tracking Job Progress

Tracking Job Progress

The job snapshot window’s updated field is changed automatically when you 
click Save. To print a hard-copy printout of the job’s snapshot window, click 
the Print button.

To view a task’s costs, and billings

A job’s costs, and billing amounts 
can be conveniently viewed from 
the Job Tickets window. The job’s 
activity is displayed in detail on 
screen. The View>Point options are 
an extremely fast and simple way to 
see a job’s activity without printing 
lots of reports. The job’s activity can 
be viewed anytime by selecting the 
job’s drop-down menu.

■  To see the job’s costs, select Task 
Costs 

■  To see the job’s billing amounts, 
select Task Billings.

The same costs and billing amounts 
can be printed for many jobs, as well 
as one project, from the Print Job 
Reports window.

To review a job’s progress

The Job Progress window shows a job task’s totals to date. For each job task 
you’ll see its budgeted hours and budgeted costs compared with the its 
actual hours and actual costs. The percentage of budget used is calculated for 
each job task, easily showing how much of its budget remains.  Calculations 
are the bottom of the window compare the percentage completed for the 
entire job based on its total budget and total costs.

The window’s toolbar buttons let you verify the job’s costs and billings (its 
identify the Verify/Recover utility), printing the job’s Job Progress report, 
and for printing a job’s costs, billings, and purchase orders. For jobs with 
large numbers of tasks, the Show Groups pop-up menu lets you compare the 
progress of different groups of tasks at one time.

1  From the Job Ticket window, choose Job Progress from the View>Point 
drop-down menu.

The Job Diary

Each job ticket has a diary that tracks the job’s history. The job diary helps 
users see what kind of changes have been made since the job was opened. 
A production manager can see a job’s history from his or her own computer, 

Plan the month’s billings.
The job snapshot window’s 
Billing Worksheet section 
shows the job’s unbilled 
total. The job’s next billing 
amount and the date 
will be summarized on 
the Snapshot Worksheet 
report.
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instead of tracking down and interrogating everyone who worked on it.

Job diary entries are made automatically when many kinds of changes are 
made. 
Entries are made when the job is opened, then anytime the specifications, 
estimates, 
or schedules are edited. They are also made whenever new tasks are 
added, removed, or changed as 
well as 
when the status is updated. 
Closing the 
job makes a diary entry, as does 
deleting 
a job. A deleted job’s diary 
stays in the 
database—so it’s easy to know 
who deleted 
a job ticket. The deleted job’s 
diary can be 
printed from job reports.

Each diary entry shows the date 
and time a 
change was made and who 
made it. A short, 
default description describes 
each entry. In 
addition, a user can include a 
longer explanation if needed. 
The information on an existing 
diary entry, except for the notes, can’t be 
changed. New entries can be added manually 
to document client meetings, memos, and 
phone calls important to a job’s progress. 
Diary entries don’t appear on client reports, 
but can be printed with job reports.

■  Since one of the important functions of 
the job diary is to track who did what on 
a job, diary entries can’t be deleted. If an 
entry were deleted, the job history would be 
incomplete.

To see a job’s diary

1  From the Job Ticket window, click the Job Diary button or choose Edit > 
Job Diary.

The job’s diary entries appear in the window, sorted by date (newest entries 
first). Entries can be resorted by clicking on the different column headings 
(i.e., when, who, what). The sort order can be reversed by clicking on the Sort 

buttons in the toolbar. Double-click on a diary entry to see its notes.

To add a diary entry

Most diary entries are entered automatically while you’re working. The only 
entries you might need to make are for events that occur outside of Clients & 
Profits X, like client meetings, approvals, phone calls, etc. 

1  From the Job Diary window, 
click the (i.e., Add) button 
then enter the date, time, 
short description, and notes 
that explain this entry.

The diary’s user initials can’t 
be changed. An e-mail mes-
sage can be sent by entering 
a staff member’s initials. 
The e-mail message is sent 
immediately when the entry 
is saved. The diary’s notes be-
come the body of the e-mail. 
For security reasons, job diary 
entries can only be sent to 
staff members.

2  Click Save.

“Who added that task?”
Job diary entries are made 
automatically whenever 
tasks are added or removed, 
traffic is edited, and more. 
Double-clicking on a diary 
entry shows its full details. 
Selected entries can be 
printed by pressing down the 
Command (or Ctr in Windows) 
key then highlighting the 
entries to print then clicking 
the Print button.
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Client Billing/Accounts 
Receivable

Everything you do for a client is billed by adding an invoice into Accounts 
Receivable.  Clients can be billed for anything you do—whether you’re billing 
an estimate, an advance, a retainer, a service charge, or a job’s final costs.  
Accounts receivable invoices are seamlessly integrated with jobs and costs, 
so billing is particularly quick and easy—and can be mostly automatic.

Every kind of client invoice—including deposits, retainers, advances, credits, 
and discounts—should be added into Accounts Receivable.  Invoices have one 
or more line items, which contain the actual billing amounts.  Every task on a 
job can be billed as a separate line item on an invoice, providing your clients 
with a clear, detailed billing—one that looks like their estimate.

Invoices can be created for job tickets, anytime, one at a time or all jobs at 
once.   All you need to know is the job number; Clients & Profits X copies the 
job’s tasks, descriptions, and unbilled amounts to the invoice automatically.  
The printed invoice shows the job’s details, such as specifications, contacts, 
and billing information.

A job can be billed at anytime, as many times as needed.  An invoice can bill 
one job ticket, or contain billings for many different jobs and tasks—even jobs 
for different clients.   

Billing, obviously, is one of the job’s most important steps.  It summarizes 
all of the work you’ve done on a job—including payables, time, checks, and 
expenses—on a simple, concise printed invoice.  Invoices can be added at the 
end of the month, or throughout the month as jobs are completed.  Billing 
works like this:  (1) Unbilled jobs are reviewed on work in progress reports to 
see what’s ready to bill; (2) account executives can adjust unbilled amounts, 
if needed, to fine-tune what will be billed.  Costs, time, and expenses can be 
transferred between jobs to the same task; (3) from these work in progress 
reports, invoices are added for each job’s unbilled tasks.  The auto-bill option 
can bill these jobs automatically in one step; (4) these new invoices are 
proofed, edited, then posted.  Posting updates the client’s balance, job totals, 
and the financial statements; (5) the new invoices are printed, then mailed to 
clients; (6) when the client sends a payment, it is added into Client Payments 
and applied to these unpaid invoices. This completes the billing cycle.

Everything you bill affects the client account and the General Ledger when 
invoices are posted. Invoices are posted to update clients, jobs, and the Gen-
eral Ledger.  Posting an accounts receivable invoice creates General Ledger 
journal entries automatically.  The invoice’s total makes a debit entry, usually 
updating the A/R account; each invoice line item makes a credit entry, 
usually for an income account. Posted invoices appear on job reports, billing 
reports, statements, and client aging reports.  

Client Billing/Accounts Receivable

Job Billing  Job billings lets you 
create an invoice by selecting any 
job’s tasks.

Advance Billing  Advances bill 
jobs from their estimates, before 
work has begun. Tasks aren’t billed; 
instead, the client only sees an 
advance billing amount.  You can 
bill all or part of the estimate.  
The job’s total billings aren’t af-
fected; instead, it updates the job’s 
advance billing total.  Advance 
billings can be applied like a pay-
ment to later invoices.  Additonally, 
they don’t affect income, instead 
they credit a liability account 
(e.g.,unearned income).

Progress/Final Billing  Invoices a 
job’s unbilled tasks in one step.

Estimate Billing  Estimate billings 
invoice a job’s estimates, show-
ing tasks. Unlike advances, they 
increase the job’s billed totals.

Media Billing  This option lists un-
billed insertion orders or broadcast 
orders.  Each insertion appears as a 
separate billing amount, showing 
its publication, issue date, ad#/
caption, and gross cost.

Multi-job Billing  This option lets 
you bill one client for one or more 
jobs and their tasks.

Miscellaneous  Bills clients for non-
job charges like consulting fees.

Retainer  Retainers bill clients for 
account service fees, based on a 
retainer billing schedule. They don’t 
affect jobs. Retainers are applied as 
payments to future job invoices.

Billing types

An invoice’s billing amounts come 
from job tasks.  Each job task keeps 
a running total of its costs, time, 
checks, and expenses from the 
day the job began.  The job task’s 
unbilled balance shows its unbilled 
gross costs (which includes mark-
ups, commissions, and billing rates) 
less what’s been billed before.  

Job costs aren’t literally billed on 
the invoice.  Instead, the invoice 
bills the job’s tasks—specifically, 
each task’s unbilled amount.  When 
you bill a job, every task that 
has unbilled costs can appear 
on the invoice (either automati-
cally or manually, your choice).  
The invoice’s billing amount is 
copied from the job task’s unbilled 
amount.  So clients don’t see every 
cost, time entry, and expense on 
invoices; instead, they only see job 
tasks.

You can freely change the invoice’s 
billing amounts.  The job’s costs 
are unaffected, giving you the f lex-
ibility to bill any amount you wish 
without making complex, time-
consuming adjusting entries.

Where do billing amounts 
come from?
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The Accounts Receivable window

The Accounts Receivable window

1  Use the arrow toolbar buttons to 
scroll through the previous and next 
accounts receivable invoices.

2  To automatically bill clients 
or projects for selected unbilled 
job tickets, click on the auto-bill 
button.  

3  To add a new job billing invoice, 
click on the add button.  Clicking 
on the edit button lets you edit 
the billing’s invoice description. 
To change billing amounts, click 
on the edit amounts button. To 
delete a billing, click on the delete 
button.  

4  Amounts can be easily added 
and removed from an unposted 
billing using the add amount and 
remove amount buttons.  

5  Use the print reports and print 
invoices buttons to print Accounts 

Receivable reports and invoices.

6  Enter the invoice number here to 
find a billing. 

7  Use the history pop-up menu to 
jump to a previously viewed billing.

8  Click on these links to quickly 
see the most important parts of an 
invoice, then make changes. 

9  Invoices are automatically num-
bered or you can enter your own 
invoice number. The next invoice 
number can be set in Preferences. 
It can contain up to 10 numbers.  

10  The billing type indicates what 
kind of charges were billed on this 
invoice (e.g., estimate, progress/
final, media, advance, retainer, 
miscellaneous, etc.). 

11  The added by initials show 

which user added the invoice.  

12  Every invoice includes one 
client number, one or more job 
numbers, a description, and an 
invoice date. This information ap-
pears on the printed invoice. 

13  The client’s PO number is 
copied from the job ticket. The 
payment terms are copied from the 
client account. Both appear on the 
printed invoice. 

14  The due date is the date on 
which the invoice’s payment is 
expected, and is used by the Cash 
Flash report. Clients never see the 
due date.

15  The Balance due shows the 
invoice’s total charges (including 
sales tax) less any retainer, ad-
vance, or client payments. Posting 
updates the client account, jobs 

and tasks, and the General Ledger. 
Posting an invoice updates the G/L 
based on its accounting period. 

16  The days due box shows a 
countdown of how many days are 
left until the invoice reaches it’s 
due date.  

17  Each invoice line item can 
include a job, task, description, 
and billing amount. Double-click on 
a line item to see and edit a billing 
amount.

18  If a retainer or advance pay-
ment was applied to an invoice, its 
description and amount appear at 
the bottom of the window—and the 
printed invoice.

19  The total amount of the billing 
includes sales tax plus the total of 
all invoice line item amounts.  

q w e r t

y u

i

o p

s

f

g

j

h

k

l

a

d



66

Client invoices can be printed any time after they are posted. Invoices can 
be printed individually, or in batches for a range of invoice numbers. A batch 
of invoices can also be printed for the same client and a range of invoice 
dates; this option lets you print the month’s invoices for one client quickly 
and easily.

The printed invoice shows the line items, billing amounts, descriptions, and 
notes you’ve entered into the invoices. Each invoice can have its own set of 
options and settings (e.g., 
display options, group and 
sort, show or hide totals, 
etc.) that affect the look 
of the billing. So printing a 
large number of invoices at 
the same time may show 
a wide variety of invoice 
styles.  

Invoices are designed to 
print on your letterhead.  
The invoice margins are cus-
tomizable, and can be set 
by choosing Invoice Options 
from the Preferences pop-up 
menu. None of the invoice’s 
options can be changed 
at the time invoices are 
printed. To change these 
options you must make your 
changes first, then print the invoice. The optional agency billing address is 
printed from Agency Information, where it can be changed.

An invoice can be printed then reprinted any number of times.  As an option, 
a job cost report can be printed showing costs billed on these invoices. This 
invoice detail report can be used to back up the billing amounts on invoices, 
if you bill strictly based on costs. If you bill for more than your costs, don’t 
print this report—your client will wonder why you’re overbilling them.

■  Unposted invoices will print if they are part of the selection, but will be 
printed as “billing previews” until they are posted.

To print client invoices

1  Click on the Print Invoices button, or choose File > Print Invoices.

The Print Invoices window lets you select a batch of invoices selected by 
invoice number (e.g., 6006 - 6015), one particular client, and a range of 
invoice dates. The currently display invoice’s number is entered by default, 
but can be changed.

2  Enter a range of invoice numbers and an optional client number.

Printing Invoices

Printing Invoices

Any invoice numbered within the range of numbers you enter will be printed 
(or reprinted, in some cases). Enter a client number to print only invoices 
added for one client; the option is useful when a client asks for a reprint of 
the month’s billings.

3  Enter an optional range of invoice dates and options.

The currently displayed 
invoice’s date is entered 
by default. Use this option 
only when you need to print 
a set of invoices added on 
the same day or within the 
same time period. 

Use the print invoice detail 
report option to include a 
copy of the job cost report 
with each invoice. Since job 
costs and billing amounts 
are linked, your clients can 
easily see the costs billed 
specifically on an invoice. 
The Invoice Detail Report 
shows gross amounts only, 
so clients won’t actually 
see what the agency paid 
for the job’s costs.

Since each invoice can contain up to five distribution names, up to five 
copies of an invoice can be printed automatically. Since laser printers don’t 
handle multi-part forms, Clients & Profits X prints the distribution name (e.g., 
Acct Exec, Client, Job Jacket, etc.) at the bottom of each invoice. The print 
distribution copies option should be unchecked when printing invoices on 
multi-part forms to high-speed dot-matrix printers.

4  Click Print.

■  Since an invoice can be reprinted many times, be careful not to mail out 
duplicate copies of the same invoice just because it printed again.  
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The printed invoice

Invoice

Corporate Communications
7405 Von Karmen Avenue
Los Angeles  CA  90012

Don Gibbs Number 11027
Audience Technologies Inc. Date 01/01/07
200 Long Canyon Job Number ATT-150
Palm Springs  CA PO# --
93029 Charge# --

Job Name: Reseller Channel Web Site
Agency Exec. Tammy Burns
Description: Monthly web site managment - Reseller Channel web site

Description Hours Billed Amount

Creative Concepting 8.00 $800.00
Copywriting 5.00 $500.00 *
Creative Subtotal: 13.00 $1,300.00

Photography 5.00 $750.00 *
Production Subtotal: 5.00 $750.00

Computer Graphics/Programming 15.00 $1,500.00 *
Fulfillment Subtotal: 15.00 $1,500.00

Project Management 2.50 $225.00 *
Account Management Subtotal: 2.50 $225.00

SUB-TOTAL: 35.50 $3,775.00

*7.7500% State Sales Tax: $230.56

TOTAL: 35.50 $4,005.56

PAYMENT TERMS: Net 15

Thank you for your business and prompt payment!
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General Ledger

Clients & Profits X is built around a one-write, double-entry general ledger.  
This comprehensive, accrual accounting system automatically tracks your 
income, costs, and expenses using a custom, user-defined chart of accounts. 
Your G/L accounts track activity totals for 24 accounting periods (15 in C&P 
Classic). The system provides agency-tailored financial statements, including 
income statements, balance sheets, trial balances, detailed general ledgers, 
journals, and audit trails.

The General Ledger is used for 
financial accounting. This is 
different than job account-
ing, which deals with costs, 
billings, and expenses from 
the job’s point-of-view. The 
General Ledger consolidates 
all of the work you do—both 
job costs and overhead 
expenses—to provide a true 
look at the shop’s net income.  

■  Clients & Profits X has ev-
erything you need to produce 
financial statements, so it 
replaces any existing account-
ing systems you may be using. 
You do not need additional 
software programs to manage 
your books.

Unlike other systems you may 
have used, not everything 
affects
your general ledger. In fact, 
only those transactions that involve 
actual money (such as purchases, 
checks, and client payments) update 
the G/L; job costs (such as time, out-
of-pocket expenses, and purchase 
orders) do not affect your financial 
statements. This is important to 
understand, since it determines how 
you’ll manage your books with 
Clients & Profits X.

Financial reports provide comprehensive auditing and analysis information.  
Financial accounting takes into consideration every expense and income 
dollar in the shop, not just job profitability.  Overhead  expenses, salaries 
and miscellaneous income are included on the Income Statement along with 
job-related transactions. Assets, accumulated depreciation, liabilites, and 
equity are reported on the Balance Sheet. Audit trails, journals, and ledgers 
help track the transactions included in the financial statement calculations.  
General ledger account budgets are easily added and printed to analyze the 

General Ledger

account activity more closely. 
 

Automatic vs. manual journal entries

Journal entries are added to the General Ledger automatically when payables, 
receivables, checks, and client payments are posted.  Invoices that you enter 
into Accounts Payable, billings that you enter into Accounts Receivable, 
checks that you write in the Checkbook, deposits that you enter into Client 

Payments, and employee 
expense reports that you 
enter into Expenses are 
distinct records. Each record 
creates a separate journal 
entry into the General Led-
ger.  So when you see 
a G/L report, you are actu-
ally looking at the journal 
entries—not the source 
records, such as the invoice.  

Any manual entries you 
make directly into the Gen-
eral Ledger appear on G/L 
reports; they won’t appear 
on payable, receivable, or 
cash reports.  This gives you 
the f lexibility of manag-
ing your cost accounting 
apart from your financial 
accounting.

Profit centers and departments

Profit centers are set up to track a division’s finances and each profit center 
has its own chart of accounts. The profit center’s financial statements include 
only general ledger numbers that are assigned to that profit center. The profit 
center’s transactions post to the G/L like any other accounts.  The only dif-
ference is that the option can be chosen to print financial statements for only 
those accounts.  There’s no limit to the number of profit centers which can 
be set up.

Departments are used to track costs incurred by a group of staff members 
(e.g., the Art Department). Separate expense accounts are set up for each de-
partment and are distinguished by a two digit code that follows the account 
number. Each account is listed separately on financial statements unless the 
roll-up option is used.

The General Ledger window displays 
journal entries from A/P, A/R, the 
Checkbook, and Client Payments as 
well as manual entries you’ve made 
directly into the G/L. Use the toolbar 
buttons to find, add, edit, delete, 
and print journal entries. The Print 
button is a shortcut to printing 
G/L reports, which show debit and 
credit entries by reference number.
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Clients & Profits X is a single accounting system, so there are no complicated modules to 
integrate, maintain, or close. 

When someone adds a vendor invoice, check, client invoice, payment, or employee expense 
report, Clients & Profits X posts debit and credit journal entries into the General Ledger 
automatically. Standard (“default”) debit and credit account numbers are entered automati-
cally, too,but can be changed. This gives users the f lexibility they need to accurately account 
for all kinds of billings, costs, and expenses. In addition, general journal entries can be added 
directly into the General Ledger.

The entries users make don’t update the G/L until they are posted. Each user can double-
check their own work before posting using proof lists. Proof lists show the debits and credits 
for each transaction they added.

Any vendor invoice, client invoice, check or employee expense report can be coded with one 
or more job numbers and tasks. This tells Clients & Profits X to update the job ticket as well as 
the General Ledger. Because the accounting system is integrated with job tracking, there’s no 
double-entry. 
 
In addition to job costs, all kinds of overhead expenses are tracked by Clients & Profits X. 
Overhead invoices and checks can debit many expense accounts (and can even be split be-
tween job cost and overhead G/L accounts).  

The General Ledger is updated every time an invoice, check, or payment is posted, so financial 
reports are also up-to-the-minute accurate. No month-end closing is required to print financial 
statements or aging reports.

Clients & Profits X can have two fiscal years open simultaneously. Fiscal years are customiz-
able, so they can start at any time during the year. Accounting, job costing, and financial 
analysis reports can be printed for any accounting period.

The chart of accounts supports hundreds of separate G/L accounts. A separate set of accounts 
can be created for profit centers or departments for better accountability. Each account can 
have up to a 9-digit account number, as well as customizable class, sub-class, cash flow, and 
ratio category settings.

Built-in auditing and reporting tools make it easy to analyze, query, and troubleshoot your 
accounting. Detailed audit trails and journals can show journal entries for any time period and 
for a range of accounts. The innovative Auditor lets you verify your General Ledger quickly and 
easily.

Clients & Profits X can handle dozens of different profit centers. Profit centers are integrated 
with jobs, tasks, staff members, and clients for better accountability. Financial statements can 
be printed for one profit center or for all profit centers. Departmental G/L accounts can be set 
up and used within a profit center for better cost tracking and analysis.

Monthly budget amounts can be entered for every G/L account, reducing the need for separate 
budget spreadsheets. Budget amounts can be reviewed on-screen or printed for any account-
ing period or quarter.

G/L Features

Feature How it works, how it’s used

 

One-Write, Double-Entry G/L

Automatic Journal Entries

Posting With Proof Lists

Integrated Job Costing, Billing

Overhead Accounting

Real-Tme Financials

24 Accounting Periods

Chart of Accounts

Auditing Tools

Profit Centers, Departments

Budgeting 
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Chart of Accounts

The Chart of Accounts contains your G/L accounts. These accounts are the 
basis of your accounting system, keeping monthly totals of income, costs, 
expenses, assets, and liabilities. The balances that appear on income state-
ments, balance sheets, trial balances, and other financials are based on the 
account totals in the Chart of Accounts.

The Clients & Profits X chart of accounts is completely customizable. You 
can have as few or as many accounts as you need (there’s no real limit to the 
quantity of accounts). Each account has an account number, classification, 
sub-class, and categories for cash flow and ratio reports. Separate accounts 
can be set up for different profit centers and departments. Every account 
keeps real-time running balances for up to 24 accounting periods (15 in C&P 
Classic).  

Budget amounts can be quickly set up for any or all accounts and periods 
using last year’s totals. Account totals can roll up into other accounts. The 
accounts are set up with the rollup information in the Chart of Accounts.  
Choose the Rollup option when printing financials to rollup, or hide, the 
account totals in the designated account. Accounts can also be made 
confidential. Confidential accounts work like regular accounts, but can’t be 
used by non-managers. They don’t appear on the printed account list or the 
lookup list.

You can add, edit, and delete accounts from your Chart of Accounts anytime 
(except for accounts with activity). Accounts with activity can be edited 
(except the number) and reclassified, but not deleted.

Account numbers

There are no rigid rules about numbering G/L accounts, although the number 
has a limited length (9-digits, which includes a decimal point and  2 decimals 
places to indicate the account’s department). You choose your own account 
numbers, so you can use any numbering system that conforms to account-
ing standards. Also, the same account number can’t be used twice. Account 
numbers are numeric, so they can’t contain letters or characters (i.e., dashes, 
etc.). An account number can’t be changed if the account has activity (i.e., 
journal entries) or a balance. Account numbers can’t contain leading zeros 
(e.g., 001000).

Account classes, subclasses, and profit centers

Accounts are categorized three ways: a major classification (e.g., asset, 
liability, sales, etc.), a subclass (e.g., current assets, fixed assets, etc.), and 
a profit center. The class organizes accounts as assets, liabilities, equities, 
sales, costs, expenses, other income, or other expenses.  Asset, liability, and 
equity accounts appear on the Balance Sheet. Income (billings), costs, ex-
penses, other income, and other expenses appear on the Income Statement. 
All accounts appear on the Trial Balance and the Detailed General Ledger. 
The classifications themselves are fixed, but their names can be changed in 
Preferences.

Chart of Accounts

Accounts are subtotaled within each class using a subclass. Subclasses 
are optional and user-defined, so you can create as many as needed. 
An account’s subclass can be edited anytime. Each account can belong to 
one profit center and one department. Profit centers are user-defined, so you 
can create as many as needed. Financial statements can be printed for one 
profit center at a time, or all profit centers.

Default accounts

Clients & Profits X has the ability to pre-program standard, or default, ac-
counts into your database. These default accounts are entered automatically 
when payables, checks, receivables, and client payments are added.  Default 
accounts can be overridden by simply entering an account number when 
a transaction is added. Default account numbers can be entered for these 
accounts: Cash/Checking; Accounts Receivable; Accounts Payable; Client 
Retainers; Billing/Income; Employee Advances*; Media Accruals*; 
Media Costs*; Overhead Expenses; Retained Earnings; Advance Billings*; A/R 
Discount Given; and, A/P Discount Taken.  Default G/L accounts are optional, 
but can help make your accounting more consistent and reduce errors. The 
default account numbers are entered in the G/L accounts Preferences win-
dow.  *not available in C&P Classic

Year-to-date net income, retained earnings 

The Year-to-Date Net Income and Retained Earnings accounts are necessary 
to your financial statements. The year-to-date net income account (which is 
always 999999) is calculated each time a financial statement is printed.  The 
account’s balance is always the income less costs and expenses. While the 
account number can’t be changed, you can name the account whatever you 
want. You can’t post entries directly to the YTD income account; instead, 
entries should be posted to income, costs, expenses, or Retained Earnings.

The Retained Earnings account tracks net income (or loss) from the previous 
accounting years. It’s an equity account of your choosing. The account is only 
used at year-end closing and for adjustments. Unlike the year-to-date net in-
come account, you can post journal entries to the Retained Earnings account 
when you need to adjust last year’s ending balances.

The Suspense account

The Suspense account (999998) is updated when the program isn’t able 
to find the account entered on the transaction. It’s an important account 
because it acts as a safety net when the wrong account, or no account, is 
entered. When entries are found in the suspense account, they are reversed 
out of suspense and into the correct account.
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The Chart of Accounts window

1  Use these tool bar buttons to 
scroll through the previous and next 
G/L accounts.

2  G/L accounts can be added, 
edited, budgeted, or deleted from 
the Chart of Accounts window.  
To add a new G/L account, click 
on the add button.  To edit a G/L 
account’s information, click on the 
edit button.  An account’s budget 
can be added, edited, viewed, or 
deleted by clicking on the edit bud-
get button.  The Monthly Budget 
window shows you the  monthly 
totals for this year and last year, as 
well as the budget for the selected 
G/L account. To delete an account, 
click on the delete button.  If an 
account has a balance or journal 
entries posted against it, it can’t be 
deleted.  Instead, you can  make 

the account inactive.

3  To print a hard-copy of the 
account list, click on the print but-
ton.  The list shows each account’s  
number, name, class, subclass, and 
profit center.

4  Enter an account number here to 
find a G/L account.  

5  Clicking the view history link 
let’s you quickly view and print all 
G/L entries for a selected account.  
All periods with activity appear 
and the debits and credits are 
subtotaled.  Then the period is 
reported.  The account’s balance is 
calculated at the end of the report.  
Each transaction’s date, reference 
number, and description are also 
given.   

6  Profit centers, sub-classes, and 
budget worksheets can be added, 
edited, viewed, and deleted from 
the Chart of Accounts window.  
Clicking on the profit centers link 
opens the Profit Centers window, 
where you can add, edit, and delete 
PCs.  Profit centers are used to 
track the financial performance 
of different parts of your business 
without maintaining a separate 
set of books.  Click the subclasses 
link to add, edit, delete, and print 
account sub-classes. Subclasses 
are used to arrange and subtotal 
accounts on financial statements. 
Examples of standard subclasses 
are Current Assets and Long-Term 
Liabilities. An account can belong 
to any (but only one) subclass.  
Click on the budget worksheet link 
to enter or edit the budget for the 

year.  All the G/L accounts and 
periods are displayed.

7  Double-click on the account 
class to view its accounts. G/L 
accounts are listed numerically by 
account number with their name/
description, profit center, and 
sub-class.    
8  Double-clicking on an account 
lets you change the G/L account 
information, such as its name. G/L 
accounts are added, edited, or 
deleted in the Chart of Accounts 
window only. 
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Snapshot Reports

Snapshot reports provide a simple way to see essential information about 
the business. The idea behind snapshot reports is simple: Snapshot reports 
are designed to give managers quick “snapshots” of jobs, costs, billings, and 
financial information that are easy to print without programming. 

Snapshot reports summarize data from all parts of Clients & Profits X:  Pro-
duction reports show status, traffic and schedules from jobs and tasks.  Work 
in Progress reports show estimates, costs, and to-be-billed amounts from 
jobs and tasks.  Job Cost reports summarize purchases, time, expenses, and 
checks by job, task, or client.  Vendor Account Aging reports show unpaid 
invoices from Accounts Payable.  Client Account Aging reports show unpaid 
invoices from Accounts Receivable. The Cash Flash window shows the current 
cash status —the current cash balance and outstanding account balances 
for A/R and A/P. Productivity reports show how time was spent from Time 
Sheets. Profitability reports show profit and loss from jobs and tasks. Finan-
cials are financial statements printed from your General Ledger.

The snapshot reports are f lexible, offering many options for selecting, sorting, 
and printing data. Snapshot reports do not replace reports found in the Job 
Tickets, Accounts Payable, and other windows; instead, they work together to 
give you the most complete picture possible of your work.

Printing snapshot reports is easy: Simply choose a command from the Snap-
shots menu, make your selections, then click Print. Report options determine 
how data will be selected, sorted, and printed. Your report can be printed 
to the window (for a quick on-screen review of the data), to the printer, or 
to disk as a word processor text file. Every snapshot window lets you select 
from various options, all of which make your report slightly different. That’s 
why there isn’t really one “snapshot” report for production, for example; 
different versions of the same basic report let you somewhat tailor the report 
to your exact needs. Some snapshot windows have more options than others, 
depending on what’s being printed.

■  Anyone can print snapshot reports if they have the proper access privi-
leges. If a user has access to a particular snapshot window, he or she can use 
any of the window’s reports and options.  

Snapshot reports vs. other reports

Snapshot reports consolidate data from all parts of your Clients & Profits X 
database, such as job tickets, accounts payable, time sheets, checkbook, and 
accounts receivable. They specialize in summarizing mammoth amounts of 
data into clear, concise reports.  

Snapshot reports use the same data as reports printed from Job Tickets,   A/P, 
A/R, etc. So you’ll see the same data on a job summary printed from Job 
Tickets as you would on a Snapshot report. The difference is the snapshot 
report shows many jobs—while a job report from Job Tickets usually shows 
one job ticket.  

The record-by-record detail for a snapshot report can always be printed 

Snapshot Reports

separately. The individual time entries in a Productivity report, for example, 
can be printed as time reports from Time Sheets. Or, the journal entries that 
comprise the totals on your Balance Sheet can be printed in audit trails from 
the General Ledger.

Tips for printing snapshot reports

■  Printing reports to the window is faster than printing to the printer.  You 
can review a report quicker when it’s on the window, since it doesn’t have to 
wait for the printer or the network.  Once in the window, you can print one 
page or all pages using the Print pop-up menu at the top-right corner of the 
window.

■  Every snapshot window features a variety of options which affect how 
data appears on reports.  This means you may get slightly different results 
when printing the same report over again.  When you’ve finally discovered 
the right combination of options on a report, make a note on the report of the 
option you’ve chosen.  So whenever someone else needs the same report, 
they’ll know the right options to use.

■  Managers can prevent users from printing certain kinds of snapshot 
reports by changing their access privileges:  Choose Users, Access, and 
Privileges from the Setup menu; from the Menus access options, uncheck the 
snapshot reports the user shouldn’t print; click Save.  These changes will take 
affect the next time the user introduces himself or herself.

■  Any snapshot report can be printed to a disk as a text file.  The text file, 
however, is unformatted (no fonts or styles).  It can be opened by any word 
processor, but not a spreadsheet, then edited as needed.
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The Snapshots menu

Snapshots Reports

1 Production reports show status, 
traffic and schedules from jobs and 
tasks. It’s the only way to get job 
status lists, traffic reports, and job 
schedules for all of your jobs in 
production. Jobs can be selected 
by production or billing status. 

2 Work in Progress reports compare 
estimates, costs, open purchase 
orders, and unbilled costs from 
jobs and clients. 

3 Job Costs reports summarize pur-
chases, time, expenses, and checks 
by job, task, or client—every cost 
you’ve incurred for a week, month, 
or any period by client, job, or task. 

4 Vendor Account Aging reports 
show unpaid invoices from A/P. You 
can see unpaid invoices in detail, 
or just see each vendor’s balance 
due. The vendor aging can be run 

as of the current date or through 
any prior period. Client Account 
Aging reports show unpaid invoices 
from Accounts Receivable. You can 
see each unpaid invoice, or just the 
total balance due for each client. 
Invoice aging reports have many 
options; for example, you can print 
an aging for one client or for all cli-
ents within one division. The client 
aging can be run as of the current 
date or through any prior period.

5 The Cash Flash window shows 
your current cash balance and 
outstanding A/P and A/R balances. 
A schedule of payments and cash 
receipts can be set up to help you 
plan your cash needs.

6 Profitability reports show profit 
and loss from jobs and tasks. You 
can analyze the job’s profit to date, 
or just profit earned for the month’s 

billings and costs.

7 Productivity reports show how 
time was spent from Time Sheets. 
You can quickly see how your staff 
is utilizing their time by client, 
department, or profit center—for 
a week, a month, or any period of 
time. There are reports to analyze 
overtime and show you which staff 
members have not accounted for all 
their hours.

8 Financials include the Income 
Statement, Balance Sheet, Trial 
Balance, Detailed General Ledger, 
and Statement of Cash Flows. 
You can print financials anytime 
during the month, seeing your 
up-to-the-minute balances. The 
financials can be run for any of the 
24 accounting periods or quarterly 
financials can be run. 
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9  Media Analysis reports can be 
used by media buyers and account 
service to see how advertising was 
purchased.  Account management 
can use media analysis reports to  
analyze how well the media depart-
ment is managing themselves.
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Production Reports

Production reports are your best source of up-to-date information on 
open jobs, traffic, and task schedules. A complete picture of your work 
in production is available here: job status lists, traffic reports showing mile-
stones, work-to-do schedules for tasks and resources, and a customi-
zable schedule chart that shows selected unfinished tasks.

The Job Hot Sheet reports show jobs by production status, sorted by job 
number. Each job shows its 
job number, job name, cli-
ent, and status. The Job Hot 
Sheet can show jobs select-
ed for a range of start dates, 
due dates, added dates, or 
closed dates. It’s like the job 
lists you can also print from 
the Job Ticket window.

Traffic reports show jobs 
by production status, and 
feature milestones. Jobs are 
grouped by job type, so that 
like jobs are shown together. 
The traffic reports can be run 
for one client, AE, or one of 
six key production people. 
The job’s status note (which 
is a customizable status 
code entered in the job’s 
Traffic window) appears on 
the right side of the report. If 
you use FileMaker, this report is probably very similar to the job report you’re 
now using. 

Schedules/work to do reports show unfinished job tasks by resource, client, 
AE, department, or task. These work-to-do reports can be printed daily to 
show everyone what they’re to do each day. Or, weekly schedules can be 
printed in advance for production meetings to help manage the week’s work 
load.

The schedule chart is a combination traffic/schedule report. It charts a 
user-defined selection of tasks by due date. You can pick-and-choose the 
unfinished tasks you want to see, sorted by job number. You can also sort the 
unfinished tasks by client. So instead of seeing every unfinished task for the 
week, you can print just ART, COPY, and DES (i.e., design) instead. Any com-
bination of tasks can be charted. This ability lets you easily chart work-to-do 
for different work groups, such as creative teams. For f lexibility, the chart’s 
title is even customizable.

The analysis reports allow you to see which tasks were completed on time 
and which were late, or a list of missed deadlines can be printed for each 
staff member

Production Reports

■ Each of the production reports has its own unique purpose. You may not 
need every one to help you manage your jobs. Instead of printing every 
report, experiment with each report (and its various options) to see which one 
gives you the best information you need to keep track of jobs.

To print production reports

Each production report has 
its own selections, which 
don’t affect the other 
reports. For example, you 
can print a status report 
listing jobs with status 
1-50, while also printing a 
traffic report showing jobs 
with status 1-999. 

1  Choose Production from 
the Snapshots menu.

2  Select the kind of report 
(i.e., Hot Sheets, Traffic, 
Schedules/Work to Do).

3  Make your report selec-
tions.

4  Click Print.

Production reports with more information will take longer to print than 
shorter reports.

Tips for printing production reports

■ Use the Job Hot Sheet as your basic production report. Since it shows the 
job’s key facts—job number, job name, client, due date, production status, 
and status notes—it’s a great way to see your open jobs at a glance. If you 
need to see more detail about a job, print a job summary (from Job Tickets).

■ Production reports are less detailed than regular job reports. Job lists 
printed from Job Tickets, for example, include many more options (such as 
showing the job specifications). However, other job reports are longer since 
they show more information. This makes them a little more complicated, 
since there are more pages used.

■ Don’t use production reports for billing. Since production reports are 
designed to manage work in production, you won’t see estimates, costs, 
billing, or other amounts. Instead, print either Work in Progress reports (from 
Snapshots) or job lists and job summaries (from Job Tickets).
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Production Reports

Production Reports

Job Hot Sheet

Traffic Hot Sheet

Traffic by Job Type

Traffic by Client

Traffic by Job Number

Traffic by Production Status

Traffic by AE/Team

Work to Do (by Due Date)

Work to Do (by Start Date)

Daily Task Calendar

Client Deadlines

Department Task Checklist

Job Schedule

Schedule Chart

On-Time Performance

Missed Deadlines

The Job Hot Sheet shows the job’s key facts—job number, production status, and status notes.

The Traffic Hot Sheet shows the job’s number, production status, and traffic assignments.

The Traffic by Job Type report lists each job within a job type and shows each jobs’ milestones 
and status notes. Each job type prints on a separate page.

The Traffic by Client report lists each clients’ jobs by job type, showing the jobs’ milestones. A 
separate page is printed for each client’s jobs.

The Traffic by Job Number lists each jobs’ milestones and sorts the jobs within each job type by 
job number. 

The Traffic by Pruduction Status lists each jobs’ milestones and sorts the jobs within each job 
type by production status code.

The Traffic by AE/Team lists job milestones and sorts the jobs within each job type by AE/Team.
 

The Work to Do report (by Due Date) shows unfinished tasks by due date and sorts by resource.

The Work to Do (by Start Date) shows unfinished tasks by start date and sorts by resource.

The Daily Task Calendar gives a checklist of unfinished tasks by due date. The client, job, 
resource, and time of day each task is due is listed with a check box so the printed report can be 
used as a manual checklist.

The Client Deadlines report shows unfinished tasks for each client and sorts them by due date. 
The job number, job name, resource, and time due are listed for each task.

The Department Tasks Checklist shows unfinished tasks for each department, sorted by due date. 
The task’s due date, time due and resource are shown along with the resource’s backup person.

The Job Schedule report gives a list of unfinished tasks by start or due date.  For each task the 
estimate hours and hours remaining are shown.

The Schedule Chart lets you choose the unfinished tasks you want to see and sorts them by job 
number or client. So instead of seeing every unfinished task for the week you can print just a 
select few (e.g., artwork, copywriting,and design).

The On-Time Performance report compares the due date of each client’s unfinished tasks to the actual 
date the task was finished. The number of days the task was late is calculated and the performance of 
meeting the due dates is analzed by showing what percentage of the tasks were early, on-time, late, or 
very late.

The Missed Deadlines report shows tasks that were finished after the scheduled due date for each 
person. The number of days the task was late is calculated.

Production Hot Sheets

Traffic Reports

Schedule/Work To Do Reports

Schedule Charts

Production Analysis Reports
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Work in Progress Reports

Work in progress reports are based on jobs and tasks—and not general ledger 
journal entries. Unlike older agency accounting systems, the general ledger 
does not automatically track your unbilled costs. This is done for two reasons: 
(1) Clients & Profits X can track costs and billing without needing the General 
Ledger, which other systems can’t; and (2) only actual costs and billings af-
fect the general ledger anyway.

Here’s how it works: When a vendor invoice or check is added, every line 
item gets a debit account (typically a job cost or expense). During post-
ing, the line item amount debits the general ledger—increasing the cost or 
expense account’s balance. 
The entry is counted as a 
cost against income immedi-
ately; it is not counted as an 
asset. When the job is billed, 
an income account is credit-
ed and Accounts Receivable 
is debited—that’s all. Billing 
does not affect your cost or 
expense accounts.

Here’s why: The system 
assumes that you’ll bill 
costs in the same period 
that they’re entered. It’s 
simpler, since agencies can 
bill costs more quickly now 
with Clients & Profits X. 
This eliminates the need to 
initially post costs to WIP, 
then reverse the costs that 
were later billed. So instead 
of booking the month’s costs 
as they’re added, you only need to make a month-end entry for the value of 
unbilled costs. And you’ll get this amount from the work in progress reports.

This method of cost accounting only applies to payables and checks. 
Purchase orders, insertion order, time sheets, out-of-pocket expenses, cost 
transfers, and job change orders don’t post journal entries into the general 
ledger Work in progress reports summarize unbilled costs. These reports are 
the best way to see what you’ve spent on jobs so far, even if they’ve been 
billed before. Work in progress reports can show what’s to be billed by client, 
making the month’s billing easier. Other reports help you account for your 
change orders.

The various work in progress reports show jobs, tasks, and costs in differ-
ent ways, so have different purposes. The Billing Hot Sheet report is a great 
pre-billing report, since it lists your unbilled jobs by client. It summarizes the 
unbilled totals by job, so it is a very compact report; however, it doesn’t show 
much detail.  

Work in Progress Reports

WIP reports can show jobs, tasks, and costs for one client, AE, project, or 
profit center by using the select by pop-up menu. They can show unbilled 
costs by production status or billing status, letting you see only jobs marked 
as ready to bill, for example. By using billing status, accounting managers 
can print their own reports.

Change orders aren’t costs, so don’t appear on the work in progress reports. 
Since they may influence a month’s billing, change order reports and forms 
can be printed from the Work in Progress window. The Change Order Report 
lists change orders for all jobs for a range of dates. The option change orders 

prints a list all change 
orders for a time period.

■ Tasks without unbilled 
costs aren’t included on 
work in progress reports. 

Billing worksheet report 
options include:

■ Include overbilled tasks. 
Only unbilled tasks appear 
on WIP reports. Over-billed 
tasks (which may have been 
billed by estimates) aren’t 
included. Why exclude over-
billed tasks? These amounts 
will decrease the unbilled 
total for the job, and you 
may not bill enough to cover 
the job’s actual costs. Since 
the job summary and job 
progress reports show all 

tasks, you should use this option if you compare them with work in progress 
reports. 

■ Show overbilled jobs. This option looks at the unbilled total of the job, 
rather than the individual tasks. If the unbilled total on the job is a negative 
amount (i.e., the job is overbilled), then the job will not appear on the report 
unless this option is selected.

To print work in progress reports

1  Choose Work in Progress from the Snapshot menu.

2  Select the kind of report (i.e., Billing Worksheets, Unbilled Costs, Unbilled 
Media..etc).

3  Make your report selection.

4  Click Print.
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Work in Progress Reports

Work in Progress Reports

Billing Hot Sheet

Job Billing Worksheet

Unbilled Costs by Job

Unbilled Costs by Task

Partially-Billed Costs

Costs On-Hold

Unbilled Media (all kinds)

Unbilled Broadcast Orders

Unbilled Insertion Orders

Write-offs

Markdowns

Overbilled Tasks

Unbillable Costs

G/L Accrual (Costs by dGL)

Change Orders

The Billing Hot Sheet shows unbilled jobs by client—including each job’s estimate (plus 
change orders), billed, and remaining unbilled amounts. A checklist of the billing workflow 
steps is listed for each job.

The Job Billing Worksheet shows unbilled jobs and their tasks—including each task’s budget, 
costs, commitments, billings-to-date, and a space to enter the amount to bill now. Every job is 
printed on its own page, making the report easy to distribute to AEs. 

The Unbilled costs by Job report can be selected by cost status. This option lets you see unbilled 
costs that are on-hold, for example, or cancelled. All other costs will be excluded from the report.

The Unbilled Costs by Task report lists unbilled vendor purchases, time entries, expenses, checks, 
and transfers by task. Use this to easily see total unbilled printing, layout, etc. at month-end. To 
see unbilled costs for a time period, choose Job Costs from the Snapshots menu.

The Partially-Billed Costs report lists any cost with a status of Partial. The costs are sorted 
by client, then job.

The Costs On-Hold report lists any cost with a status of On-Hold.

The Unbilled Media (all kinds) report lists all insertion and broadcast orders that have not been 
billed to the client. The orders are grouped by client and sorted by order number.

The Unbilled Broadcast Orders lists all broadcast order not yet billed to the client. Each 
broadcast order is listed with its station, flight dates, number of spots, and net and gross 
amounts. A separate page is printed for each client’s orders.

The Unbilled Insertion Orders lists all insertion orders not yet billed to the client. Each in-
sertion order is listed with its publication, issue date, ad size, and gross amount. A separate 
page is printed for each client’s orders.

The Write-offs report analyzes costs that have been written off for some time period.

The Markdowns report shows costs that have been billed for less than their gross amounts.

The Overbilled Tasks lists job tasks that have been billed for more than their actual costs.

The Unbillable Costs report lists unbillable costs by job or task.

The G/L Accrual summarizes unbilled job costs by debit G/L# for making manual WIP entries.

The Change Orders report lists change orders added for any time period.

Billing Worksheets

Unbilled Costs

Unbilled Media

Analysis

Miscellaneous
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Job Cost Reports

Job cost reports are very detailed listings of vendor purchases (buyouts), time 
sheets, checks written for job costs, out-of-pocket expenses, and job cost 
transfers. 

Job costs are selected by work date (i.e., when the time was used, the 
vendor’s invoice date, or the date a check was written for job costs) or posted 
date. This makes it easy to see what you bought and where you spent your 
time for a week, month, or any time period. In addition, costs can be sorted 
by job number, client, or 
task for better analysis. 

The basic job cost report 
shows each cost’s refer-
ence number (i.e., invoice 
number, check number, 
time ID number), date, 
vendor or staff member, 
job number, task, hours 
(if it is a time entry), net 
cost amount and gross 
amount. As an option, you 
can show the cost’s notes.

You’ve got a substantial 
amount of control over 
how the report is ar-
ranged. Cost reports can 
be printed showing any 
combination of vendor 
costs, time entries, 
expenses, and cost 
transfers. 

Since costs are connected to jobs, you can print cost reports using status 
codes. You can select costs by the job’s production or billing status. This abil-
ity lets you see job costs, for example, for only open jobs. Or, you can print 
job costs for closed jobs, jobs on hold, etc. You can also show costs for one 
job number, one client, or one task. There’s no limit to how you can print job 
cost reports.

■ Purchase orders are not job costs (yet), but a purchase/insertion order 
report can be printed from the Job Cost Report window.

Job Cost reports vs. other cost reports

The Job Cost report is best for seeing costs for all jobs for some time period. 
But there are other reports that may be more useful in different situations, for 
different needs.

■ To see the costs for one job only: Choose View > Job Tickets then find 

Job Cost Reports

the job you want. Then choose File > Print Job Reports, select the job 
cost report, then click Print. This report prints all costs, regardless of 
date, including billing information. Costs can also be sorted by kind, instead 
of task.

■ To see time in detail by day: Choose Accounting > Time Sheets then 
choose File > Print Time Reports. Enter a range of dates, then click Print. 
Time reports show time by day, staff member, job, task, or client. In addition, 

you can print time entries 
by date added or date 
posted, unlike the Job 
Cost reports.

■ To see time totals: 
Choose Productivity from 
the Snapshots menu; enter 
a range of work dates; 
select some options; then 
click Print. The productiv-
ity reports summarize time 
sheets in various ways. 
You’ll see clear, concise 
totals and not all of the 
time detail, making it a 
very efficient, effective 
management report.

To print Job Cost 
Reports

1  Choose Job Costs from 
the Snapshots menu.

2  Select the kind of report (i.e., Job Costs, Client Job Costs, Task Costs..etc)

3  Make your report selections.

4  Click Print.

Tips for printing job cost reports

■ Only posted costs appear on Job Cost reports. Unposted costs, including 
unposted daily time cards, are simply excluded until they are posted.

■ If a user doesn’t have access to cost amounts, they will not be able to 
print Job Cost reports, so there’s no way for the user to see cost rates and net 
amounts.
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Job Cost Reports

Job Cost Reports

. 

Job Costs

Client Job Costs

Task Costs

Purchase Orders

Change Orders

The Job Costs report is simple, showing costs by job and task. All costs can be selected or any combi-
nation of outside costs, time, in-house expenses, or internal charges.

The Client Job Costs report shows costs by client, then by job number. 
A separate page is printed for each client. All costs can be selected or any combination of outside 
costs, time, in-house expenses, or internal charges. 

The Task Costs report shows costs by client first, then by job task. You’ll see how time and money was 
spent by client, task, and the vendor or staff member. A separate page is printed for each client, too. 

The Purchase Order report can be printed for one or all types of orders (broadcast, insertion, 
purchase).  Each order’s number, vendor, date, cost, gross, and balance is shown.

The Change Order report can be printed for approved or Unapproved orders.   Each change 
order’s number, date, description, and status are shown, along with the hours, budget, and 
estimate amounts being changed.

Job Costs

Client Job Costs

Task Costs

Purchase Orders/Insertion Orders

Change Orders
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Profitability Reports

There are many kinds of job profitability reports. Each report gets its infor-
mation from a different source, so each has a slightly different focus—and 
usefulness. The Job Profitability reports show costs, time, and billings for jobs 
and tasks. The Client Profitability reports are based on journal entries from 
the General Ledger, including overhead expenses you’ve directly allocated to 
clients, for one accounting period. The Gross Margin report compares costs, 
time, expenses, and billings for a week, a month, or any period of time—so 
it’s the most f lexible way to track your shop’s performance.

The foundation of the Job 
Profitability reports is the job 
task. Jobs remember every-
thing purchased and billed by 
job task. Job tasks keep job-
to-date totals for costs, time, 
expenses, and billings from 
the date the job was started. 
Since job tasks are connected 
to jobs and clients, they are 
an ideal basis for analyz-
ing profitability. Job-to-date 
profitability reports search 
for job tasks for a period of 
time (using the job’s start 
date) and billing status (such 
as closed jobs, for example). 
These tasks are rearranged, 
sub-totaled, and printed by 
job, project, client, task, etc. 
based on the options selected 
in the Profitability window. 
In most cases, the job tasks 
themselves are hidden to save space; what you see instead are just the job’s 
totals. These totals are based on the same job tasks you’d see in a Job Sum-
mary report.

■ The Job P&L and Client P&L, which is based on G/L journal entries from 
billing and job costs, is printed from Financials. Every journal entry can be 
given a client number and a job number. If a journal entry has a job number, 
it is selected for the job income statement. The Job P&L is printed for one 
accounting period, just like the agency’s income statement. It can reflect 
the client’s overhead allocation, if entered into the Overhead Allocation 
Worksheet. You can print the report for one job or one client.  The job income 
statement doesn’t show time, expenses, or any other amount not posted in 
the General Ledger—so it may be drastically different (and probably less ac-
curate) then the other profitability reports. 

The Gross Margin report compares costs and profit for any period of time, 
such as a month or a quarter. This report is distinctive because it shows 
profit both before and after labor. Direct costs are the total vendor purchases, 
checks, and expenses. Net Revenue is billings less direct costs. Direct Labor 

is the total time cost for the month. Profit is net revenue less direct labor. 
Jobs are sub-totaled by client for easy comparison. The last bill date is shown 
from the last invoice billed for the job.

Job profitability vs. agency profitability

You can see profitability two ways: Job profit is focused on job costs—vendor 
purchases, labor, cash disbursements from checks, and out-of-pocket expens-
es—and job billings. Agency profit is based strictly on income and expenses 

for everything—whether they 
were the result of jobs or not. 

You can’t rely on just one 
profit report to keep you 
informed. Job profitability and 
the income statement em-
phasize different things: job 
profitability reports are based 
solely on jobs, tasks, and 
clients; income statements 
are based only on the general 
ledger.

Job profitability shows only 
costs and billings for jobs and 
tasks, and does not account 
for overhead expenses like 
rent. Income statements don’t 
reflect the cost of time spent 
working on jobs, only the 
total payroll expense. Income 

statements take into account other non-job income, like fees and interest in-
come; job profitability doesn’t reflect adjusting entries to the General Ledger.

What’s the difference between gross margin and net income? Gross margin, 
as it is used in Clients & Profits X, is based on jobs and tasks. 
It is the difference between a task’s billings and its costs—vendor purchases, 
time sheets, and expenses. Net income, as it is used on the income state-
ment, is the agency’s real profit after overhead expenses.

Job Profitability vs. the Income Statement

Both reports show important information about how well you’re doing. Job 
profitability shows exactly where your revenue is being earned, even showing 
each client’s total contribution to profit. Income statements can’t 



81Profitability Reports

Profitability Reports

Profitability Reports

Gross Margin by Job

 

Projected Gross Margin

 
Projected vs. Actual Gross Margin

Gross Margin by Client

Project Profitability

Division Profitability

Client vs. Client Gross Margin

 
Comparative Client Profitability

Projected Gross Margin by Client

Gross Margin by AE/Team

 
AE/Team Projected Gross Margin

 
AE/Team Projected vs. Actual Gross 
Margin

Gross Margin by Profit Center

Profit Center Projected Gross Margin

Profit Center Projected vs. Actual 
Gross Margin

The Gross Margin by Job report compares costs and profit for each job, sub-totaled by job 
type. The net revenue is calculated based on the billings less direct costs, and the gross 
margin (or profit) is calculated by the net revenue less direct labor costs.

The Projected Gross Margin report calculates a projected gross margin based on the 
job’s estimate less the costs expected to be incurred to complete the job (i.e., budget).

The Projected vs Actual Gross Margin report compares the job’s actual gross margin to 
the projected gross margin. The job’s are sub-totaled by job type. 

The Gross Margin by Client report shows the net revenue for every client’s jobs.

The Project Profitability report compares gross margin for jobs within each project.

The Division Profitability report compares profit between divisions and their clients.

The Client vs Client Gross Margin report shows the costs and profit for each client and 
calculates each client’s net revenue and gross margin.  

The Comparative Client Profitability report compares this year’s and last year’s profit.

The Projected Gross Margin by Client report calculates a projected gross margin based 
on the job’s estimate less the costs expected to be incurred to complete the job (i.e., 
budget) and the jobs are subtotaled by client.

The Gross Margin by AE/Team report calculates the net revenue and gross margin for 
each job and sub-totals the jobs by AE/Team.

The AE/Team Projected Gross Margin report calculates the projected gross margin 
based on the job’s estimate less its budget. The job’s are sub-totaled by AE/Team.

The AE/Team Projected vs Actual Gross Margin report compares the projected gross 
margin to the actual gross margin for each job and sub-totals the jobs by AE/Team.

The Gross Margin by Profit Center report calculates the net revenue and gross margin 
for each job and sub-totals the jobs by client, then by profit center.

The Profit Center Projected Gross Margin report calculates the projected gross margin 
figure for each job based on the projected billings (the job’s estimate) less the costs 
expected to be incurred to complete the job (the job’s budget). The job’s are sub-
totaled by client, then by profit center.

The Profit Center Projected vs Actual Gross Margin report compares the projected gross 
margin to the actual gross margin for each job and sub-totals the jobs by client and 
PC.

Job Profitability

Client Profitability

AE/Team

Profit Center
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Productivity Reports

Productivity reports use time sheets to show how the shop’s time is spent. 
These reports are the best way see how people work—by client, job, or task. 
Productivity reports show the hours, cost amounts, and billable amounts 
for both billable and non-billable hours, so you’ll see a complete picture of 
your work.

Productivity reports show time by work date. Like time reports, productivity 
reports show hours posted 
from time cards and time 
sheets. But unlike time 
reports, productivity reports 
only show totals—so you 
won’t see individual time 
entries. This makes produc-
tivity reports much more 
concise (and probably more 
usable) than time reports.

Productivity reports don’t 
show billings. They’re less 
concerned with how the 
time was billed (or not 
billed) than with how the 
time was actually spent, 
since the cost of your staff is 
mostly fixed (unless they’re 
freelancers, that is). One rea-
son for printing productivity 
reports is to see how time is 
being used, and especially if 
is it being managed properly. 
One of the reasons to track productivity is to ensure that the right people 
work on the right clients (i.e., the higher-paid staffers should only work on 
the most profitable clients, etc.).

Productivity reports can also help you balance your work load. If one staff 
member is consistently logging more hours than other staff, you’ll see it in a 
their total hours—they’ll be higher than others. You can use this information 
to move work around, so that everyone is working more efficiently.  

Time reports vs. productivity reports

Productivity reports show time in summary, while time reports show time 
in detail. Productivity reports are designed to give managers a clear idea of 
how the staff spends their time over a week, month, quarter, or year. 

Time reports, in contrast, are designed for day-to-day time accountability. 
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Productivity reports 

The Daily Dept Time Analysis report shows total hours by day for everyone who worked, 
including planned vs. actual hours by day for each staff member and department.

The Weekly Time Summary report shows total hours spent for each staff member for a 
7-day period, sub-totaled by department.

The Weekly Time Analysis report shows total hours spent for each staff member and the 
jobs they worked on for a 7-day period, sub-totaled by department.

The Missing Time report lists each staff member by departement showing their planned 
hours vs. their actual hours. It shows who hasn’t accounted for all of their time.

The Overtime report shows time entries marked as “overtime” only.

The Staff Utilization report compares each staff member’s total hours vs. their billable 
hours. It is based on what percentage of their total hours is actually billable time.

The YTD Staff Utilization by Client report compares period vs. year-to-date staff time.

The Freelance Time Analysis compares client hours for employees vs. freelancers.

This report compares the percentage of unbillable staff time by client.

The Billable/Unbillable Time Summary report compares billable to unbillable hours. 

The Staff Realization report compares each staff member’s total hours vs. their billed 
hours.  It is based on what percent of thier total hours has actually been billed.

The Dept/Group Productivity report compares each staff member’s total hours vs. their 
billable hours. The staff members are sub-totaled by department.

The Team Productivity report compares each team’s total hours vs. their billable hours 
and calculates the team’s utilization (percentage of billable hours).

The Team/Staff Productivity report compares each staff member’s total hours vs. their 
billable hours. The staff members are sub-totaled by team.

The Monthly Client Time Summary report shows total hours worked by staffer per client. 

The Client Productivity by Job report shows total hours worked by job and client.

The Division Productivity report compares each division’s total hours vs. billable hours.

The Division/Client Productivity report analyzes total hours for each division and client.

The Division/Staff Productivity report compares staff hours by division and client

Daily Department Time Analysis

Weekly Time Summary

Weekly Time Analysis

Missing Time

Overtime

Staff Utilization

YTD Staff Utilization by Client

Freelance Time Analysis

Unbillable Time Analysis

Billable/Unbillable Time Summary

Staff Realization

Dept/Group Productivity

Team Productivity

Team/Staff Productivity

Monthly Client Time Summary

Client Productivity by Job

Division Productivity

Division/Client Produtivity

Division/Staff Productivity

General

Dept Performance

Client AnalysisClient Analysis

Staff Utilization
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Financials

Clients & Profits X prints standard financial statements tailored especially for 
the advertising industry. These financial reports are used for auditing, track-
ing, and reporting your G/L accounts balances. You can print trial balances, 
income statements, balance sheets, and detailed general ledger reports for 
any accounting period—at any time during the month.

Financial statements show account balances from the General Ledger and 
the Chart of Accounts. These account balances are updated when entries are 
posted, so the financial statements are always timely and accurate whenever 
they’re printed. 

The account totals on the 
financial statements are 
copied from the Chart of Ac-
counts. To see one account’s 
totals: Choose Setup > Chart 
of Accounts. Click once 
on an account to select it, 
then choose Edit > Monthly 
Budgets. The center column, 
actuals, is the total from 
posted entries. Entries added 
in the General Ledger affect 
financial statements when 
they’re posted. Unposted 
entries won’t appear on 
financial reports. 
Be sure to post everything 
before printing financial 
statements.

■ Only manager-level us-
ers can print financials. There is no month-end procedure required to print 
financials. Since the G/L account balances are updated whenever entries are 
posted, your financial statements will always be up-to-date throughout the 
month.

The AGI Income Statement

The income statement shows the agency’s profit and loss. There are two 
kinds of income statements, the standard form and the agency gross income 
form. Both forms show the same accounts, but have different sub-totals. 
These sub-totals affect how the percentages are calculated.

The standard income statement sub-totals income accounts, job cost ac-
counts, and expense accounts. Gross profit is calculated as billings minus job 
costs. A gross profit percentage is calculated showing job costs as a fraction 
of the total billings. An account can appear in the income or job cost section, 
based on its classification (which is user-defined). Expenses are listed below 
the gross profit. The expense percentage for each overhead account is calcu-
lated as a percent of the billings, not gross profit. This calculation shows your 
ratio of overhead to total billings.

The AGI income statement combines your billing and job cost accounts into 
the same section. The gross profit is calculated as the billings minus job 
costs (like media, typesetting, printing, etc.). This amount is your agency 
gross income. Expenses are listed below the AGI. The expense percentage for 
each overhead account is calculated as a percent of gross profit, not billings. 
This calculation shows the ratio of overhead to gross profit—the agency’s 
gross income.

To print financials

1  Choose Financials from 
the Snapshot menu.

2  Select the kind of report 
(i.e., Trial Balance, Detail 
G/L, Income Statement, etc.)

3  Make your report selec-
tion.

4  Click Print.

Tips for printing 
financials

■ Financial reports can be 
printed to the screen for 
quick review, before the 
report is committed to paper.

■ Financial statements can 
be printed for previous periods—even if the period is locked—by choosing the 
period from the pop-up menu. 

■ Unless a period is locked, anyone can post entries into prior periods. This 
means your past financials might change after they’ve been printed. If some-
one adds costs or billings after you’ve printed the month’s financials, be sure 
to reprint the reports over again.

■ Account totals on financial statements can be audited by printing audit 
trails and journals from the General Ledger. 

■ If your audit trails and journals don’t equal the financial statements, post-
ing may have crashed during the month. Use the verify G/L account balances 
utility to recover the correct totals.

■ The date and time a financial statement was printed appears at the top of 
each report. When you’re printing financial reports repeatedly, use this date 
to determine the most-recently printed report.
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Financial Statements

 

The Trial Balance shows assets, liabilities, equity, income, costs, and expenses. You’ll see each 
account’s beginning balance, current balance, and ending balance. Assets, costs, and expenses 
have positive balances; liability, equity, and income accounts have negative balances.

The Detailed General Ledger report shows the period’s journal entries for each account. Each ac-
count includes its beginning and ending balances for quick reference. For easy auditing, journal 
entries can be printed for selected accounts.

The Income Statement shows income, job cost, and expense accounts as well as net profit/loss 
for the shop. The standard format shows gross profit as billings less job costs. It also shows ex-
pense ratios as part of total billings. The AGI format shows expense ratios as part of gross profit, 
not total billings. 

The Comparative Income Statement compares this years income, job cost, and expense 
accounts to the amounts from last year.

The Client P&L report shows billings, direct costs, gross profit, and gross profit by client. 
Unlike the Client P&L Analysis, it does not break out each client’s share of overhead.

The Client P&L Analysis shows each client’s income, costs, direct labor, direct expenses, 
plus their share of the overhead allocation. The net income earned is calculated by client.

The Job P&L shows billing, direct costs, expenses, and gross margin for one period.

The Balance Sheet shows ending balances for assets, liabilities, and equity. It shows your net 
worth.

The Comparative Balance Sheet compares assets, liabilities, and equity between two fiscal 
years.

The Statement of Cash Flows report uses each G/L account’s cash flow category to calcu-
late operating, investing, and financial activities totals for the period.

This report shows detail of the amounts on the Statement of Cash Flows. It is used to ana-
lyze the amounts use to calculate the totals shown on the Statement of Cash Flows.

The Media WIP Analysis report is used to audit balance of the Media WIP Accruals liability 
account, which is updated from media billing and vendor invoices.

The Liquidity Analysis report measures the ability of the company to meet cash require-
ments. It’s based on the ratio categories entered for each G/L account.

The Profitability Analysis report measures how well the company is utilizing its resources

The Solvency Analysis report measures how the company’s financial health with ratios such 
as debt-to-equity, cash flow to interest, debt-to-assets, and more.

Trial Balance

Detailed G/L

Income Statement

Comparative Income Statement

Client P&L

Client P&L Analysis

Job P&L

Balance Sheet

Comparative Balance Sheet

Statement of Cash Flows

Cash Flow Detail Report

Media WIP Analysis

Liquidity Analysis

Profitability Analysis
  
Solvency Analysis

Trial Balance

Detailed G/L

Income Statement

Balance Sheet

Ratios

Analysis
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Appendix A: Setting Up C&P E-mail

One of the best features in Clients & Profits X is the innovative use of 
internet-based electronic mail. It works with industry-standard SMTP-based 
mail servers to automatically send e-mail from Clients & Profits X to staff 
members or other e-mail address. C&P e-mail is sent automatically (such 
as when a job is opened or its status codes changes) or based on scheduled 
entries added by users.

Two things make C&P e-mail work: a SMTP server and e-mail addresses for 
each staff member. To start sending automatic e-mail, you’ll first need to 
enter the name of your SMTP 
server into Clients & Profits 
X. It must be a standard 
SMTP-based mail server, 
and not a proprietary server 
like ccMail, QuickMail, etc. 
(unless you’re using a newer 
version that speaks SMTP). 
The mail server must be 
available full-time because 
Clients & Profits X sends 
mail throughout the day.

Every staffer must have an 
e-mail address  (e.g., john@
agency.com).  For security 
reasons, C&P e-mail is gen-
erally sent only to staff 
members and not to people 
outside 
the shop. This prevents 
confidential 
information from being to 
sent to 
clients, vendors, and possibly 
competitors. However, “cc’s” (i.e., 
carbon copies) and “bcc’s” 
(i.e., blindcarbon copies) have 
no such limitation. This means users 
who manually send e-mail from Clients & Profits X can potentially send it to 
anyone.

■  E-mail that is sent from the Help E-mail window to the C&P Helpdesk is 
considered as confidential and private. However, e-mail send to the C&P User 
Group or the C&P Wish List is considered public and can be read by anyone 
subscribing to those mailing lists.

The Clients & Profits X e-mail system is based on an internal calendar. Stored 
mail is automatically checked each morning when the first user opens the 
database. Any pending mail is then sent. E-mail is automatically sent from 
these areas:

TimeCop  Staff members who haven’t accounted for enough hours (i.e., actual 

The Update User E-Mail Addresses 
window lets you easily update the de-
partment and e-mail address settings 
for all staff members at 
one time.

vs. planned) on the previous day’s time card/time sheet get a user-defined 
reminder via e-mail.
Quick Check  The system manager is notified via e-mail if daily Quick Check 
finds a problem with the database.

Media Calendar  Scheduled entries from the media calendar can remind 
media department staffers of space closing dates, material due dates, dates 
of special promotions, and meeting dates.

Cash Flash  A daily “cash 
flash” of the shop’s current 
cash, A/R, and A/P balances 
can be e-mailed to agency 
management. In addition, 
e-mail “ticklers” can be sched-
uled to remind the accounting 
staff about unpaid invoices, 
tax deposits, appointments, 
and other follow-up.

Client Diary  When a user 
adds a diary entry, a copy can 
be e-mailed to a staff member. 
Entries can be scheduled to be 
sent in the future to automate 
account follow-up.

Job Tickets  E-mail can be au-
tomatically sent to accounting, 
production, or management 
when a new job is opened, its 
status code is changed, or the 

job is closed.  Production people are notified of impending task deadlines 
several days ahead of time via e-mail. When a user adds a job diary entry, a 
copy can be sent to account service, production, or accounting.

To start C&P e-mail:

1  Choose Setup > Preferences > C&P E-mail.

2  Click the Automatically send e-mail checkbox, then click Save.

To stop C&P e-mail:

1  Choose Setup > Preferences > C&P E-mail.

2  Uncheck the Automatically send e-mail checkbox, then click Save.

Need more info about C&P Mail?  Find out how to use more auto-
matic e-mail features from the C&P Mail FAQ (i.e., frequently-asked 
questions) page:  www.cnp-x.com/support/FAQs/FAQ_email.html



87Appendix A: Setting Up C&P E-mail

The C&P E-mail Preferences window

1  This option starts up the auto-
matic e-mail system, including the 
daily TimeCop (which sends e-mail 
reminders to staffers who haven’t 
finished their time cards). If this 
option is unchecked, no e-mail 
will be sent from Clients & Profits 
Pro X.

2  Enter the name of your SMTP 
mail server server here. The mail 
server must be accessible on your 
network for the automatic e-mail to 
function. If not, an error will appear 
each time mail is sent.

3  The system manager is auto-
matically notified via e-mail when 
there’s a problem with Clients & 
Profits X . If there are multiple 
system managers, choose the one 
who is most responsible for the 
day-to-day operation of Clients & 

Profits X . This person should also 
be the primary in-house contact for 
C&P questions and troubleshooting; 
all internal help e-mail sent by us-
ers will be delivered to this system 
manager.

4  If the system manager is a staff 
member, his or her e-mail address 
will be copied to the system 
manager 
e-mail address field automatically. 
If the system manager is an outside   
consultant, or has a special e-mail 
address, you’ll need to enter the 
e-mail address here. 

5  Clients & Profits X has a built-in 
help e-mail function that can be 
used by anyone using the system. 
This makes it very easy for users to 
send questions and report problems 

without quitting Clients & Profits 
X. When a user chooses Send Help 
E-mail from the Lookup menu, 
the message is sent to the system 
manager by default (although it 
can be sent instead to the C&P 
Helpdesk, the C&P User Group, 
or the C&P Wish List). The system 
manager can preset a standard 
message that appears every time 
a user sends a help e-mail. It can 
be used to explain how to get help, 
how to explain the user’s problem, 
or some other kind of helpful notes 
for the user.

6  The missing time message is a 
standard e-mail message that users 
see in when they haven’t finished 
their time card. It can be changed 
anytime to keep it fresh—and to 
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keep users from readily ignoring it.

7  The send e-mail about overdue 
tasks option notifies staff members 
every morning about their overdue 
dates (i.e., job tasks that have a 
due date prior to the current day). 
If the production department isn’t 
very timely about marking tasks as 
finished, this option could generate 
dozens of meaningless e-mail. The 
send e-mail about over-budget 
tasks notifies AEs whenever some-
one adds a cost that makes a task 
exceed its budget.



88

“We thought we could 
get away with a generic 
accounting package. But 
it just didn’t work. We 

needed something 
designed for the way we 
work. Clients & Profits X 

was the answer.”

www.clientsandprofits.com

CPA Software News just recognized what our users have 

known for years.  There’s no substitute for real ad agency 

management software. One that speaks the language of 

advertising. One that knows how an ad agency works. That’s 

why over 1,600 shops chose Clients & Profits X®. And why 

it’s the best-selling agency system for Mac,Windows, and 

the web. Call today [800] 272-4488.


